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Preface

About this book

This book is the Installation and Customization Guide for WebSphere® Studio 
Application Monitor (Application Monitor). It contains instructions on installing 
user's exits and customizing the Application Monitor.

Who should read this book

Administrators or advanced users wanting to install or modify the configuration of 
the Data Collector. For the z/OS system, anyone wanting to install or modify the 
OS/390® or z/OS® Data Collector or the Managing Server. For the Data Collectors, 
knowledge of the operating system (AIX, Solaris, Windows, Linux, or HPUX) and 
WebSphere is expected. For the z/OS Data Collector, knowledge of WebSphere, 
MVS™ Systems programming and RACF® is expected. For the managing server, a 
working knowledge on deploying WebSphere applications in a UNIX® environment 
with DB2® and/or Oracle experience is expected.  

Where to find more information

The following list shows the books in the Application Monitor library:

• WebSphere Studio Application Monitor User’s Guide contains instructions and user 
information for the Application Monitor.

• WebSphere Studio Application Monitor Operator’s Guide contains information about 
the operation of Application Monitor and the common services address space.

• WebSphere Studio Application Monitor Installation and Customization Guide contains 
instructions on installing user's exits and customizing the Application Monitor.

• WebSphere Studio Application Monitor for CICS® Data Collector Product Guide 
contains information about the installation, configuration and use of the 
Application Monitor CICS Data Collector. 

• WebSphere Studio Application Monitor for IMS Data Collector Product Guide contains 
information about the installation, configuration and use of the Application 
Monitor IMS Data Collector. 

• WebSphere Studio Application Monitor Messages and Codes contains information 
about messages and codes generated by the Application Monitor.

• WebSphere Studio Application Monitor Program Directory contains complete 
installation instructions for the Application Monitor Engine.

•  WebSphere Studio Application Monitor Program Directory for the CICS Data Collector 
contains complete installation instructions for the Application Monitor CICS Data 
Collector  Engine.

•  WebSphere Studio Application Monitor Program Directory for the IMS Data Collector 
contains complete installation instructions for the Application Monitor IMS Data 
Collector  Engine.

• WebSphere Studio Application Monitor has an online help system that describes all 
of the commands and dialogs available from its graphical user interface.
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Documentation Conventions

The following table describes the conventions used throughout thsi book. 

   

 

Table 1. Documentation Conventions

Convention Item

Ctrl+Tab Indicates that you must press two or more keys simultaneously.

<installation directory> Indicates that you should insert the directory appropriate for your 
environment. 

monospace text Indicates code samples. 
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Chapter 1. Product Overview

The Application Monitor provides immediate Problem Determination, Availability 
Monitoring and Performance Management for enterprise J2EE and CICS applications 
running on Windows 2000 Server, Solaris, HP-UX, AIX, z/OS and OS 390 
environments. The Application Monitor monitors heterogeneous environments 
consisting of both mainframes and distributed systems. From development and 
testing to staging and productions, the Application Monitor helps to identify 
problems and resolve them in real-time, as well as understand application 
performance, and assess resource consumption patterns for planning future growth. 

In today’s e-business applications, J2EE transactions often link up with Legacy back-
end systems. The Application Monitor, along with the optional Data Collector for 
CICS, provides visibility into transactions that span across Application Server and 
CICS platforms. Composite transactions between J2EE servers and CICS can be traced 
and correlated, giving developers and analysts insight into the health and 
performance of both mid-tier business logic and Legacy back-end components. 

Architecture

The Application Monitor is composed of two main parts: the Data Collector and the 
Managing Server. A Data Collector agent runs on each monitored J2EE application 
server or CICS transaction server, and communicates essential operational data to the 
Application Monitor managing server. Unique sampling algorithms maintain low 
CPU and network overhead while providing application specific performance 
information. The Application Monitor managing server is composed of a Kernel, 
which controls the environment, a Publish Server to publish and collect data, a 
Relational Database to store and retrieve that data, and a Visualization Engine which 
users interact within a browser-based graphical environment. 

Figure 1. Application Monitor Architecture
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The Managing Server

The Managing Server is comprised of several Java components, and also relies on an 
application server and a database, which must be installed prior to installing the 
Managing Server itself.  

Requirements

You can choose among several supported operating system platforms on which to 
install the Managing Server.  Likewise, you can choose among two application servers 
and versions, and two databases and versions.  These requirements are described in 
detail in “Software Requirements” on page 9.

Supported Installations

The Managing Server is designed for scalability and load-balancing, and there are 
many ways to architect an installation across one or more servers.  Likewise, the 
database used by the Managing Server can be located on a different server than the 
Managing Server itself.  It is recommended that you consult with Professional 
Services when making these decisions, and that you do so before attempting to install 
the Managing Server.

The instructions in this document describe installing a Managing Server on a single 
server, with support for using a remote database.  The procedure for doing so uses a 
graphical installer.  This document does not describe how to install the Managing 
Server manually, or how to install the Managing Server with a more complicated 
architecture.

Complete installation and configuration instructions are included in Part 2, “The 
Managing Server Installation,” on page 7.

Data Collectors

Once you have installed the Managing Server (or once you have determined its 
configuration properties,) you can install Data Collectors.  

In order for the Application Monitor to monitor a server, you must first install a Data 
Collector on that server.

Many Data Collectors can work with a single Managing Server.  The communication 
between Data Collectors and the Managing Server is independent of platform.

Requirements

Data Collectors are specific to operating system platform, application server type and 
version.  For non-z/OS and non-OS/390 servers, the supported combinations are 
listed on “Requirements for Installing the Data Collector” on page 95. For z/OS go to 
“Platform Pre-requisites” on page 41.

Supported Installations

The installation procedures you need to follow conform to one of two formats, based 
on whether or not the operating system of the monitored server is z/OS or OS/390.

• Installation of Data Collectors on the z/OS and OS/390 platforms are covered in 
Part 3, “The Data Collector for z/OS,” on page 39.
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• Installation of Data Collectors on all other platforms are covered in Part 4, “The 
Data Collector for Multiplatforms,” on page 93.

In addition, for non-z/OS and non-OS/390 Data Collectors, you can run a graphical 
installer, or install the Data Collector manually.  These installation options are 
described in Chapter 13, “Installation and Configuration,” on page 97.
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Part 2. The Managing Server Installation
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Chapter 2. Preparing to Install

This section describes how to install the Managing Server.

Planning Your Installation

The following information will help you plan your installation of the Managing 
Server. 

Software Requirements

The Managing Server is a standalone server (or in some cases, a collection of servers.)  
It consists of the following elements:

• Database – to store performance data and configuration information.

• J2EE Application Server – to run the monitoring console.

• Java Components – The Managing Server consists of several components, each of 
which runs as a Java process,  including the following:  Kernel, Publish Server, 
Archive Agent, Message Dispatcher, Polling Agent, Global Publish Server and the 
Port Consolidator.

You must have a supported combination of operating system platform, database and 
application server in order to use the Managing Server.  Table 2 describes the 
supported combinations. 

   

 

Hardware Requirements

The memory requirements for the server running the Managing Server are a function 
of your workload.  However, we recommend 4GB of memory for most installations. 

Table 2. Managing Server Requirements

Operating System Database Application Server JDK

AIX 5.1 DB2 UDB v8.1 
Fixpack 5

WebSphere 5.1.1 Supplied by 
Application Server

AIX 5.2 DB2 UDB v8.1 
Fixpack 5

WebSphere 5.1.1 Supplied by 
Application Server

Intel/Linux: 

RHEL 2.1AS

DB2 UDB v8.1 
Fixpack 5

WebSphere 5.1.1 Supplied by 
Application Server

Solaris 8 DB2 UDBv8.1 
Fixpack 5

WebSphere 5.1.1 Supplied by 
Application Server

Solaris 9 Oracle v10g WebSphere 5.1.1 Supplied by 
Application Server

z/Linux :

SuSe Linux 8.1

DB2 UDB v8.1 
Fixpack 5

WebSphere 5.1.1 Supplied by 
Application Server
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The disk space requirements are a function of the amount of performance data you 
choose to store in the database.

   

 

Database Considerations

For more information on database considerations, see Chapter 3, “Installation and 
Configuration,” on page 13 specifically the “Database Installation” on page 14.

Networking Considerations

The server(s) on which the the Managing Server is installed must have a real 
hostname and IP address (rather than just using localhost or 127.0.0.1.)

Data Collectors use eight ports to communicate with the Managing Server:  six ports  
for TCP/IP sockets, and two ports for RMI.  In addition, the two unique ports are 
needed for each Data Collector, in order for the Managing Server to contact the Data 
Collectors via RMI. See the Operator’s Guide, Appendix C. Port Consolidator. 

If a firewall sits between your Managing Server and your Data Collectors, you must 
configure your firewall to allow these connections.  See “Configuring Your Firewall” 
on page 28 for details.

Installation Overview 

Here is a summary of the instructions in this chapter which describe how to install or 
upgrade the Managing Server.

Preparing to Install

You must perform several tasks before you can install the Managing Server:  

• Install and configure DB2 or Oracle.

• Install WebSphere.

• Install Virtual Frame Buffer.

Installing and Configuring

• Create users and setup environment.

• Gather configuration.

• Run installer. 

• Start server.

Table 3. Recommended Hardware Configuration

CPU DISK MEMORY

AIX 5L 4 Way 3 x 36 GB 4 GB

Intel/Linux: 

RHEL 2.1AS

4 Way 3 x 36 GB 4 GB

Solaris 8 4 Way 3 x 36 GB 4 GB
 10 Application Monitor:Installation and Customization Guide  



Performing Post-Installation Tasks

See Chapter 4, “Customization,” on page 27 for more information about what to do 
once you have finished installing the Managing Server.  

Upgrading Considerations

Follow the normal installation steps and then see “Upgrading Considerations” on 
page 23

Preparing your Environment for Installation

Install J2EE Application Server

In order to install the Managing Server, you must first install a supported 
combination of a database and an application server.  The supported combinations are 
described in Table 2 on page 9.

To install WebSphere:

1. Install the application server according to manufacturers instructions.

Optional: Install Web Server 

If you want to have the WSAM Web console run on port 80, you will need to install 
and configure an HTTP server to serve those requests. You can find the instructions at 
Appendix E. 

Install Virtual Frame Buffer

To ensure the graphics environment for the Application Monitor is properly setup, an 
X11 environment is necessary. Typically, on the Managing Server server, X is not 
started. Instead, a virtual X11 environment is used. 

For Redhat Linux:  Install the XFree86-Xvfb package. You can find this on your 
Redhat Linux CD or via redhat.com.

For AIX: Install the Virtual Frame Buffer (xvfb). This package can be found on the 
AIX® installation CD X11.vfb package ("Virtual Frame Buffer Software for AIX 
Windows®") from the AIX CD.

For Solaris: Install from the x11 distribution. 

For  z/Linux: Install from the x11 distribution. 
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Chapter 3. Installation and Configuration

The following provide instructions for how to install and configure the Managing 
Server.  Please review Chapter 2, Preparing to Install for information on Software 
Requirements, Hardware Requirements, Database Considerations and Network 
Considerations. 

Create Users and Setup User Environment

The Application Monitor uses UNIX user names and passwords for authentication.  
The Application Monitor associates its users with UNIX accounts on the server that 
hosts the Managing Server. 

You must create two user accounts used exclusively by and for the Application 
Monitor:

• Create the user named "cyanea", who owns all Managing Server programs.

Note:  If you are using a remote database, the same user must be created on the 
remote machine. 

• Create the user named "admin", who is the Application Monitor administrator.

Create Users

The following instructions show you how to create users and the directory structures. 

To create users and directory structures :

1. Log in as root.

2. Create the username “cyanea” and assign a password using the following 
commands: 

Note:  If you are using a remote database, the same user must be created on the 
remote machine. 

Note:  The command, useradd, is typically located at /usr/sbin. 

useradd cyanea  

passwd cyanea 

mkdir /home/cyanea 

3. Create the username “admin” if it does not exist and assign a password using the 
following commands:

useradd admin

passwd admin 

mkdir /home/admin

4. [optional] Create the group "cyanea" using the following commands:

Note:  You can create a group called “cyanea” to organize your system; however, 
Application Monitor does not need this group to operate properly. 

For AIX:

mkgroup cyanea

For Solaris and Linux:

groupadd cyanea
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5. Change ownership rights of the newly created home directories to the users they 
belong to. For example:

chown cyanea:cyanea /home/cyanea

6. Login to the server using the “cyanea” and “admin” usernames and passwords.

The security set up on many systems requires the user to physically login for the 
first time. On some UNIX systems, you receive a prompt the first time you login, 
this prompt will cause the Application Monitor scripts to fail. 

Database Installation

The following instructions include all the information you need to set up your 
database for WSAM. You will probably need a DBA to perform these steps. 

Install Database

In order to install the Managing Server, you must first install a supported 
combination of a database and an application server.  The supported combinations are 
described in Table 2 on page 9.

Note:  This task may require a DBA skill set. 

Note:  The installer will create a UTF-8 database instance. If you are manually creating 
a database instance, you will need to create a UTF-8 database instance.

To install and configure DB2:

1. Install DB2 according to manufacturers instructions.

2. Install the necessary fixpacks to bring DB2 up to Fixpack 5.

3. Create a DB2 server instance according to the DB2 installation documentation, 
(unless you are using the default user and instance.)

To install and configure Oracle:

1. Install Oracle according to manufacturers instructions.

2. Install the necessary patches.

Setting up the Database

The following are instructions for preparing your database for installation. 

To prepare a DB2 database for installation:

If the Managing Server is AIX-based and it uses a local database, proceed as follows:

Note:  You do not need to perform steps 1-3 if a remote database is used or if a loop 
node has been created for using TCP/IP communication instead of shared memory 
communication.

1. Edit the file <db2_instance_home>/sqllib/db2profile

to include the following lines: 

EXTSHM=ON

export EXTSHM

The default location for the file is /home/db2inst1/sqllib/db2profile.

2. Log in as the instance owner (e.g. db2inst1):

su - db2inst1

3. As the instance owner, issue the commands:
 14 Application Monitor:Installation and Customization Guide



db2stop force

db2set DB2ENVLIST=EXTSHM

db2start

To prepare an Oracle database for installation: 

Create an Oracle database with a SID name octigate, using utility:

dbassist

Using a Remote Database 

The following instructions describe how to prepare the database used by the 
Managing Server, in cases where your database is installed on a different server than 
the Archive Agent (a component of the Managing Server.)

Within this section, we refer to the servers as follows:

• The server on which the Visualization Engine and Archive Agent are installed is 
the local server.

• The server on which the database is installed is the remote server.

Note:  In this scenario, you must install the database client (DB2) or JDBC libraries 
(Oracle) on the local machine.

Using Remote DB2

Create a consistent user on the local and remote database. The database server needs 
to have the same username and password as the Managing Server.

To install the DB2 client  on the the local server:

1. Install the DB2 client on the local machine.

After you prepare DB2 on the remote machine, and install the DB2 client on the local 
machine, you can proceed with the installation of the Managing Server, as described 
in “Run Installer” on page 21. 

To prepare remote DB2 for use with the Managing Server:

1. Install DB2 on the remote machine.

Note:  On the remote machine, a unix account for example, "cyanea" should be 
created  (the same as on the Managing Server.)

The following steps should be performed on a local machine.

2. Log in as a user with dba privileges, for example: db2inst1.

Note:  For convience purposes, you may want to log in as root.  In the following 
steps, you will be executing a script that prompts for the password multiple times.  
This can be avoided if you run it as root.

3. Catalog TCP/IP node pointing to remote node.  For example:

db2 catalog tcpip node <db2node> remote <Remote Server> server <db2 listening 

port>

4. Catalog database on the node just created.  For example:

db2 catalog db octigate at node <db2node> 

5. Create a temporary directory on remote machine in which to place the database 
installation scripts.  In this example we use /tmp.

6. ftp the file db2-remote-scripts.tar to the temporary directory. (Located in the 
Installer-MS/scripts directory.)
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Note:  The db2-remote-scripts.tar file is provided with the Managing Server 
distribution (in /Installer-MS/scripts/). 

7. Untar the db2-remote-scripts.tar file.

8. Run the db2install.sh script, specifying the database user name and installation 
directory.  For example:

cd /tmp/db2/bin 

sh db2install.sh <db username (db2inst1)> <db_user (cyanea)> <absolute path 
installation dir> 

Note:  The db username must have dba privileges, e.g. db2inst1.  

Note:  When you get prompted for password, enter the password for the db2inst1 
user.

Note:  The absolute path installation dir is a db2 directory in the temporary 
directory containing the installation scripts, e.g. /tmp/db2.

Note:  The db2install.sh script invokes the scripts db2configuration.sh and 
db2createschema.sh.  The db2configuration.sh script invokes the script 
dbsettings.sql, and the db2createschema.sh script invokes the cyaneaone-db2.sql 
script.

Using Remote Oracle

To use a remote Oracle database with the Managing Server, you must prepare the 
Oracle database on the remote machine, and install JDBC drivers on the local 
machine. 

To prepare to use remote Oracle with the Managing Server:

1. Install Oracle on the remote machine.

2. Create the SID for use by the Managing Server.  For example: octigate.

3. Create a temporary directory on the remote machine.  In this example we use 
/tmp.

4. ftp the file oracle-remote-scripts.tar to the temporary directory.

Note:  The oracle-remote-scripts.tar file is provided with the Managing Server 
distribution (in /Installer-MS/scripts/). 

5. Log in as a user with dba privileges.  For example: oracle.

6. Untar the oracle-remote-scripts.tar file. (Located in the Installer-MS/scripts 
directory.)

7. Export the ORACLE_SID used by the Managing Server.  For example:

export ORACLE_SID=octigate

8. Run the oracleinstall.sh script, which has the following format:

cd /tmp/oracle

sh bin/oracleinstall.sh <dba user> <dba password> <tablespace> <schema user> 
<schema password>

Note:  The <dba user> must be the owner of the Oracle database hierarchy.  For 
example: system.

Note:  The <tablespace> is the name of the tablespace that will be created when 
you run the oracleinstall.sh script.  This is the tablespace the Managing Server will 
use.

Note:  The <schema user> and <schema password> are the login and password of 
the user that the Managing Server uses to connect with the database, using JDBC.  
This same login and password must be used during the Managing Server 
installation.
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To install JDBC libraries on the the local server:

Install the thin JDBC drivers on the local machine.

After you prepare Oracle on the remote machine, and install the JDBC drivers on the 
local machine, you can proceed with the installation of the Managing Server, as 
described in “Run Installer” on page 21. 

Setting the Environment

In order to set up the proper environment for the Managing Server, it may be helpful 
to set up a profile for the “cyanea” user that is appropriate for your application server 
and database. In addition, if your security policies allow, it may be helpful for these 
environment variables to be added to the ’root’ user as well. 

The examples in this section assume that the "cyanea" user uses the bash or bourne 
shell, which means you can add the appropriate lines to the .bash_profile or .profile in 
the home directory of the “cyanea” user.   If you are using another shell, you must use 
the appropriate syntax in the appropriate startup script for your environment.

WebSphere 

Include in the profile of  the “cyanea” user (likely found under 
/home/cyanea/.profile) the following:

• Point WAS_HOME to the location of the local WebSphere application server 
installation directory, which is typically one of the following:

For AIX (example):

 /usr/WebSphere/AppServer

For Intel/Linux, z/Linux and Solaris  (example):

/opt/WebSphere/AppServer

• Point JAVA_HOME to the location of the JDK, which is typically the following:  

${WAS_HOME}/java

• Modify PATH to include ${JAVA_HOME}

The following lines are an example of the code to insert into the profile: 

For AIX:

WAS_HOME=/usr/WebSphere/AppServer; export WAS_HOME

JAVA_HOME=${WAS_HOME}/java; export JAVA_HOME

PATH=${JAVA_HOME}/bin:${PATH}; export PATH

For Intel/Linux, z/Linux and Solaris: 

WAS_HOME=/opt/WebSphere/AppServer; export WAS_HOME

JAVA_HOME=${WAS_HOME}/java; export JAVA_HOME

PATH=${JAVA_HOME}/bin:${PATH}; export PATH

DB2

Based upon your decision to use either a remote or a local database, perform these 
instructions on that machine. Include in the profile of the “cyanea” (likely found 
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under /home/cyanea/.profile, may be at different location for your environment) 
user the following:

• Source the files db2profile, which is  located in the sqllib subdirectory of the DB2 
home directory respectively. 

• Source the files db2profile, which are located in the sqllib directories under the 
DB2 home directory respectively. 

The following lines are an example of the code to insert into the profile, if it already 
exists you don’t have to do this: 

if [ -f /home/db2inst1/sqllib/db2profile ]; then

 .  /home/db2inst1/sqllib/db2profile

fi

Note:   All references to db2inst1 should be replaced with the appropriate DB2 
instance name.

Oracle

No updates required. 

Example Configurations

The following is an example of a profile for WebSphere and DB2 on Linux:

   

 

Gather Configuration Information

The graphical installer will prompt you to enter configuration information about your 
application server, database, logins and filesystem.  Gather this information before 
you run the graphical installer, since you will need it to complete the installation.

In all cases, you need the information about the Managing Server.  However, the 
specific information you need to gather about the application server and database 
depends on which ones you use.

Note:  If you are using a remote database, make sure the settings you use for the 
database match those of the remote database.

DB2

If you are using a database installed on the same machine as the Managing Server, 
and it is DB2, gather the following information before you run the graphical installer:

EXAMPLE  profile for user "cyanea" for WebSphere and DB2 on Linux

WAS_HOME=/opt/WebSphere/AppServer; export WAS_HOME

JAVA_HOME=${WAS_HOME}/java; export JAVA_HOME

PATH=${JAVA_HOME}/bin:${PATH}

if [ -f /home/db2inst1/sqllib/db2profile ]; then

   .  /home/db2inst1/sqllib/db2profile

fi
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• DB2 Installation directory (/home/db2inst1)

• DB2 instance (db2inst1)

• Fully qualified JDBC Driver jar file (/home/db2inst1/sqllib/java12/db2java.zip)

Oracle

If you use Oracle, gather the following information before you run the graphical 
installer:

• Oracle host name 

• Oracle port (1521)

• Oracle SID (octigate)

• JDBC User (cyanea)

• JDBC User password (cyanea)

• Fully qualified JDBC Driver classes jar file (/opt/oracle/jdbc/lib/classes12.zip)

• Fully qualified JDBC Driver charset jar file 
(/opt/oracle/product/8.1.7/jdbc/lib/nls_charset12.zip)

In addition, if you are using an Oracle database installed on the same machine as the 
Managing Server, then you must gather the following information before you run the 
graphical installer. (If you are using Oracle remotely, you will need this information 
for setting up the remote database:)

• UNIX username that can run sqlplus (oracle)

• Tablespace name (for use with the Managing Server) (cyanea_ts)

• DBA User name (system)

• DBA User password (manager)

Setting up the Graphical Environments

In order to display graphs, the Managing Server needs a connection to an X Window 
display.  To accomplish this, start a virtual frame buffer X server, and set your 
environment appropriately.

To set up the graphical environment for the Managing Server installer: 

1. Log in as root or whatever user you will be using to install the application server.

2. Start the Virtual X environment:

Linux

Xvfb :1 &  

(Typically located in /usr/X11R6/bin.)

AIX

X –vfb –force :1 &

(Typically located in /usr/bin/X11/X.)

Solaris

Xvfb :1 &

(Typically located in /usr/X/bin.)

z/Linux

Xvfb :1 &  

(Typically located in  /usr/bin/X11.)
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You may verify this by using the following command: 

ps -ef | grep xvfb

This command may vary according to the shell you are using. 

Gather Configuration Information

The graphical installer will prompt you to enter configuration information about your 
application server, database, logins and filesystem.  Gather this information before 
you run the graphical installer, since you will need it to complete the installation.

In all cases, you need the information about the Managing Server.  However, the 
specific information you need to gather about the application server and database 
depends on which ones you use.

Note:  If you are using a remote database, make sure the settings you use for the 
database match those of the remote database.

Managing Server

Determine the values you will use for the following names, directories, files and ports 
(defaults listed in parentheses):

• "cyanea" user UNIX password (cyanea)

• Managing Server installation directory (/opt/cyaneaone)

• Primary Kernel server name (<Hostname for Managing Server>)

• Primary Kernel Codebase server port (9122)

• Primary Kernel RFS server port (9120)

• Primary Kernel RMI server port (9118)

• Secondary Kernel server name (<Hostname for Managing Server>)

• Secondary Kernel Codebase server port (9123)

• Secondary Kernel RFS server port (9121)

• Secondary Kernel RMI server port (9119)

• Archive Agent 1 Port (9129)

• Archive Agent 2 Port (9130)

• Publishing Server 1 Port (9103)

• Publishing Server 2 Port (9104)

• Message Dispatcher Port (9106)

• Polling Agent Port (9111)

• Global Publish Server 1 Port (9126)

• Global Publish Server 2 Port (9127)

WebSphere

If you are using WebSphere as your application server, gather the following 
information before you run the graphical installer:

• WebSphere instance host name and SOAP port (8880)

— If using ND, provide the hostname and SOAP port of the Deployment 
Manager instead. 

• WebSphere application server name (cyanea)
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If Global Security is turned on, provide the WebSphere Username and Password of a 
WebSphere user with administrative rights.: 

• WebSphere Username

• WebSphere Password

DB2

If you are using a database installed on the same machine as the Managing Server, 
and it is DB2, gather the following information before you run the graphical installer:

• DB2 Installation directory (/home/db2inst1)

• DB2 instance (db2inst1)

• Fully qualified JDBC Driver jar file (/home/db2inst1/sqllib/java12/db2java.zip)

Oracle

If you use Oracle, gather the following information before you run the graphical 
installer:

• Oracle host name 

• Oracle port (1521)

• Oracle SID (octigate)

• JDBC User (cyanea)

• JDBC User password (cyanea)

• Fully qualified JDBC Driver classes jar file (/opt/oracle/jdbc/lib/classes12.zip)

• Fully qualified JDBC Driver charset jar file 
(/opt/oracle/product/8.1.7/jdbc/lib/nls_charset12.zip)

In addition, if you are using an Oracle database installed on the same machine as the 
Managing Server, then you must gather the following information before you run the 
graphical installer. (If you are using Oracle remotely, you will need this information 
for setting up the remote database:)

• UNIX username that can run sqlplus (oracle)

• Tablespace name (for use with the Managing Server) (cyanea_ts)

• DBA User name (system)

• DBA User password (manager)

Run Installer

Before you install the Managing Server, make sure you follow the procedures for 
upgrading, if appropriate (“Upgrading Considerations” on page 23,) and for 
preparing to install (“Preparing to Install” on page 10) and follow the instructions 
found earlier in this chapter. 

Note:  When upgrading Managing Server if you want to migrate data , make certain 
your input is ’No’ when entering the value for  re-initializing the database by the 
installer. 

Note:  If you are using a remote database, make sure that you have followed the 
instructions on “Using a Remote Database” on page 15 before you install the 
Managing Server.

Note:  Make sure the Application Server type and version, and the operating system 
type and version you are using are supported. (If the installation environment does 
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not meet the pre-requisites, the installer pre-requisite check will fail and you will be 
unable to continue the installation. If you wish to proceed with the installation, you 
can bypass the pre-requisite check by passing the parameter "-force" to install-MS.sh.

Note:  The installer will create log files in /tmp/cyanea_installer_ms/ during the 
installation. After installation is complete, you can find a copy of the logs in the 
<cyanea_home>/logs directory. 

Note:  If the pre-installation steps for users "cyanea" and "admin" were not correctly 
performed, the installer will not open, and will display errors in the console.

Note:  If running the installation from a remote machine, enter: xhost + on the 
machine on which you are installing the Managing Server. 

To install the Managing Server:

1. Start your J2EE server. 

Note:  If you are in an ND environment then you must start the following.

• Deployment Manager

• Node Agent

• WebSphere instances to be monitored

2. Log in as the root user.

3. Source the profile for the "cyanea" user described in“Setting the Environment” on 
page 17. Or if you wish, set the environment variables appropriate to your 
environment manually.  

source ~cyanea/.profile

This command may vary according to the shell you are using. 

4. Refer to “Setting the Environment” on page 17 to verify this has completed 
correctly, by issuing the following commands:

For WebSphere:

echo $WAS_HOME

echo $JAVA_HOME

echo $PATH

Make sure that the output from the echo command matches your inputs.

5. Locate the file MSInstall.tar in the installation media. Go to the directory where 
you downloaded MSInstall.tar and extract the contents to a temporary directory:

mkdir /tmp/cyainst

cp MSInstall.tar /tmp/cyainst

cd /tmp/cyainst

tar xf MSInstall.tar

6. If you want to perform an Interactive (GUI) install go to Step 6a. If you want to 
perform a non-Interactive (silent) install go to step 6b.

a. If running the installation on a remote server, export the display to your local 
workstation using the following command: 

DISPLAY=<workstation>:0; export DISPLAY

Run installer (You must be in this directory of the installer to work properly.):

cd /tmp/cyainst/Installer-MS/bin/

sh install-MS.sh

b. Create a copy of the sample response file.

cd /tmp/cyainst/Installer-MS/etc

cp msInputs_Sample.txt msInputs.txt
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Edit the response file msInputs.txt. The parameters required are documented 
within the text file.

Run the installer in silent mode. 

cd /tmp/cyainst/Installer-MS/bin/

sh install-MS.sh -silent ../etc/msInputs.txt

Upgrading Considerations

Migrating Data

To complete an upgrade of the Managing Server to v3.1 from any earlier version, you 
must migrate the data in the database.

Performing a Migration

 These instructions describe how to migrate your data from v2.1.3 so that they are 
compatible with the Application Monitor v3.1.

Note:  First BACKUP the existing octigate database so you preserve all your data 
under the previous schema. 

To migrate the data of the Application Monitor database to v3.1 from v.2.1.3:

1. Make sure your Managing Server components are not running.

2. Update the setenv.sh file in the $CYANEA_HOME/bin directory with the 
following variable definitions: 

• For DB2                  

${JDBC_DRIVER_NAME}=COM.ibm.db2.jdbc.app.DB2Driver

${JDBC_DRIVER_JAR}=<directory of DB2v8 INSTANCE 
HOME>/sqllib/java12/db2java.zip

${JDBC_DRIVER_URL}=jdbc:db2:octigate

${JDBC_USER}=cyanea

${JDBC_PASSWORD}=<cyanea’s password>

• For Oracle            

${JDBC_DRIVER_NAME}=oracle.jdbc.pool.OracleConnectionPoolDataSource

${JDBC_DRIVER_JAR}=<directory which has classes12.zip>/classes12.zip

${JDBC_DRIVER_URL= jdbc:oracle:thin:@<oracle database 
server>:<port>:octigate

${JDBC_USER}=<cyanea database user name>

${JDBC_PASSWORD}=<cyanea database user password>

3. For Oracle database users, backup data from v2.1.3 if needed. Otherwise, go to 
step 7 directly.

4. Execute data migration scripts: You should be logged in as user “cyanea”.

• Excute SQL script: 

— For DB2 database, do db2 connect to octigate: 

db2 –tf $CYANEA_HOME/etc/migratetables-db2.sql > 
$CYANEA_HOME/logs/migratedb.log

—  For Oracle database, go to Oracle database server, do sqlplus:

<cyanea database user name>/<cyanea database user password>@<cyanea 
ORACLE_SID> @$CYANEA_HOME/etc/migratetables-oracle.sql > 
$CYANEA_HOME/logs/migratedb.log
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Note:  All $CYANEA_HOME should be replaced with real directory name.

• Execute the following shell scripts in $CYANEA_HOME /bin: 

./migration.sh

5. Bring up all servers.

Note:  Log files during migration are located in $CYANEA_HOME/logs.

Starting the Application Monitor

Note:  Verify that your application server, database, virtual frame buffer and 
optionally HTTP server are running. 

For most UNIX platforms you can verify it as follows: 

1. To verify the application server, go to admin console to make sure your server is 
up. 

2. To verify database is up, establish a database connection. 

3. To verify Virtual Frame Buffer: 

ps -ef | grep Xvfb

4. To verify HTTP server:

ps -ef | grep httpd

To start the Application Monitor, follow these steps:

1. Switch to user “cyanea”. 

su - cyanea

2. Go to the bin directory where the Application Monitor is installed and run the 
cyanea-start.sh script.

cd /opt/cyaneaone/bin
sh cyanea-start.sh

3. Using the terminal window, start the application server by typing the commands 
appropriate for your application server:

WebSphere

Note:  Login as the user who is authorized to start WebSphere. If you are using a 
user other than "cyanea", make sure you have a db2 profile set. If not, run 
/home/db2inst1/sqllib/db2profile. 

cd /<WebSphere Install directory>/bin 

DISPLAY=<hostname>:1; export DISPLAY

sh startServer.sh Cyanea &

Note:  Substitute the name of the application server you are using for the 
Visualization Engine in place of Cyanea. 

4. If your Web environment requires an HTTP server, and the HTTP server is not 
running, change directory to your HTTP Server and start it as root as follows: 

Linux:

cd /opt/IBMHTTPServer/bin

./apachectl start

AIX: 

cd /usr/HTTPServer/bin/

./apachectl start

The exact path depends on the convention used at your site. 
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5. To log into the monitoring console, open a browser and type in:

http://<hostname>/cyanea_one/home

You can use the user name “admin” and UNIX password for UNIX user “admin” 
to log in.

Note:  If your J2EE application server is not setup to be served on port 80, and you 
have not setup an HTTP server to do so, you have to include the port number in 
the URL. For example, the default port that WebSphere 5.1.1 listens on port 9080. 

http://<hostname>:<port>/cyanea_one/home
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Chapter 4. Customization

Follow the instructions below to complete the customization of your environment. 
For information on setting up cron jobs for maintenance, see the Operator’s Guide.

Setup Email Host

The Application Monitor includes a “traps” feature that allows the user to have email 
messages sent when certain thresholds are reached. To have this feature work 
correctly, the SMTP host needs to be specified. 

Note:  The Performance Analysis & Reporting (PAR)  section and the Traps section 
will not email reports without this step. 

To do this, edit the file: 

/opt/cyaneaone/etc/md.properties

and specify the correct IP address of the SMTP host or hostname (A valid email server 
is required; contact your Email Administrator for this information) for property as:

smtp.host=aa.bb.cc.dd

where aa.bb.cc.dd should be substituted with the IP address of the SMTP host.

Setup init.d

You may skip this section if you do not want the Application Monitor to start 
automatically upon reboot. 

Activate appropriate scripts that can start the following components automatically 
upon reboot in the following sequence:

1. Virtual Frame Buffer

2. DB2 or Oracle (DB2 installation may have already created this.)

3. HTTP Server

4. WebSphere

5. cyanea

To set up the Application Monitor scripts to restart automatically, do the following:

The installation program will install a script for starting the Managing Server back 
end components automatically at boot time.  To enable the startup script, please 
follow the instructions below for each platform.  You must login as root to run any of 
the commands.

Linux: The installation program will install /etc/rc.d/init.d/cyanea. To enable 
automated startup at boot time, add cyanea service with chkconfig command as 
follows:

/sbin/chkconfig –add cyanea

AIX: The installation program will install /etc/rc.cyanea. To enable startup by 
process init, add the following line to the /etc/inittab file: 

msbackend:234:once:/etc/rc.cyanea start
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Solaris: The installation program will install /etc/init.d/cyanea. To enable automated 
startup at boot time, you must create the links below.  You may want to modify the 
sequence numbers (S91, K36) according to local conventions.

ln -s /etc/init.d/cyanea /etc/rc2.d/S91cyanea                                                   
ln -s /etc/init.d/cyanea /etc/rc1.d/K36cyanea                                            
ln -s /etc/init.d/cyanea /etc/rc0.d/K36cyanea                                                   
ln -s /etc/init.d/cyanea /etc/rcS.d/K36cyanea

 If you are upgrading, be sure to remove the old startup entry

cyna:234:once:/etc/rc.cyanea start

 from /etc/inittab in Solaris.

Setup SNMP

If you want to setup SNMP, see the following instructions:

• Appendix A, “Tivoli TEC Integration,” on page 115.

• Appendix B, “BMC Patrol Integration,” on page 137.

Setup Regular Database Tuning

To keep the Application Monitor performing well you may wish to tune the database 
periodically via a regularly scheduled Cron job. For details, refer to the Operator’s 
Guide. 

Increase Linux Kernel Setting

RedHat Intel/Linux Managing Server: If you are using a Linux Managing Server, you 
should change the MSGMNI kernel variable. This is an IBM recommendation for DB2 
performance tuning. 

You can issue (as root), the following command to set it to 1024.

sysctl –w kernel.msgmni =1024

To check the current setting, use:

ipcs -l

Configuring Your Firewall

Follow the instructions below to configure the firewall between the managing server 
and the Data Collector. 

Note:  If you do not have a firewall between your Managing Server and your Data 
Collector, please ignore these instructions. 

To configure your firewall: 

1. Open the following ports on the firewall from both directions: 9102-9104 9111 
9118-9123 9126 9127 8300 8200. (Assuming you used the default settings.) 

2. Update the datacollector.properties file (on the maching running the Data 
Collector). This is typically located at /opt/cyaneaone/etc (the installation 
directory): 

probe.rmi.port=8300

probe.controller.rmi.port=8200
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3. If there is more than one Data Collector installed on a node, you must open a port 
for each Data Collector in both ranges starting from 8200 and 8300. Then assign 
unique values for each in the respective datacollector.properties files. 

Note:  You can use the optional component, Port Consolidator, to minimize the 
number of ports required. 

Parameters Specified with Multiple Network Cards 

To install multiple network cards: Make sure that the IP specified for the Managing 
Server are IPs that can be used to talk to each other (i.e if there is a network config 
where one of the IPs does not have a path to the other box, don’t use that IP). 

1. On the Managing Server, in setenv.sh (in $CYANEA_HOME/bin), set the 
KERNEL_HOST01 and KERNEL_HOST02 to the IP address of the managing 
server. 

2. On the Managing Server, in $CYANEA_HOME/bin/klctl.sh, add a Java system 
property to the java command line in the “start” section of the script and set it to 
the IP address of the Managing Server: 

java.rmi.server.hostname=<hostname> 

3. On the Managing Server, repeat step 2 for $CYANEA_HOME/bin/psctl.sh. 

In addition, if the Managing Server was installed on multiple boxes, make the changes 
above on all the boxes where the Managing Server was installed. 
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Chapter 5. Troubleshooting

The following information will help you in troubleshooting problems with your 
installation. 

Test Database Connection

If the installation appears to succeed, you should test the database connection.

WebSphere (DB2 or Oracle)

The installation program creates a data source. The following procedure tests if the 
installation was successful. 

Note:  In the case of an Oracle database, you have to perform the following steps:

1. In the WebSphere adminiistrative console, expand the tree Security > JAAS 
Configuration > J2C Authentication Data. 

2. Click on Cyanea J2C Authentication data entry.

3. Click Apply. 

To test the database connection:

1. In the WebSphere administrative console, expand the tree Resources > JDBC 
Providers.  

2. Select the name of the JDBC provider. 

3. At the bottom of the page, select Data Sources.

4. Place a checkmark in the box next to the correct data source. 

Figure 2. Data Sources

5. Click Test Connection to verify that WAS can connect successfully to the octigate 
database. If connected successfully, a message will display at the top of the screen. 

If the test fails, try verifying the following:

• Try to connect to the octigate database manually using the DB2/Oracle 
command line processor. 

• Verify the user name, password, and database name. If using Oracle, check to 
make sure the URL has the following format:
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jdbc:oracle:thin:@<db host>:<port>:<SID>

For example:

jdbc:oracle:thin:@perfdb-sun-so1.cyanea.com:1521:octigate

• Verify that the user which is used to start the WebSphere console has a DB2 
profile as part of its profiile. 

Authentication

If your passwords have expired or you have changed the passwords, you need to 
modify your password in <cyanea_home>/bin/setenv.sh and in the WebSphere data 
source. 

Database Problems

If the managing server uses an Oracle database and you see SQL syntax errors, check 
ve.properties file and make sure com.cyanea.octigate.database.ORACLE_8I is set to Y. 
If not set the property to Y, and restart the VE. For example:

com.cyanea.octigate.database.ORACLE_8I=Y

Viewing the Error Logs

The following is a list of additional error logs created by the Application Monitor. 

Visualization Engine (VE) - cyaneaone_ve_stderr.txt (VE standard error), 
cyaneaone_ve_stdout.txt (VE standard output), cyaneaone_system.log (All log 
messages from the VE.)

Note:  You may see the following exception for WebSphere 4.X on z/OS (which does 
not have PMI support.)  This exception can be safely ignored.

ERROR [publish.smf.SmfTask] (SmfTask.java:254    ) -

Error !!! {0}

java.lang.NullPointerException

        at com.cyanea.publish.smf.SmfTask.sendThreadPoolToTrap(SmfTask.java:317)

        at com.cyanea.publish.smf.SmfTask.pollPerfSummary(SmfTask.java:246)

        at com.cyanea.publish.smf.SmfTask.poll(SmfTask.java:195)

        at com.cyanea.publish.smf.SmfTask$SmfTimerTask.run(SmfTask.java:527)

        at java.util.TimerThread.mainLoop(Timer.java(Compiled Code))

        at java.util.TimerThread.run(Timer.java:395)

Kernel Log - cyaneaone_kl1.log (1st instance) and cyaneaone_kl2.log (2nd instance)

Publish Server Log - cyaneaone_ps.log (1st instance), cyaneaone_ps2.log (2nd 
instance), cyaneaone_ps_audit.log (This file logs the trap related messages from the 
Publish Server.)

Global Publish Server Log - cyaneaone_sam.log

Archive Agent Log - cyaneaone_aa1.log (1st instance) and cyaneaone_aa2.log (2nd 
instance)

Polling Agent Log - cyaneaone_pa.log

Audit Messages - cyaneaone_audit.log

Message Dispatcher Log - cyaneaone_md.log
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To Change Username/Password for WSAM Application Monitor

To change username/password for admin user:

1.  Create a local UNIX account associated with the new user, <newusername>.

2. Update USERS table in WSAM database by doing:

For DB2:

db2 connect to <wsam database>

db2 "update users set username = <newusername>, ext_user = <newusername> where 
username = 'admin' and ext_user = 'admin'"

For Oracle:

export ORACLE_SID=<wsam sid>

sqlplus <wsam username>/<wsam password>

update users set username = <newusername>, ext_user = <newusername> where 
username = 'admin' and ext_user = 'admin'

To change "cyanea" user to a new username in WebSphere:

1.  Login to the WebSphere admin console where VE is installed.

2. Expand Resources ==> JDBC Providers ==> Choose the JDBC Provider for 
WSAM ==> Data Sources ==> Choose WSAM DataSource (CyaneaDataSource) 
==> J2C Authentication Data Entries ==> Choose WSAM J2C Authentication 
Data Entries ==> In User ID field, type in the new user, in password field, type in 
the password corresponding to the new user. ==> Click on OK ==> Save the 
change ==> restart the AppServer.
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Chapter 6. Uninstalling the Managing Server 

The following instructions describe how to uninstall the Managing Server. 

Note:  Prior to uninstalling the Managing Server, make sure you do the following:

• Disable all Data Collectors.  See Chapter E, “Setting up an HTTP Server with your 
Managing Server,” on page 183 and Chapter 11, “Uninstalling the z/OS Data 
Collector,” on page 87 for instructions on disabling Data Collectors.

• Stop the Managing Server.

Remove the Application Monitor Database

DB2

1. Login as the DB2 admin user.

2. Check the databases on the box using, 

db2 list db directory

3. Drop the database by issuing the command: 

db2 drop db octigate

Oracle

To remove the database, use the command line tool: 

dbassist

Uninstall the J2EE Application Server

WebSphere

1. Launch WebSphere Admin Console.  

2.  Expand Applications. 

3. Click Enterprise Applications. 

4. To stop the Enterprise Application, select the Octigate application. 

5. Click Stop.

6. To uninstall the Enterprise Application, select the Octigate application.

7. Click Uninstall. 

8. To uninstall the Data Source, expand Resources.

9. Select JDBC Providers. 

10. Select DB2 Legacy CLI-Based Type 2 JDBC Driver.

11. Select Data Sources.

12. Select Cyanea Data Source.

13. Click Delete.

14. Go to the /<Websphere_home>/bin directory. 
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15. Issue the command: 

stopServer.sh <cyanea>

Shutting Down the Managing Server 

WebSphere

In order to shut down the Managing Server you need to shut down the cyanea 
components, including the Application Monitor, WebSphere, HTTP server, and DB2. 

To shut down the Application Monitor:

1. Login as the cyanea user: 

su -cyanea

2. Go to the Cyanea Home directory: 

cd /<cyanea_home>/bin

3. Stop the Application Monitor: 

./cyanea -stop.sh

To stop WebSphere:

1. To stop WebSphere, go to the /<Websphere_home>/bin directory. 

2. Issue the command: 

stopServer.sh <cyanea>

or issue the command: 

killall java 

3. To check for Java processes, issue the command: 

ps -ef | grep java

To stop the HTTP server:

1. Go to the HTTP server home directory: 

cd /<http server home>/bin

2. Issue the command:

 ./apachectl stop

3. To check if the server is down, issue the command: 

ps -ef | grep http

To stop DB2:

1. Login as the DB2 admin user.

2. Issue the command: 

db2stop

3. To check if DB2 is down, issue the command: 

ps -ef |grep db2

Note:  You must take the DB2 server down last. When restarting, you must bring 
the DB2 server up first in the process. 

Uninstall the Application Monitor Files

The following instructions describe how to uninstall the Application Monitor files. 
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To uninstall the Application Monitor files:

1. Login as root, and remove <managing server installation directory>.

2. If you added the line kernel.msgmni=1024 in /etc/sysctl.conf, remove it.

3. For Linux:* If you copied the "cyanea" script to /etc/rc.d/init.d, remove it.

For AIX: * If you copied the "cyanea" script to /etc, remove it.
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Part 3. The Data Collector for z/OS
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Chapter 7. Preparing to Install

Planning Your Installation

The following information will help you plan the installation of the z/OS Data 
Collector. 

Platform Pre-requisites

   

 

Warning: We do not recommend installing the Data Collector into the Admin Console 
server (non-ND environment), Node Agent, or Deployment Manager (ND 
environment). In addition, all UNIX command references here are based on the bash 
shell. 

MVS Component Considerations

• If you want SMF or WLM data, install CYN1PROC address space. See “Installing 
MVS Components” on page 46. 

• For SMF, turn on SMF option in WebSphere. See Chapter 9, “Customization,” on 
page 75.

Space Management

The installation process and documentation use the /<installation 
directory>/wsam/<server>/ as  the installation directory reference of  the USS 
components of the Data Collector. When the Data Collector starts for the first time, it 
generates three files in the/<installation directory>/wsam/<server>/etc directory.

• <sysplex>.<server instance name>.datacollector.properties

• <sysplex>.<server instance name>.id

•  cyanea.mod

 The generated files in the /<installation directory>/wsam/<server>/etc directory 
should not be deleted except under direction from Level 1 and Level 2 Product 
Support team.  Also see “General” on page 58 for the usage, customization, and 
maintenance of these generated files. Each time the Data Collector starts, it will 
generate a new log file in the /<installation directory>/wsam/<server>/logs 

Table 4. z/OS Data Collector Pre-requisites

Operating 
System Application Server JDK Optional Software

z/OS 1.2 - 
1.4

WebSphere 5.0.2.012, 
5.1.0.003

JDK 1.3 (cm131s-
20040117) for 
WebSphere 5.0.2

JDK 1.4 (cm1411sr2a-
20040515) for 
WebSphere 5.1

MQ5.3.1, DB2 7.1( 0311),DB2 7.0 
Universal Driver
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directory.  The generated log files should be cleaned up (deleted) as available space 
dictates.

As files initially are generated to the /<installation directory>/wsam/<server>/etc 
directory and ongoing to the /<installation directory>/wsam/<server>/logs 
directory, these directories must be READ-WRITE. This may be accomplished by 
mounting a unique HFS file over the /<installation directory>/wsam/<server>/ 
directory or by creating a symbolic link that will redirect access from the 
/<installation directory>/wsam/<server>/logs and /<installation 
directory>/wsam/<server>/etc directories to another set of directories that are 
READ-WRITE.

Network Considerations

If your LPAR has more than one IP address, make sure your system and/or network 
(DNS) are configured such that the primary IP is used for all connections between the 
Data Collector and Managing Server. You can use the netstat- command to check the 
IP’s being used. Alternatively you may specify the IP to be used by Application 
Monitor in the WebSphere configuration via the java.rmi.server.hostname parameter 
in WAS_JAVA_OPTIONS for z/OS WebSphere 4 and in JVM Servant property in 
z/OS WebSphere 5. See Chapter 10, “Troubleshooting,” on page 85 for more detailed 
information.

Installation Overview

Pre-requisites

• Must have the Managing Server installed and configured.  See Part 2, “The 
Managing Server Installation,” on page 7 for more detail reference. 

• Review section Chapter 7, “Preparing to Install,” on page 41  to ensure all 
necessary software and resources are in place prior to installing the Data 
Collector. 

 

Overview

1. Data Collector Installation and Configuration. See Chapter 17, “WBI JDBC 
Adapter Data Collector,” on page 111 for more detail. It includes: 

a. Download the software (SMP/E or non-SMP/E format).

b. Un-package/Un-tar the distributed software to the proper mainframe 
environment. 

c. Install MVS components. 

d. Install USS component. 

e. Verify the files fromthe distributed package are indeed all there. 

f. Configure Data Collector on USS side. 

g. Update/Configure WebSphere variables.

h. Quick start/test of the Application Monitor. 

i. Configure distinct Application Server instances. 

2. Customize the Application Monitor with optional support, e.g., PMI, SMF, JDBC, 
and MQI.  See Chapter 9, “Customization,” on page 75.   
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System Access and Levels of Authority

In some environments a systems support staff person may have responsibility and 
access to many areas of the system such as WebSphere, MVS and Security (RACF). In 
other Installations the areas of responsibility will be spread across groups; in fact, 
these areas of responsibility may reside in distinctly different reporting structures of 
the business. To facilitate installation of the Application Monitor  z/OS Data Collector 
it is important to understand there will be an update of the WebSphere 
Administration Console, the MVS Parmlib, Linklib and Proclib and possibly the 
security system (RACF) to permit definition of an authorized library. Thus, the 
appropriate support staff should be included in the planning and implementation 
process for the Application Monitor.
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Chapter 8. Installation and Configuration

Unpackaging Data Collector Software

The packaging of the Data Collector can be in either SMP/E or non-SMP/E install 
format.

SMP/E Install

SMP/E format can be downloaded from the IBM website. Simply follow IBM 
instructions for unpackaging the software. 

Non-SMP/E Install

Download Distribution Files from the Website to Windows PC

1. Create a directory C:\zos.  

Download the Data Collector software to the newly created PC directory.  The 
following files should be copied to the PC.

   

 
1<version> is the Application Monitor version information, for example, 31 refers 
to the Application Monitor 3.1.

Unpacking the Product Documentation

Use an available “unzip” program such as PKZIP or WINZIP to unpack the 
documentation (document.zip).  This contains the following manuals in PDF format:

• Installation and Customization Guide (SC31-6312-02).

• Operator's Guide (SC31-6313-02).

• Messages and Codes (SC31-6315-02).

• User’s Guide (SC31-6314-02).

Table 5. Files Copied to the PC

File Name Function

installation_guide.zip Compressed (zip) file containing installation instructions. 

operators_guide.zip Compressed (zip) file containing operational guide. 

msg_code.zip Compressed (zip) file containing message code 
information. 

user_guide.zip Compressed (zip) file containing user guide. 

zWAS_DC_<version>1_MVS.tar Tar file for the z/OS TSO library.

zWAS502_DC_<version>1_USS.
tar

Tar file of the mvs/uss segment for zWAS5.0.2 z/OS 
DataCollector.

zWAS510_DC_<version>1_USS.
tar

Tar file of the mvs/uss segment for zWAS5.1 z/OS Data 
Collector.
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Information as well as a download of the WINZIP program may be found on the 
internet at www.winzip.com.

Installing the Data Collector

Once you have unpackaged the Data Collector files from either SMP/E or non-
SMP/E format, continue with the following instructions. 

Installing MVS Components

This MVS installation is optional support for SMF and WLM. If you choose not to 
install the MVS component, SMF and WLM data will not be shown in the Managing 
Server VE.

The following instructions describe how to install the MVS components:

• “Pre-allocating Files on MVS”

• “Extract z/OS TSO Tar File”

• “Transferring Files from the PC to MVS” on page 47

• “Installing the MVS files” on page 47

• “Defining Subsystem CYN1” on page 47

• “Authorizing Data Sets and Updating the Linklist” on page 48

• “Installing the IEFU83 Exit” on page 48

• “Initializing MVS” on page 49

• “Verifying the MVS Components” on page 52

Pre-allocating Files on MVS

Pre-allocate datasets on the MVS system using the following JCL:

//S1JOB JOB …..installation dependent job card parameters

//S1  EXEC PGM=IEFBR14

//DD1  DD  DISP=(NEW,CATLG),UNIT=3390,VOL=SER=volumename,

//                  DCB=(LRECL=80,BLKSIZE=3120,RECFM=FB,DSORG=PS),

//                  SPACE=(CYL,(2,1)),DSN= CYN.CINSTALL.ACYNAUTH

//DD2  DD  DISP=(NEW,CATLG),UNIT=3390,VOL=SER=volumename,

//                  DCB=(LRECL=80,BLKSIZE=3120,RECFM=FB,DSORG=PS),

//                  SPACE=(CYL,(2,1)),DSN=CYN.CINSTALL.ACYNPROC

Where volumename is the volser for these temporary files.  These files may be deleted 
and un-cataloged at the end of the installation process after the TSO RECEIVE process 
has completed.

Extract z/OS TSO Tar File

1. Go to c:\zos directory in PC Window environment and double click on the tar file 
zWAS_DC_<version>_MVS.tar.

2. You now should see the following files in C:\zos:

cyn.cinstall.acynauth

cyn.cinstall.acynproc
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Transferring Files from the PC to MVS

1. FTP files from the PC C:\zos directory to the MVS systems. 

2. From the PC connect to the MVS system and log onto TSO to “receive” the files.

To transfer (ftp) pre-install files from your PC to the MVS system:  At the PC 
Command Prompt issue the commands:

ftp  ipname 

(where IPNAME is the IP address of the MVS system. When prompted for 
userid/password provide the appropriate userid and password.)

lcd    c:\zos 

bin

cd    ‘cyn.cinstall.acynauth’ 

put   ‘cyn.cinstall.acynauth’

cd    ‘cyn.cinstall.acynproc’

put   ‘cyn.cinstall.acynproc’

quit

Installing the MVS files

Log onto TSO and at the TSO READY prompt issue the commands:

 

receive indata(‘cyn.cinstall.acynauth’)

You will receive system messages:

INMR901I Dataset………..

INMR906A Enter Restore Parameters ~ ‘Delete’ or ‘End’ +

da(‘cyn.scynauth’) volume(volser)

(Where volser is the volume serial number of the disk to install the file.)

receive indata(‘cyn.cinstall.acynproc’)

You will receive system messages:

INMR901I Dataset………..

INMR906A Enter Restore Parameters ~ ‘Delete’ or ‘End’ +

da(‘cyn.scynproc’) volume(volser)

(Where volser is the volume serial number of the disk to install the file.)

Defining Subsystem CYN1

DYNAMIC SUBSYSTEM DEFINITION:  The above Parmlib Update will take effect 
with the next IPL of the system and is permanent. An IPL of the system is not required 
to dynamically add a subsystem. The following command will define the CYN1 
subsystem without an IPL and will remain in place until the next IPL:
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Note:  For MVS Dataset update, perform a whole new replacement of both libraries 
scynauth and the linklist. 

SETSSI  ADD,SUBNAME=CYN1

PARMLIB UPDATE:  Update the SYS1.PARMLIB(IEFSSNxx) used in your 
installation to include the statement:

   SUBSYS SUBNAME(CYN1)

RACF UPDATE:  Installations have a significant number of options they can choose 
to enable started tasks and authorize them with RACF. Usually a started task must 
have an RACF association with either a user or a group as well as an entry in the 
Started Class Table. This must be done in accordance with your installations 
specifications to permit functioning of the CYN1 subsystem and SNTP started task. A 
possible solution to this would be to issue the RACF commands:

RDEF STARTED (CYN1*) OWNER(STCRACF) STDATA(USER(STCRACF) TRACE(YES))

SETROPTS REFRESH RACLIST(STARTED)

The Userid associated with the started tasks must have RACF access to the MVS 
libraries installed in the subsequent steps.

PROCLIB UPDATE:  In previous steps you have created and populated 
CYN.SCYNPROC. Either concatenate this file to the JES2 procedure PROC00 
statement or copy the members from CYN.SCYNPROC into a dataset that is already 
part of the JES2/PROC00 DD statement.

Authorizing Data Sets and Updating the Linklist

Update SYS1.PARMLIB(LNKLSTxx) to include CYN.SCYNAUTH in the LNKLST 
concatenation or via the LNKLST statement in the appropriate PROGxx member of 
SYS1.PARMLIB.  Update SYS1.PARMLIB to define CYN.SCYNAUTH as an 
authorized library either via the IEAAPFxx or PROGxx members.

Note:  If you use the IEAAPFxx option, simply add a line that contains:

CYN.SCYNAUTH    volser

where volser is the volume name the library was installed on.

If you use PROGxx, simply add lines that contain

APF  ADD  DSNAME(CYN.SCYNAUTH)  VOLUME(volser)

LNKLST ADD NAME(LNKLST00) DSN(CYN.SCYNAUTH) VOLUME(volser)

where volser is the volume name the library was installed on.

Installing the IEFU83 Exit

Update SYS1.PARMLIB(SMFPRMxx) to enable the SMF exit IEFU83 and recording of 
SMF type 120 records. An example of an entry to enable an IEFU83 exit and recording 
of SMF type 120s is:

SYS(NOTYPE(14:19,62:69),EXITS(IEFU83,IEFU84,IEFACTRT,IEFUSI,IEFUJI,IEFU29),NOINTERVA
L,NODETAIL)

SUBSYS(STC,EXITS(IEFU29,IEFU83,IEFU84,IEFUJP,IEFUSO,IEFACTRT))
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If you currently do not have a SYS and/or SUBSYS statement you must include at a 
minimum:

SYS(TYPE(120),EXITS(IEFU83))

SUBSYS(STC,EXITS(IEFU83))

If your installation already has an IEFU83 exit, the MVS command SETPPROG may 
be used to create a “cascade effect” of calls to multiple yet distinct modules that will 
receive control, sequentially, to view/process the SMF records.

If your installation uses dynamic Exits, update SYS1.PARMLIB(PROGxx) with the 
following commands:

EXIT ADD EXITNAME(SYS.IEFU83) MODNAME(CYN1FU83) DSNAME(CYN.SCYNAUTH) FIRST 

EXIT ADD EXITNAME(SYSSTC.IEFU83) MODNAME(CYN1FU83) DSNAME(CYN.SCYNAUTH) FIRST

If your installation does not use dynamic Exits, update SYS1.PARMLIB(COMMNDxx) 
with the following commands:

SETPROG EXIT,ADD,EX=SYS.IEFU83,MOD=CYN1FU83,DSN=CYN.SCYNAUTH,FIRST

SETPROG EXIT,ADD,EX=SYSSTC.IEFU83,MOD=CYN1FU83,DSN=CYN.SCYNAUTH,FIRST

Initializing MVS

Depending upon the options you selected when installing the CYN1 subsystem, 
installing the IEFU83 exit, authorizing the cyn.scynauth library and adding 
cyn.scynauth to the active Linklist, an IPL may be required.

Customizing the CYN1 Subsystem for SMF Collection (Optional)

In order to collect SMF information for all the zWAS server instances on an LPAR, it 
may be necessary to customize parameters that control the building of in-core 
repository tables in CYN1PROC’s address space. These parameters indicate the 
maximum number of zWAS server instances, the sizes of the bean section, the bean 
method section, the web application section, and the servlet section pools. So, for 
example, if you’re running more zWAS server instances than the maximum allowed, 
then CYN1PROC’s maximum zWAS server instances allowed parameter must be 
changed, and the other CYN1PROC parameters may require tuning too. 

The CYN1 subsystem uses address space storage to store SMF information collected 
from the various WebSphere for z/OS application server instances running in the 
same LPAR.  SMF statistics comprise server and container data, bean data, bean 
method data, web application data, and servlet data.  These data are collected from 
SMF records 120 and reside in the CYN1 address space according to a hierarchical 
structure with the server instance as the top level.  Memory for such a structure is pre-
allocated by the CYN1 address space when it comes up according to a pre-defined 
parameter template, which specifies the maximum number of server instances, the 
sizes of the bean section, bean method section, web application section, and servlet 
section pools.

The parameter template is assembled and linked in the SCYNAUTH library and its 
name is of the form CYNPxxxx.  By default, CYN1 will load the CYNPTEST 
parameter template which is provided with the SCYNAUTH library.  CYNPTEST is 
specified as a default parameter in the CYN1 cataloged procedure (PARMS=), as 
follows:

//CYN1     PROC SMFWRITE='ON',PARMS='TEST' 

//STEP1    EXEC PGM=CYN1DRVR,REGION=0K,TIME=NOLIMIT,                   

//         PARM='&PARMS,&SMFWRITE'                                     
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//********************************************************************/

//*                                                                                                                                 */

//* PROPRIETARY-STATEMENT:                                                                           */

//* LICENSED MATERIAL - PROPERTY OF IBM                                               */

//*                                                                                                                                  */

//* 5655-L42 (C) COPYRIGHT CYANEA SYSTEMS CORP. 2002-2004              */

//* ALL RIGHTS RESERVED.                                                                                  */

//*                                                                                                                                 */

//*                                                                                                                                 */

//* WEBSPHERE STUDIO APPLICATION MONITOR                                      */

//* VERSION 3.1.0                                                                                                     */

//*                                                                                                                                 */

//* ----------------------------------------------------------------                                           */

//STEPLIB  DD DISP=SHR,DSN=CYN.SCYNAUTH                                

//SYSLOG   DD SYSOUT=*,FREE=CLOSE,SPIN=UNALLOC                         

//*SYSUDUMP DD SYSOUT=*,FREE=CLOSE,SPIN=UNALLOC                        

//*SYSABEND DD SYSOUT=*,FREE=CLOSE,SPIN=UNALLOC                        

//*SYSMDUMP DD SYSOUT=*,FREE=CLOSE,SPIN=UNALLOC                        

//*

Configuring the parameters statically:  The source code for a generic CYNPxxxx 
parameter template can be found in the CYNPXXXX member of the distribution 
library CYN.SCYNPROC, encapsulated by sample JCL to assemble and link it into the 
CYN.SCYNAUTH library.  You can customize the values in that member and rename 
it with any arbitrary suffix of at most 4 characters.  Then you can either edit the CYN1 
catalog procedure to reference that member as the default parameter template, or 
override the default when you start the CYN1 address space.  For example the JES 
command: 

“START CYN1PROC,PARMS=ABCD”  specifies that the CYN1 address space will 
load the member CYNPABCD from the library CYN.SCYNAUTH when coming up 
and it will use the values specified in that member to allocate its in memory SMF 
structures.

You can only modify the following lines in that member:

…

PEQUSENN EQU   10                 # OF SERVER ENTRIES 

…                  

PEQUBSNN EQU   PEQUSENN*2*10      NUMBER OF BEAN SECTION ENTRIES        

… 

PEQUBMNN EQU   PEQUBSNN*10        # OF BEAN METHOD ENTRIES           

…   

PEQUWSNN EQU   PEQUSENN*2*10      # OF WEBAPP SECTION ENTRIES    

…

PEQUSVNN EQU   PEQUWSNN*10        # OF SERVLET SECTION ENTRIES   

…
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Furthermore, only the number ’10’ can be changed; in the above example, the 10.  Do 
not change the 2.  For each server entry there are two sets of pools, a current pool 
containing the currently accumulated SMF statistics and an in-progress pool 
containing the latest SMF statistics.  The SMF statistics in the two pools are then 
aggregated into the currently accumulated SMF statistics.  Hence the factor of 2 which 
is specified in the PEQUBSNN and PEQUWSNN constants, and which should not be 
changed.

The constant PEQUSENN specifies the maximum number of server instances running 
in the LPAR for which CYN1 will keep SMF statistics for.  Once a server entry is 
allocated, it remains so until the CYN1 region is brought down.  Specify a number big 
enough to accommodate your needs, but keep in mind that the size of the bean 
section, bean method, web application, and servlet section pools will be multiplied by 
that number.

The constant PEQUBSNN specifies the average number of bean section entries per 
pool and per server instance.  Some server instances may have more, some other less.  
That number is the size of the common pool.  Specify the appropriate number here.

The constant PEQUBMNN specifies the average number of bean method entries per 
bean section.  Some beans may have more, some other less.  That number is the size of 
the common pool.  Again specify the appropriate number.

The constant PEQUWSNN specifies the average number of web application section 
entries per pool and per server instance.  Some server instances may have more, some 
other less.  That number is the size of the common pool.  Specify the appropriate 
number here.

The constant PEQUSVNN specifies the average number of servlet entries per web 
application section.  Some web applications may have more, some other less.  That 
number is the size of the common pool.  Again specify the appropriate number.

Keep in mind that because of the multiplication factors, the number that you specify 
at the higher levels (server, bean sections, web application sections) are propagated at 
the lower levels.  Be aware of that rather than specifying the biggest numbers just to 
be safe.  The parameter template may not assemble correctly if the size of the SMF 
structure is too big.

Configuring the parameters dynamically:  Another way to specify the size of the 
parameter values above is to override the PARMS parameter in the start command 
with those values explicitly.  The values are included between two slashes (“/”), 
separated with spaces or commas, and they must all be present.  For example, 
specifying:

 START CYN1PROC,PARMS=’/ 10,20,5,7,8/’

will cause CYN1PROC to dynamically compute its memory requirements with:

Number of server instances:10(PEQUSENN)

Average number of bean sections per server instance: 20(PEQUBSNN)

Average number of bean methods per bean section:  5(PEQUBMNN)

Average number of web applications per server instance:  7(PEQUWSNN)

Average number of servlets per web application:  8(PEQUSVNN)

All 5 values must be specified.  CYN1PROC will not create a parameter member.

For example:

START CYN1PROC

will start CYN1PROC using the default specification in the PARMS value of the 
cataloged procedure (either explicit values, or a parameter member, e.g.,CYNPTEST).

START CYN1PROC,PARMS=’PROD’
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will start CYN1PROC using the values defined in the parameter member CYNPPROD.

START CYN1PROC,PARMS=’/ 10, 30, 30, 10, 10/’

will start CYN1PROC using the specified values instead of the values specified in a 
parameter member.

Verifying the MVS Components

The following MVS commands may be used to help ensure the installation was 
successful.

To verify the definition of the CYN1FU83 exit, use the command:

D PROG,EXIT,MODNAME=CYN1FU83

This should produce messages similar to the following:

CSV462I 16.46.00 PROG,EXIT DISPLAY 978 

MODULE  CYN1FU83

EXIT(S) SYS.IEFU83       SYSSTC.IEFU83

To verify the installation of the SYSSTC.IEFU83 exit, use the command:

D PROG,EXIT,EX=SYSSTC.IEFU83,DIAG

This should produce messages similar to the following:

CSV464I 10.09.39 PROG,EXIT DISPLAY 136                 

EXIT SYSSTC.IEFU83                                     

MODULE    STATE EPADDR     LOADPT     LENGTH       JOBNAME  

CYN1FU83    A     8A0241A0  0A0241A0  000001E0    *   

     (verify the Loadpoint and Length are not zero)  

To verify the installation of the SYS.IEFU83 exit, use the command:

D PROG,EXIT,EX=SYS.IEFU83,DIAG

This should produce messages similar to the following:

CSV464I 10.12.26 PROG,EXIT DISPLAY 291                

EXIT SYS.IEFU83                                       

MODULE    STATE EPADDR     LOADPT    LENGTH      JOBNAME 

CYN1FU83    A     932FB5C8  132FB5C8  000001E0   *     

(verify the Loadpoint and Length are not zero)  
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To verify that CYN.SCYNAUTH is APF authorized, use the command:

D PROG,APF,DSNAME=CYN.SCYNAUTH

This should produce a message similar to the following:

CSV450I 17.04.49 PROG,APF DISPLAY 386

FORMAT=DYNAMIC                       

ENTRY    VOLUME     DSNAME                  

1               STCE03       CYN.SCYNAUTH

To verify that CYN.SCYNAUTH is in the active Linklist, use the command:

D PROG,LNKLST

This should produce a message similar to the following:

RESPONSE=STLABCE                     

CSV470I 14.28.30 LNKLST DISPLAY 539 

LNKLST SET LINK00   LNKAUTH=LNKLST  

ENTRY APF VOLUMEDSNAME          

1A IPL12BSYS1.LINKLIB    

2A RES20FCYN.SCYNAUTH     

3    ………

To verify that CYN1 Subsystem is defined, use the command:

D SSI,SUB=CYN1

This should produce a message similar to the following:

IEFJ100I  10.32.59  SSI DISPLAY 349                    

SUBSYS=CYN1                                            

DYNAMIC=YES     STATUS=INACTIVE     COMMANDS=REJECT

Verify the system is recording SMF type 120 records and the CYN1 subsystem is 
capturing data in conjunction with the IEFU83 exits. This test must be done after all 
previous tests and when the WebSphere changes (see the following section) have been 
implemented, the conversation activated and WebSphere is up and running. At that 
point, use the following commands:

S CYN1PROC

Wait for x minutes to execute the next command where x=SMF interval length. See 
Chapter 9, “Customization,” on page 75.
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F CYN1PROC,DUMP,AS,$CYNSETB,192 

This should produce output similar to the following:

CYNS0004I: DUMP,AS,$CYNSETB,192                                         

CYNS0013I:13803000  00000000    00000000   00000000     00000000   |                

CYNS0013I:13803010  00000000    00000000   00000000     00000000   |                

CYNS0013I:13803020  00000000    00000000   00000000     00000000   |                

CYNS0013I:13803030  00000000    00000000   00000000     00000000   |                

CYNS0013I:13803040  00000000    00000000   00000000     00000000   |                

CYNS0013I:13803050  00000000    00000000   00000000     00000000   |                

CYNS0013I:13803060  13803514    00000037   C1C4C3C4     D7D30000   | ADCDPL  

CYNS0013I:13803070  00000000    00000000   00000000     00000000    |                

CYNS0013I:13803080  00000000    00000000   00000000     00000000    |                

CYNS0013I:13803090  00000000    00000000   00000000     00000000    |                

CYNS0013I:138030A0  00000000    00000000    C2C2D6C1    E2D9F200   | BBOASR2 

CYNS0013I:138030B0  C2C2D6C1    E2D9F2C3   13803444     13803478   | BBOASR2C   

where:

ADCDPL
is your Sysplex

BBOASR2
is your J2EE Server

BBOASR2C
is your J2EE Server Instance

To look for version of the CYN1PROC, use the following command: 

F CYN1PROC,VER

CYNS0004I: VER 

CYNS0045I: CYN1 ID: CYN1DRVR 03.01.00 09/14/04 18.09

Installing USS Component

This involves the following tasks:

• “Pre-Allocating a Directory Structure on USS”

• “Transferring Files from the PC to USS” on page 55

• “Extract the Data Collector Files from a Tar File in USS Environment” on page 55

• “Copy Data Collector Files to the Installation Directory” on page 56

Pre-Allocating a Directory Structure on USS

1. Log onto the z/OS USS environment.

2. Change directory to /usr/lpp. 
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3. Check to see if a directory /usr/lpp/tmp exists. If one does not exist, create a 
directory with the commands: mkdir /usr/lpp/tmp. This is a tmp directory for 
untarring the packaging. 

4. Log off the z/OS USS environment.

Transferring Files from the PC to USS

FTP files from the PC C:\zos directory to the z/OS USS system.

1. Log onto PC environment and open a PC DOS Command window.   

2. At the PC DOS Command prompt, issue the commands”.

ftp ipname

(Where ipname is the IP address of the MVS system.)

When prompted for userid/password, provide the appropriate userid and 
password.

cd   /usr/lpp/tmp

Note:  Make sure the /usr/lpp/tmp directory exists at the z/OS USS System.

lcd  c:\zos

bin

put  <zDataCollector>.tar

Note:  <zDataCollector>.tar where <zDataCollector> can either be 
zWS502_DC_<version>1_USS or zWS510_DC_<version>1_USS.

quit

Log off from the PC environment.
1<version> is the Application Monitor version information, for example, 31 refers 
to the Application Monitor 3.1.

Extract the Data Collector Files from a Tar File in USS Environment

1. Telnet into the z/OS USS environment and logon.  Generally a Userid with root 
access will be required to update the /usr/lpp files.

2. Issue the commands:

cd /usr/lpp/tmp

tar –xvf <zDataCollector>.tar

cd cyanea

chmod –R 755 *

Note:   Depending upon the access level of the person performing this install and 
the authorization of the Userid associated with the WebSphere Server Instance the 
above command may need to be changed to “chmod –R 775 *” to permit dynamic 
updates of some of the files.  

chown –R CBASRU2 /usr/lpp/tmp/cyanea/wsam/cyanea_one

Note:   The chown command above indicates use of userid CBASRU2; this should be 
changed to the RACF userid associated with your servant region address space 
(look in SDSF).

Executing the tar command creates the following directory structure: 

/usr/lpp/tmp/cyanea/wsam/cyanea_one/lib

/usr/lpp/tmp/cyanea/wsam/cyanea_one/logs

/usr/lpp/tmp/cyanea/wsam/cyanea_one/etc
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Copy Data Collector Files to the  Installation Directory

The following convention is suggested for choosing the <installation directory> for 
the Data Collector:

• Choose a high level qualifier. For example, mkdir /usr/lpp/cyanea if it does not 
exist already.

• The subdirectory "wsam" is fixed, e.g., mkdir /usr/lpp/cyanea/wsam if it does 
not exist already. 

• It is recommended that the last subdirectory be the server/instance name that is 
created via the WebSphere Admin console for the Application Monitor. For 
example, mkdir /usr/lpp/cyanea/wsam/serverA if it does not exist already. 

Note:  For Data Collector upgrade, we recommend you archive or remove the old 
Data Collector files:

To archive the old Data Collector files, for example: 

mkdir /<high level qualifier>/wsam/<server>/backup

mv /<high level qualifier>/wsam/<server>/lib /<high level 
qualifier>/wsam/<server>/backup

mv /<high level qualifier>/wsam/<server>/etc /<high level 
qualifier>/wsam/<server>/backup

mv /<high level qualifier>/wsam/<server>/logs /<high level 
qualifier>/wsam/<server>/backup

To remove the old Data Collector files, for example: 

rm -rf /<high level qualifier>/wsam/<server>/lib 

rm -rf /<high level qualifier>/wsam/<server>/etc

rm -rf /<high level qualifier>/wsam/<server>/logs

• For Data Collector upgrade, remove the old files, for example:

rm -rf /<high level qualifier>/wsam/<server>/lib 

rm -rf /<high level qualifier>/wsam/<server>/etc 

rm -rf /<high level qualifier>/wsam/<server>/logs 

• Copy from/usr/lpp/tmp to installation directory. 

cp -R /usr/lpp/tmp/cyanea/wsam/cyanea_one/* /<high level 
qualifier>/wsam/<server>/

Note:  In this example, /<high level qualifier>/wsam/<server> refers to 
/usr/lpp/cyanea/wsam/serverA

Verifying Installation of the Data Collector

After installing the Data Collector on z/OS or OS/390, you should verify that the 
installed directories and files match those listed in this chapter. <installation 
directory> and <server> represent whatever directory name that you use.

Verifying WebSphere 5

The following table describes the location and permissions of directories and files 
included in the installation of Application Monitor Data Collector for WebSphere 5.

   
Table 6. Installed Directories and Files for WebSphere 5

System File Permissions

USS /<installation directory>/wsam rwxr-xr-x
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USS /<installation directory>/wsam/<server> rwxr-xr-x

USS /<installation directory>/wsam/<server>/etc                                                                 
/<installation directory>/wsam/<server>/etc/LogMessages                                  
/<installation directory>/wsam/<server>/etc/jndi.properties                                  
/<installation 
directory>/wsam/<server>/etc/datacollector.properties                 
/<installation directory>/wsam/<server>/etc/datacollector.env                           
/<installation 
directory>/wsam/<server>/etc/datacollectorservice.xml    
/<installation directory>/wsam/<server>/etc/request_jdbc.xml  
/<installation directory>/wsam/<server>/etc/request_ctg.xml 
/<installation 
directory>/wsam/<server>/etc/request_imsconnect.xml 
/<installation 
directory>/wsam/<server>/etc/request_jmsqueue.xml 
/<installation 
directory>/wsam/<server>/etc/request_jmstopic.xml 
/<installation directory>/wsam/<server>/etc/request_mqi.xml   
/<installation directory>/wsam/<server>/etc/bcm.properties            
/<installation directory>/wsam/<server>/etc/version.properties

rwxr-xr-x

USS For z/OS WebSphere 5.0.2                                                                             
/<installation directory>/wsam/<server>/lib                                        
/<installation directory>/wsam/<server>/lib/libcyanea.so       
/<installation directory>/wsam/<server>/lib/common.jar                              
/<installation directory>/wsam/<server>/lib/cdn.jar              
/<installation directory>/wsam/<server>/lib/cyaneaaux.jar                
/<installation directory>/wsam/<server>/lib/kernel.common.jar                              
/<installation directory>/wsam/<server>/lib/model.jar              
/<installation directory>/wsam/<server>/lib/ppe.probe-intf.jar 
/<installation directory>/wsam/<server>/lib/ppe.zprobe.jar   
/<installation directory>/wsam/<server>/lib/ppe.zws502.jar   
/<installation directory>/wsam/<server>/lib/ppe.zcdn_impl.jar                                                                                      
/ <installation directory>/wsam/<server>/lib/ext/

rwxr-xr-x

USS For z/OS WebSphere 5.1                                                                               
/<installation directory>/wsam/<server>/lib                                        
/<installation directory>/wsam/<server>/lib/libcyanea.so 
/<installation directory>/wsam/<server>/lib/libcyaneaDLL.so  
/<installation directory>/wsam/<server>/lib/common.jar                              
/<installation directory>/wsam/<server>/lib/cdn.jar              
/<installation directory>/wsam/<server>/lib/cyaneaaux.jar                      
/<installation directory>/wsam/<server>/lib/kernel.common.jar                              
/<installation directory>/wsam/<server>/lib/model.jar              
/<installation directory>/wsam/<server>/lib/ppe.probe-intf.jar 
/<installation directory>/wsam/<server>/lib/ppe.zprobe.jar   
/<installation directory>/wsam/<server>/lib/ppe.zws510.jar  
/<installation directory>/wsam/<server>/lib/ppe.zcdn_impl.jar                                                             
/ <installation directory>/wsam/<server>/lib/ext/

rwxr-xr-x

USS /<installation directory>/wsam/<server>/logs                rwxr-xr-x

Table 6. Installed Directories and Files for WebSphere 5

System File Permissions
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Configuring the Data Collector

The Data Collector must point to the Managing Server and the WebSphere Control 
Region.  This is done by setting parameters that identify the IP address of the 
Managing Server and the WebSphere Control Region. These changes must be 
implemented prior to starting the Data Collector.

From here on, we refer to the <installation directory> as the high level qualifier of 
your Data Collector directory path.<server> as the last subdirectory of your Data 
Collector directory path (i.e., this may be your server/instance name). <WebSphere 
directory> as your z/OS WebSphere directory path.

General

The following are general instructions for configuring the Data Collector.

MVS CYN.SCYNAUTH(CYN1$WTO)                             
CYN.SCYNAUTH(CYN1CALL)                               
CYN.SCYNAUTH(CYN1DRVR)                                
CYN.SCYNAUTH(CYN1DUMP)                               
CYN.SCYNAUTH(CYN1FU83)                                 
CYN.SCYNAUTH(CYN1KCRR)                               
CYN.SCYNAUTH(CYN1KCR8)                               
CYN.SCYNAUTH(CYN1KFOP)                            
CYN.SCYNAUTH(CYN1KGBM)                                   
CYN.SCYNAUTH(CYN1KGBS)                              
CYN.SCYNAUTH(CYN1KGHS)                               
CYN.SCYNAUTH(CYN1KGSS)                             
CYN.SCYNAUTH(CYN1KGSV)                             
CYN.SCYNAUTH(CYN1KGWS)                             
CYN.SCYNAUTH(CYN1KRSS)                                 
CYN.SCYNAUTH(CYN1KWEN)                            
CYN.SCYNAUTH(CYN1KWSC)                            
CYN.SCYNAUTH(CYN1KWSP)                           
CYN.SCYNAUTH(CYN1MSGS)                                
CYN.SCYNAUTH(CYN1OPER)                                
CYN.SCYNAUTH(CYN1SLOG)                                  
CYN.SCYNAUTH(CYN1TIME)                                  
CYN.SCYNAUTH(CYN1UTIL)                               
CYN.SCYNAUTH(CYN1WLM)                                                 
CYN.SCYNAUTH(CYN1XCOM)                           
CYN.SCYNAUTH(CYN1XINT)                                 
CYN.SCYNAUTH(CYN1XMPC)                               
CYN.SCYNAUTH(CYN1XOP)                                  
CYN.SCYNAUTH(CYN1XTRM)                                  
CYN.SCYNAUTH(CYN1XZAP)                            
CYN.SCYNAUTH(CYNMENGL)                                
CYN.SCYNAUTH(CYNMFRCH)                               
CYN.SCYNAUTH(CYNPTEST)                                    
CYN.SCYNAUTH(CYNPBIG)                      
CYN.SCYNAUTH(CYNPRAIF)

AC=00  
AC=00  
AC=01  
AC=00  
AC=00  
AC=00  
AC=00  
AC=00  
AC=00  
AC=00  
AC=00  
AC=00  
AC=00  
AC=00  
AC=00  
AC=00  
AC=00  
AC=00  
AC=00  
AC=00  
AC=00  
AC=00  
AC=01  
AC=00  
AC=00  
AC=00  
AC=00  
AC=00  
AC=00  
AC=00  
AC=00      
AC=00  
AC=00   
AC=00 
AC=00

MVS CYN.SCYNPROC(CYN1ELOG)                             
CYN.SCYNPROC(CYN1PROC)

AC=00 
AC=00

Table 6. Installed Directories and Files for WebSphere 5

System File Permissions
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To configure the Data Collector:

Once you have installed a Data Collector, you must configure it so that it 
communicates with the Managing Server. This is accomplished by setting the 
properties in the following two files: 

• /<installation directory>/wsam/<server>/etc/datacollector.properties

• /<installation directory>/wsam/<server>/etc/datacollector.env

1. Edit the file /<installation 
directory>/wsam/<server>/etc/datacollector.properties. For property 
references, see “Data Collector Property References” on page 68.

• Change all occurrences in this file (global change) of the default IP Address in 
kernel.codebase and kernel.rfs.address properties for example, 9.30.134.134 to 
the IP Address of your Managing Server. 

• Save your changes and close the file.

2. Edit the file: /<installation directory>/etc/datacollector.env. For property 
references, see “Data Collector Property References” on page 68.

• Change the default directory path in cyanea_modfile property: 

   

 

• Save your changes and close the file.

Once you have installed, configured, and brought up the Data Collector, the following 
system-generated files are created and used for subsequent startups in /<installation 
directory>/wsam/<server>/etc:

• <sysplex>.<machine name>.<LPAR name>.<server 

instance name>. datacollector.properties

• <sysplex>.<machine name>.<LPAR name>.<server 

instance name>.id

• <sysplex>.<machine name>.<LPAR name>.<server 

instance name>.gpsCounter.txt

• cyanea.mod

Therefore, if you need to change a value defined in datacollector.properties (such as 
Managing Server IP address), you must delete this system-generated 
datacollector.properties file, as described in the following instructions: 

To update the datacollector.properties file:

1. Update the datacollector.properties file with your changes.

2. Remove the following system-generated files which are located in the 
<installation directory>/wsam/<server>/etc directory: 

<sysplex>.<machine name>.<LPAR name>.<server instance 
name>.datacollector.properties

<sysplex>.<machine name>.<LPAR name>.<server 

instance name>.gpsCounter.txt

3. Restart the server. 

From To

/usr/lpp/cyanea/wsam/cyanea_one /<installation directory>/wsam/<server>/
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Configuring the Application Servers

The following instructions describe how to install the application servers on 
WebSphere 5 on z/OS. 

Configuring WebSphere 5 on z/OS

Configuring WebSphere 5 on z/OS involves the following tasks:

• “Configuring Probe Services”.

• “Configuring the z/OS Data Collector Home Runtime” on page 61.

• “Configuring Protocol Timeout Properties” on page 62

• “Configuring Administrative Services” on page 63.

• “Configuring the Servant Region Libpath” on page 63.

• “Supporting Global and Java Security” on page 65.

Updating WebSphere Proclib

The WebSphere Servant Region proclib must be updated to accommodate the 
Application Monitor Heap Analysis function. Else, the Heap Analysis function may 
cause WebSphere to abend.  Update the Servant Region procedure to include 
HEAP(,,,FREE). For Data Collector upgrade, simply comply with the following 
configuration. The updated version of the proclib looks like the following:

//BBO5ASR PROC ENV = ADCDPL.P390.SERVER1,Z=BBO5ASRZ

//  SET ROOT=’/WebSphere/V5ROM1’

//BBOSR  EXEC PGM=BBOSR,REGION=0M,TIME=NOLIMIT,

//PARM=’TRAP(ON,NOSPIE),HEAP(,,,FREE),ENVAR("_EDC_UMASK_DFLT=007")/"

//BBOENV DD PATH=’&ROOT/&ENV/was.env’

// INCLUDE MEMBER=&Z

Configuring Probe Services

You must configure probe services in WebSphere in order to use the Application 
Monitor. This defines the Data Collector custom services to run within the server.

1. Login to the WebSphere Administration Console.

2. Navigate as follows:

a. Select the Servers > Application Servers option and select the <ServerName>.

b. Navigate to the Additional Properties: Custom Services.

3. Select <New> for new creation or select ’-’ of the probe service for update.

4. In the configuration window enter or update the following (For Data Collector 
upgrade, delete the contents of the classpath and re-enter the new configuration.):

Startup: checked

 External Configuration URL: <blank>

Classname: com.cyanea.websphere.ProbeService

Display Name: Probe Service

Description: <blank>

Classpath: 
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/<installation directory>/wsam/<server>/lib/ppe.zprobe.jar:   

/<installation directory>/wsam/<server>/lib/ppe.zws502.jar:1               

/<installation directory>/wsam/<server>/lib/ppe.probe-intf.jar:      

/<installation directory>/wsam/<server>/lib/model.jar:             

/<installation directory>/wsam/<server>/lib/kernel.common.jar:    

/<installation directory>/wsam/<server>/lib/common.jar:        

/<installation directory>/wsam/<server>/lib/cyaneaaux.jar:     

/<installation directory>/wsam/<server>/lib/ppe.zcdn_impl.jar:     

/<installation directory>/wsam/<server>/lib/cdn.jar
1For z/OS WebSphere 5.1, use ppe.zws510.jar instead of ppe.zws502.jar.

5. Select <Apply>.

6. In the Messages dialog box, select ’Save’.

7. In the Save to Master Configuration dialog box, 

• If you are under ND environment, be sure the checkbox ‘Synchronize changes 
with Nodes’ is selected and then select <Save>.

• If you are NOT under ND environment, simply select  <Save>.

8. You may re-verify your configuration data in /<WebSphere 
directory>/<server>/server.xml by searching the keyword ’Probe Service’.

Note:  This file is ASCII encoded.  To view it, you need to either use an editor 
which support ASCII encoding (e.g. viascii) or export it to a computer (UNIX or 
Windows) which supports the ASCII character set by default. 

Configuring the z/OS Data Collector Home Runtime

You must configure Home Runtime in WebSphere in order to use the Application 
Monitor. This defines the Application Monitor start command. 

1. Login to the WebSphere Administration Console.

2. Select the Server > Application Servers option and select the <ServerName>. 

3. Navigate to the Additional Properties: Process Definition > Servant > Additional 
Properties: Java Virtual Machine. 

4. Add "-Xruncyanea" to the Generic JVM arguments if it exists.

5. Change Initial Heap Size to 256 and Maximum Heap Size to 256 or above. 

6. Select ’Apply’.

7. Navigate as follows:

a. In the Java Virtual Machine Panel, navigate to the Additional Properties: 
Custom Properties.

b. For new Data Collector installation: 

1) Select <New>. 

2) In the configuration panel, enter the following name/value pair. Select 
<OK> after each add operation:

   
Name Value

cyanea.home /<installation directory>/wsam/<server>

appserver.platform3 ws502
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c. For Data Collector upgrade: 

1) Update cyanea.home property to reference the current Application 
Monitor Data Collector server path. 

2) Select <New> to create the new properties if they don’t already exist. 

3) In the configuration panel, enter the following name/value pair. Select 
<OK> after each add operation:

   

 
1<libversion> is the Application Monitor version information, for example, lib3.1 
refers to lib directory of the Application Monitor 3.1.  
2For z/OS WebSphere 5.1, use ppe.zws51.jar instead of ppe.zws502.jar.
3For z/OS WebSphere 5.1, enter value as ’ws51’.
4Two single quotes are used to wrap the entire string. There is a space between 
every two ‘file’ URLs. Since there are 3 file URLs in the string, there are 2 spaces 
inside the single-quoted strings. If this string has incorrect syntax, the JVM will 
not be attached by WebSphere correctly and will result in a CEE DUMP.

8. In the Messages dialog box, select ’Save’. 

9. In the Save to Master Configuration dialog box, 

•  If you are under ND environment, be sure the checkbox ‘Synchronize 
changes with Nodes’ is selected and then select <Save>.

• If you are NOT under ND environment, simply select <Save>.

10. You may re-verify your configuration data in /<WebSphere 
directory>/<server>/servant.jvm.options by searching the property name (e.g., 
runcyanea, cyanea.home).

Configuring Protocol Timeout Properties

If you have a transaction that is hung or too slow, you need to do this to avoid an 
abend. This option is required only for new Data Collector installations. 

1. Login to the WebSphere Administration Console.

2. Navigate as follows:

a. Select the Server > Application Servers option and select the <ServerName>.

b. Navigate to the Additional Properties: Process Definition > Control > 
Additional Properties: Environment Entries.

c. Add the following properties, as name/value pairs.  Select <OK> after each 
add operation:

java.rmi.server.codebase4 ’file:///opt/cyaneaone/<libversion>1/ppe.zprobe.jar 
file:///opt/cyaneaone/lib/ppe.probe-intf.jar 
file:///opt/cyaneaone/<libversion>1/ppe.zws502.jar2’

Name Value

appserver.platform3 ws502

java.rmi.server.codebase4 ’file:///opt/cyaneaone/<libversion>1/ppe.zprobe.jar 
file:///opt/cyaneaone/lib/ppe.probe-intf.jar 
file:///opt/cyaneaone/<libversion>1/ppe.zws502.jar2’
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3. In the Messages dialog box, select ’Save’.

4. In the Save to Master Configuration dialog box, 

•  If you are under ND environment, be sure the checkbox ‘Synchronize 
changes with Nodes’ is selected and then select <Save>.

• If you are NOT under ND environment, simply select <Save>.

5. You may re-verify your configuration data in /<WebSphere 
directory>/<server>/was.env.

Configuring Administrative Services

If your WebSphere Configuration Services is not enabled, you must configure 
administrative services in WebSphere in order to use the Application Monitor Data 
Collector.  

1. Login to the WebSphere Administration Console.

2. Navigate as follows:

a. Select the Server > Application Servers option and select the <ServerName>.

b. Navigate to the Additional Properties: Administration Services 

c. Select ’Custom Properties’. 

3. Make sure the following property is set to "true", or create it if it does not yet exist: 

   

 

4. Select ’Apply’.

5. In the Messages dialog box, select ’Save’. 

6. In the Save to Master Configuration dialog box, 

•   If you are under ND environment, be sure the checkbox ‘Synchronize 
changes with Nodes’ is selected and then select <Save>.

• If you are NOT under ND environment, simply select <Save>.

Configuring the Servant Region Libpath

You must configure the servant region libpath in order to run the Application Monitor 
Data Collector. This adds the Data Collector libpath information to the LIBPATH 
property of WebSphere Servant Environment so that the Data Collector native library 
can be invoked at the server startup time. 

1. Login to the WebSphere Administration Console.

Name Suggested 
Minimum Value

protocol_http_timeout_input 3600

protocol_http_timeout_output 3600

protocol_http_timeout_output_recovery 3600

protocol_http_timeout_persistentSession 3600

Name Value

com.ibm.websphere.management.enableConfigMBean  true
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2. Navigate as follows:

a. Select the Servers > Application Servers option, select the  <ServerName>.

b. Navigate to Additional Properties: Process Definition > Servant > Additional 
Properties: Environment Entries.

c. Select New button for creating new entry LIBPATH or select the LIBPATH 
entry for an update.

d. Insert the following properties as name/value pair to the beginning (for Data 
Collector upgrade update the following LIBPATH value just to be compliant):

   

 

e. Select <Apply>.

Note:  A colon ’:’ must be used to separate two property values. 

3. In the Messages dialog box, select ’Save’.

4. In the Save to Master Configuration dialog box, 

•  If you are under ND environment, be sure the checkbox ‘Synchronize 
changes with Nodes’ is selected and then select <Save>.

• If you are NOT under ND environment, simply select <Save>.

5. You may confirm your changes in was.env and server.xml under /<WebSphere 
directory>/servers/<ServerName> directory via key word 
‘server_region_libpath’ and ‘LIBPATH’, respectively. 

Note:  The server.xml is ASCII encoded.  To view it, you need to either use an 
editor which support ASCII encoding (e.g. viascii) or export it to a computer 
(UNIX or Windows) which supports the ASCII character set by default. 

6. If you are upgrading z/OS Data Collector from release 2.1.4 or earlier, you may 
already have an existing server with the old configuration. If so, we recommend 
removing the old configuration. 

a. Go to the mainframe USS window.

b. Go to the WebSphere Server directory. For example, 
/WebSphere/.../servers/<ServerName>.

c. Open the file "variables.xml" and remove the following values under variable 
’WAS_SERVER_ONLY_server_region_libpath’ if they exist: 

/<installation directory>/wsam/<server>/lib

/usr/lpp/cicsts/gateway/ctg/deployable

d. If you are under ND (Network Deployment) environment, go to the 
<WebSphere Deployment Manager Directory>/.../servers/<ServerName>. 
For example, 

cd 
/WebSphere/V5R1M0/DeploymentManager/config/cells/ADCDPLNetwork/nodes/nodeA/s
ervers/server1

e. Perform the same operation as step 3 above (delete the 
’WAS_SERVER_ONLY_server_region_libpath’ property from ’variable.xml’).

Name Value

LIBPATH <installation directory>/wsam/<server>/lib
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Supporting Global and Java Security

• Whether Global security is enabled or not, no change is required by the 
Application Monitor Data Collector in 
/<WebSphere>/AppServer/properties/server.policy. 

•  If Java 2 security is enabled, the following properties are required by the 
Application Monitor Data Collector to be added to 
/<WebSphere>/AppServer/properties/server.policy.

// Added the following for the Application Monitor Data Collector                                    
grant codeBase "file:/<installation directory>/wsam/-" {

 permission java.security.AllPermission;

};

grant codeBase "file:/<db2 install path>/db2710/classes/-" {

permission java.security.AllPermission;

};

For example, add the following for the Application Monitor Data Collector 

grant codeBase "file:/usr/lpp/cyanea/wsam/-" {

 permission java.security.AllPermission;

}; 

grant codeBase "file:/usr/lpp/db2/db2710/classes/-" {

permission java.security.AllPermission;

};

• If Java 2 security is disabled, the following properties, if they exist, can be 
removed from the  /<WebSphere>/AppServer/properties/server.policy.

grant codeBase "file:/<installation directory>/wsam/-" {

 permission java.security.AllPermission;

};

grant codeBase "file:/<db2 install path>/db2710/classes/-" {

permission java.security.AllPermission;

};

Note:  Although the install is complete, you need to continue with customization 
in Chapter 9. 

Starting the Data Collector (Quick Start Guide)

Here is a quick start guide for the Data Collector. We recommend you review the 
Custom options in Chapter 9, “Customization,” on page 75 and continue the Data 
Collector installation process if the options apply to you. In addition, it is strongly 
recommended that you read the Operator’s Guide and the User’s Guide for more 
detailed information on using this product.

Note:  Suggest verifying the application server without the Application Monitor 
configuration is functional before continuing the following instructions. 

Start the Managing Server (see “Starting the Application Monitor” on page 24 in 
Chapter 5, “Troubleshooting,” on page 31.)

1. Start the CYN1PROC procedure.

2. Start WebSphere with the Application Monitor Data Collector configuration.

3. Using TSO and SDSF (or another suitable program), 
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• Check the WebSphere JESMSGLG job log for the configured Server Region. 
You are looking for the “open for e-business” message that indicates the 
Server Instance has completed initialization.

• Check the WebSphere SYSPRINT job log for the configured Server Region. 
You are looking for the following messages: 

CYNK0001I <PPECONTROLLER,  …  Successfully joined Kernel <IP-of-managing-server>

CYNK0002I <PPEPROBE,  …  Successfully joined Kernel <IP-of-managing-server>

+Server "<your-server-name>" open for business

The CYNK0001I message indicates the Data Collector has successfully connected 
to the Managing Server.

The CYNK0002I message indicates the Data Collector has been configured by the 
Managing Server.

Configuring Distinct WebSphere Application Server Instances

You may have multiple distinct server instances under a common Control Region.  In 
this case, you may want to monitor all server instances concurrently. To monitor two 
or more distinct WebSphere instances, you will need to create an additional USS 
directory structure for each WebSphere instance.

General

The following are general instructions for configuring a distinct WebSphere 
application server instance. 

Setting up the Data Collector Directories 

Duplicate the /<installation directory>/wsam/<server> structure for each additional 
distinct server instance. Follow and repeat the instructions below increasing the 
directory name structure for each duplicate (i.e. create <server2> for the second 
distinct server instance, <server3> for the third and so on).

Log onto the z/OS uss environment, create a copy of the /<installation 
directory>/wsam/<server> directory structure and files with the following 
commands:

cd  /<installation directory>/

mkdir wsam/<server2>

To use share library files approach: 

• Duplicate the Application Monitor Data Collector configuration file structures 
(e.g., <etc directory>).  

cp –pR /<installation directory>/wsam/<server>/etc  /<installation 
directory>/wsam/<server2>

• Make <logs> directory for <server2>.

mkdir /<installation directory>/wsam/<server2>/logs

• Make a <shared> directory for other Application server instances to share the 
same version of libraries.

mkdir /<installation directory>/wsam/shared

• Copy the Data Collector libraries from the 1st server instance library directory to 
the <shared> directory.
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cp -R/<installation directory>/wsam/<server>/lib/* /<installation 
directory>/wsam/shared

• Change the file permission for the <shared> directory and files beneath it.

chmod -R 755 /<installation directory>/wsam/shared

• Reference the other server instance <lib> directory to the <shared> directory

cd /<installation directory>/wsam/<server2>/

ln -s /<installation directory>/wsam/shared lib

Note:  This approach can be used if the distinct application server instances are of the 
same version.  For example, you can not use this shared libraries approach for 
different versions (2.1.4 and 3.1) of the Application Monitor Data Collector . 

To use the copied library files approach: 

• Simply copy ALL the Application Monitor Data Collector files structures.

cp –pR /<installation directory>/wsam/<server>/* /<installation 
directory>/wsam/<server2>

• Remove the log files that were created by the originating server instance.

rm /<installation directory>/wsam/<server2>/logs/*                        

• Change files/directories permission.

cd /<installation directory>/wsam/<server2>

chmod -R 777 etc

chmod -R 777 logs

chmod -R 755 lib

z/OS WebSphere 5

Update Data Collector Control Files

You will need to update the files containing specific pointers to the /<installation 
directory>/wsam/<server> directory and any of its subdirectories. 

Edit the following file and replace all occurrences of the “old string” with the “new 
string”.

   

 

Follow and repeat the instructions, increase the directory name structure created in 
the step above (i.e. update <server2> for the second server instance, <server3> for the 
third and so on).

FILE
OLD 
STRING

NEW 
STRING

/<installation 
directory>/wsam/<server2>/etc/datacollector.env

<server> <server2>
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Cloning a WebSphere Server with the Application Monitor Data 
Collector Configuration 

The cloning mechanism is a quick way to create another WebSphere Server. If the 
WebSphere Server that was cloned from consists of the Application Monitor Data 
Collector configuration, all of the Data Collector configurations will be propagated to 
the new cloned  WebSphere Server. However, you need to tailor the new server to be 
in compliance with your own Application Monitor Data Collector configuration in 
order to work well (e.g., the classpath, libpath, jdbc provider, etc.).

Note:  Recommend to review and perform (only if you choose to) the optional 
support configuration on the Application Monitor server before cloning it. This will 
allow the optional support configuration to be cloned as well. See Chapter 9, 
“Customization,” on page 75. 

To clone a server in WebSphere 5:

1. Login to the WebSphere Administration Console.

2. Navigate to the Server > Application Servers option and select the server ’New’:

3. Enter the server name.

4. In "select template," select the "Existing application server" button and the server 
you want to clone.

5. Click ’Next’.

6. Click ’Finish’.

Follow the instructions from the following references to replace <server> with 
<server2>:

• “Configuring Probe Services” on page 60.

• “Configuring the z/OS Data Collector Home Runtime” on page 61.

• “Configuring the Servant Region Libpath” on page 63.

• Chapter 9, “Customization,” on page 75.

Data Collector Property References

z/OS WebSphere 5

The following examples show the default datacollector.properties and 
datacollector.env file settings. 

datacollector.properties (for z/OS WebSphere 5)

   
DEFAULT datacollector.properties

kernel.codebase1=http://9.30.134.134:9122/kernel.core.jar   
http://9.30.134.134:9123/kernel.core.jar                                       
kernel.rfs.address1=9.30.134.134:9120   9.30.134.134:9121                                          
probe.rmi.port=8200-8299                                                                                    
probe.controller.rmi.port=8300-8399                                                                     
cyanea.usecustomrmi=true                                                                         
cyanea.rmisocket.timeout=360000                                                                          
appmonitor.url.limit=1000                                                                                         
appmonitor.sql.limit=5000
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1The property value should be entered as one continuous line in the 
datacollector.properties file.

appmonitor.sql.limit

This property specifies the maximum length for the SQL strings.  The default 
value is 5000 characters. If the SQL strings exceed this defined length, the data 
collector will truncate it and thus only the SQL string up to the defined length 
will be displayed in the Managing Server VE.

Value

Length, in integer.

Example

appmonitor.sql.limit=5000

appmonitor.url.limit

This property specifies the maximum length for the URL strings. The URL 
strings may consist of requestName, applicationName, and URL. The default 
value is 1000 characters. If the URL strings exceed this defined length, the 
data collector will truncate it and thus only the URL string up to the defined 
length will be displayed in the Managing Server VE.

Value

Length, in integer.

Example

appmonitor.url.limit=1000

cyanea.installedapps.dir

For a Network Deployment environment, this property is optional and is 
used by the Software Consistency Check function. This allows you to specify 
additional application directories for comparison purpose should they do not 
reside in the directories of standard cell/naming convention.

Value

Sub-strings of directoryy names where application code resides.

Example

cyanea.installedapps.dir=/WebSphere/V5R0M1/AppServer/installedApps/cellA:/We
bSphere/V5R0M1/AppServer/installedApps/cellB:/WebSphere/V5R0M1/AppServer/ins
talledApps/cellC 

cyanea.jmx.host

To be used when localhost is not resolved correctly in a non-ND environment. 
In order for the Application Monitor data collector to work, localhost should 
be resolved to the host name of the TCP/IP stack that WebSphere binds to.

Note:  When this property is needed, recommend to specify as an IP address 
to eliminate further resolution.

Value

IP Address

Example

cyanea.jmx.host=9.30.134.134
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cyanea.rmisocket.timeout

If the cyanea.usecustomrmi property is set to true, this property specifies the 
duration of the timeout used for rmi calls.

Value

A duration, in  milliseconds.

Example

cyanea.rmisocket.timeout=360000

cyanea.usecustomrmi

Enables use of custom RMI socket factories that enforce timeout, which 
prevents hanging the Kernel.  Set to false to use standard RMI.

Value

true or false

Example

cyanea.usecustomrmi=true

gpsCushion

Specifies how frequently the counter, which is used to create unique tokens 
used to correlate Composite Requests, is written to a file.  The default value is 
200.  Increase this value if there is too much I/O as a result of monitoring 
systems that process many Composite Requests. 

Value

an integer

Example

gpsCushion=200

java.rmi.server.codebase

This parameter provides the locations of Data Collector code/library which 
can be downloaded from the Kernel. 

Note:  The java.rmi.server.codebase property is optional in 
datacollector.properties, if it has already been defined in the Process 
Definition of the Servant process. However, if it has not been able to define 
this property in the Process Definition of the Servant process for whatever 
reason, you *MUST* specify this property in the datacollector.properties.

Value

z/OS WebSphere 5.0.2:

file:///opt/cyaneaone/<libversion>1/ppe.zprobe.jar   
file:///opt/cyaneaone/<libversion>1/ppe.probe-intf.jar  
file:///opt/cyaneaone/<libversion>1/ppe.zws502.jar   

z/OS WebSphere 5.1:

file:///opt/cyaneaone/<libversion>1/ppe.zprobe.jar   
file:///opt/cyaneaone/<libversion>1/ppe.probe-intf.jar  
file:///opt/cyaneaone/<libversion>1/ppe.zws510.jar   
1<libversion> is the Application Monitor version information, for example, 
lib3.1 refers to libs of the Application Monitor 3.1.

Example

z/OS WebSphere 5.0.2:
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java.rmi.server.codebase=file:///opt/cyaneaone/lib3.1/ppe.zprobe.jar 
file:///opt/cyaneaone/lib/ppe.probe-intf.jar          
file:///opt/cyaneaone/lib3.1/ppe.zws502.jar   

z/OS WebSphere 5.1:

java.rmi.server.codebase=file:///opt/cyaneaone/lib3.1/ppe.zprobe.jar 
file:///opt/cyaneaone/lib/ppe.probe-intf.jar          
file:///opt/cyaneaone/lib3.1/ppe.zws510.jar   

kernel.codebase

This parameter provides the locations of the code/library which can be 
downloaded from the Kernel of the Application Monitor.

Value

There are always two copies of the Kernel running. The hostname (or IP 
address) of the Kernel and the port number of its HTTP server must be 
provided. The two values are separated by a space.

http://hostname:port number/kernel.core.jar   http://hostname:port 
number/kernel.core.jar

Example 

Assuming both copies of the Kernel run on the same IP:

kernel.codebase=http://204.146.177.123:9122/kernel.core.jar 
http://204.146.177.123:9123/kernel.core.jar

kernel.rfs.address

This parameter provides the locations where the stub code can be 
downloaded from the Kernel of the Application Monitor. 

Value

There are always two copies of the Kernel running. The hostname (or IP 
address) of the Kernel and the port number of its RFS (Request for Stub) 
server must be provided. The two values are separated by a space.

hostname:port number hostname:port number

Example

Assuming both copies of the Kernel run on the same IP:

kernel.rfs.address=204.146.177.123:9120 204.146.177.123:9121

probe.controller.rmi.port

This parameter specifies a range of port numbers available for the controller 
of the data collector to communicate to the Visualization Engine. The range 
should be at least equal to the number of possible server regions that can be 
started on a single z/OS or OS/390 image and preferably not overlap with 
that of probe.rmi.port. 

Value

nnnn-nnnn

Example

probe.controller.rmi.port=8300-8399

probe.rmi.port

This parameter specifies a range of port numbers available for the Command 
Agent of the Data Collector to communicate with the Visualization Engine of 
the Application Monitor. The range should be at least equal to the number of 
possible server regions that can be started on a single z/OS or OS/390 image.

Value
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nnnn-nnnn

Example

probe.rmi.port=8200-8299

probe.send.thread.dump

The value 'yes' means that Thread Dumps are sent back to the Application 
Monitor when one is requested.  The default value is 'yes.'

The value 'no' means that the dump is stored locally, and instead of sending 
the dump contents, the Data Collector sends the fully-qualified path of the file 
where the dump is stored.

Value

yes or no.

Example

probe.send.thread.dump=yes

datacollector.env

   

 

1The property value above should be entered as one continuous line in the 
datacollector.properties file.

cyanea_modfile

This parameter points to a file that contains information on the monitoring 
level of the Application Monitor.

Value

<installation directory>/wsam/<server>/etc/cyanea.mod

Example

cyanea_modfile=/usr/lpp/cyanea/wsam/serverA/etc/cyanea.mod

classes_not_to_trace

This environment variable specifies a list of classes which are not to be 
method traced.  The environment variable only applies:

• if wsam_intent_trace=yes, method tracing will take place at level 3 
regardless of the initial monitoring level.

• if wsam_intent_trace=no, method tracing will take place only if the initial 
monitoring level is 3.

Note:  classes_not_to_trace is not related to the “Exclude(classname)” in the 
Data Collector configuration in the Visualization Engine. 

Value

DEFAULT datacollector.env

cyanea_modfile=/usr/lpp/cyanea/wsam/cyanea_one/etc/cyanea.mod        
wsam_intent_trace=yes 
classes_not_to_trace1=java/*;javax/*;sun/*;oracle/*;org/apache/*;org/omg/*;org/w3c/*;or
g/xml/*;com/ibm/*;com/cyanea/*;com/sun/*;COM/rsa/*;utils/version/*;com/adobe/*                                                                                               
classes_to_trace1=
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A class list consists of class specifiers and uses “;” as separators between the 
class specifiers. A class specifier consists of the package name plus its class 
name and allows use of * as wildcard to describe matching packages or 
classes.

Example

classes_not_to_trace=java/*;javax/*;sun/*;oracle/*;org/apache/*;org/omg/*;or
g/w3c/*;org/xml/*;com/cyanea/*;com/sun/*;COM/rsa/*;com/ibm/*;utils/version/*
;com/adobe/*

classes_to_trace

This parameter specifies an additional list of classes to be method traced.  
These classes are in addition to those in the user’s application set.  This 
variable only applies:

• if wsam_intent_trace=yes, method tracing will take place at level 3 
regardless of the initial monitoring level.

• if wsam_intent_trace=no, method tracing will take place only if the initial 
monitoring level is 3.

Note:  classes_to_trace is not related to the “Exclude Overwrite(classname)” 
in the Data Collector configuration of Managing Server Visualization Engine.

Value

A class list consists of class specifiers and uses “;” as separators between the 
class specifiers. A class specifier consists of the package name plus its class 
name and allows use of * as wildcard to describe matching packages or 
classes.

Example

classes_to_trace=trade/*;simplejspservlet/*

wsam_intent_trace

This parameter when set to yes will facilitate dynamic changing of the 
monitoring level from level 1 to level 3. See more information on this 
parameter and its impact in the WebSphere Studio Application Monitoring 
User’s Guide. The default value is yes. 

Value

<yes> or <no>

Example

wsam_intent_trace=yes
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Chapter 9. Customization

Optional z/OS WebSphere 5 Support

Optional support includes capturing and reporting data such as, PMI, J2EE APIs 
(JDBC, JNDI/JMS, MQI), CICS L2 Trace and SMF. If you are not sure whether you 
need to configure these options, consult with your WebSphere Admin and/or the 
Application Support person who knows about the applications that will be used with  
the Application Monitor product.

PMI = Performance Monitoring Services 

JDBC = Java Database Connectivity

JNDI = Java and Naming Directory Interface

JMS = Java Message Service

Adding SMF Support

You must add SMF support if you want SMF data in the Application Monitor.  This 
step is required for new Data Collector installations or for first time using SMF feature 
from a Data Collector upgrade. 

1. Login to the WebSphere Administration Console.

2. Navigate as follows:

a. Select the Server > Application Servers option and select the <ServerName>.

b. Navigate to the Additional Properties: Process Definition > Control > 
Additional Properties: Environment Entries.

c. Add the following properties, as name/value pairs.  Select <OK> after each 
add operation:

   

 

3. In the Messages dialog box, select ’Save’.

4. In the Save to Master Configuration dialog box, 

• If you are under ND environment, be sure the checkbox ‘Synchronize changes 
with Nodes’ is selected and then select <Save>.

• If you are NOT under ND environment, simply select <Save>.

5. You may re-verify your configuration data in /<WebSphere 
directory>/<server>/was.env.

Name Suggested Value

server_SMF_container_interval_enabled 1

server_SMF_interval_length1 120

server_SMF_server_interval_enabled 1

server_SMF_web_container_interval_enabled 1
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1The server_SMF_interval_length property is the time interval length (in seconds) for 
getting SMF data. For example, if value=120, SMF data will be retrieved every 120 
seconds. 

Adding PMI Support

1. Login to the WebSphere Administration Console.

2. Select the Server > Application Servers option and select the <ServerName>. 

3. Navigate to the Additional Properties: Performance Monitoring Service.

4. For the new installation: 

a. Select the options ’startup’.

b. To fully utilize the Application Monitor features, we recommend the ’custom’ 
options. 

c. Select the ’custom’ checkbox with the following configuration:

• beanModule=X

• cacheModule=H

• connectionPoolModule=X

• j2cModule=H

• jvmRuntimeModule=H

• orbPerfModule=H

• servletSessionsModule=H

• systemModule=H

• threadPoolModule=H

• transactionModule=H

• webAppModule=H

• webServicesModule=H

• wlmModule=H

• wsgwModule=H

d. Select ’Apply’.

e. In the messages Dialog box, select ’Save’.

f. In the Save to Master Configuration dialog box, 

•  If you are under ND environment, be sure the checkbox ‘Synchronize 
changes with Nodes’ is selected and then select <Save>.

• If you are NOT under ND environment, simply select <Save>.

5. For Data Collector upgrade, simply verify: 

a. The ’startup’ checkbox is checked.

b. All PMI modules are compliant with what are listed under new installation 
section. 

 

Adding JDBC Support

You must configure WSAM JDBC provider in WebSphere in order to monitor SQL 
and EJB/Entity Bean with DB2 requests. This involves defining a JDBC provider and 
data source.
 76 Application Monitor:Installation and Customization Guide  



Enabling the JDBC support configuration:  

1. Login to the mainframe USS system.

2. update the property 'jdbc.enable' to 'yes' value in /<installation 
directory>/wsam/<server>/etc/bcm.properties file.  For example: 

jdbc.enable=yes

3. Save the updated bcm.properties file. 

Configuring JDBC driver  path in Probe Services:

1. Login to z/OS WebSphere Admin console.

2. Select the Servers > Application Servers option and select the <ServerName>.  

3. Navigate to the Additional Properties: Custom Services.

4. Select '-' of the probe service for an update.

5. Insert the following class path exactly as written to the beginning of the classpath 
field: 

${DB2390_JDBC_DRIVER_PATH}/classes/db2j2classes.zip

Note:  The ':' is required to separate between 2 classpath values. 

6. Click <Apply>.

7. In the messages dialog box, select ’Save’.

8. In the Save to Master Configuration dialog box, 

•   If you are under ND environment, be sure the checkbox ‘Synchronize 
changes with Nodes’ is selected and then select <Save>.

• If you are NOT under ND environment, simply select <Save>.

9. You may re-verify your configuration data in /<WebSphere 
directory>/<server>/server.xml via a search of word ’j2cIntf’. 

Note:  This file is ASCII encoded.  To view it, you need to either use an editor 
which support ASCII encoding (e.g. viascii) or export it to a computer (UNIX or 
Windows) which supports the ASCII character set by default. 

10. Need to ensure the existence of db2j2classes.zip file under 
${DB390_JDBC_DRIVER_PATH} directory path.  To do so, navigate as follows: 

a. In the z/OS WebSphere Admin Console, select the Environment > Manage 
WebSphere Variables.

b.  Select the node with server option as blank and click <Apply> button.

c. Look for ${DB390_JDBC_DRIVER_PATH} and its real value (e.g., 
/usr/lpp/db2/db2710).

d. Then, go to the mainframe USS system and look for the existing of 
db2j2classes.zip file under the directory 
${DB390_JDBC_DRIVER_PATH}/classes.  For example,  

cd /usr/lpp/db2/db2710/classes

ls -l db2j2classes.zip

e. If you don't see it, you need to locate these db2j2classes.zip file (via your 
WebSphere or DB2 administrator(s)) and update the variable 
${DB390_JDBC_DRIVER_PATH} to reference the correct directory path.

Defining the JDBC provider

This configuration is to support DB2 JDBC Driver. 

1. Login to the WebSphere Administration Console.

2. Select the Resources > JDBC Providers. 
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3. Select the <NodeName>.

4.  Select the <ServerName> and click <Apply>.

5. For new Data Collector installation: 

a. Click <New>.

b. On the configuration tab, select JDBC Providers and set it to "DB2 for zOS  
JDBC Providers (RRS)".

c. Select ’Apply’

d. Change the Name field to a uniquely identified name. For example:

<server> DB2 zOS Local JDBC Provider (RRS)

e. Select <Apply>.

f. In Additional Properties table, select ’DataSources (Version 4)’ or 
’DataSources’ option.

Note:  "DataSource (Version 4)" is for WebSphere V4. "DataSource" is for 
WebSphere V5. You may select either or both; this should be determined by 
the applications you run on this server and the datasource level they use. If 
you are not sure about the data source configuration, contact your 
Application Support person. 

g. Click <New>.

h. Fill in the appropriate fields that define your DataSource, which is 
installation-specific.  The following are examples:

For the "DataSources (Version 4)":

Name: DataSourceSample

JNDI Name: jdbc/DataSourceSample

Database Name:YOUR_DB_LOCATION_NAME (for example, S390LOC)

Default User ID: ccc (Your database User ID.)

Default User Password: *** (Your database user password.) 

For the "DataSource":

Name: DataSourceSampleV5

JNDI Name: jdbc/DataSourceSampleV5

DataSource Helper Classname: 
com.ibm.websphere.rsadapter.DB2390LocalDataStoreHelper

i. Select the appropriate database in the Component-managed Authentication 
Alias for database authentication in runtime for resource authentication 
setting to Application.

j. Select the appropriate database in the Container-managed Authentication 
Alias for database authentication in runtime for resource authentication 
setting to Container. 

k. Select 'DefaultPrincipalMapping' option in Mapping-Configuration Alias 
field.

l. Select <Apply>.

m. Navigate to Additional Property: Custom Properties and add the name value 
pair.  

Name: databaseName

Value: YOUR_DB_LOCATION_NAME (for example, S390LOC)

n. Click <Apply>.
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6. For Data Collector upgrade, we recommend that you

a. Backup the datasource information from your existing Application Monitor 
JDBC provider

b. Delete the old/existing Application Monitor JDBC Provider

c. Follow the instructions from the new Data Collector installation to create a 
new JDBC provider.

7. (Optional) You may choose to allocate more Database Connection Pool by 
increasing the pool size under Additional Properties > Connection Pools link, and 
click <Apply> to save your changes. 

8. In the messages dialog box, select ’Save’.

9. In the Save to Master Configuration dialog box, 

•   If you are under ND environment, be sure the checkbox ‘Synchronize 
changes with Nodes’ is selected and then select <Save>.

• If you are NOT under ND environment, simply select <Save>.

10. You may re-verify your configuration data in /<WebSphere 
directory>/<server>/resources.xml via a search of db2 provider name, for 
example, <server> DB2 zOS Local JDBC Provider (RRS). 

Note:  This file is ASCII encoded.  To view it, you need to either use an editor 
which support ASCII encoding (e.g. viascii) or export it to a computer (UNIX or 
Windows) which supports the ASCII character set by default. 

Defining the Universal JDBC Provider

This configuration is to support Universal JDBC Driver. 

1. Login to Admin console. 

2. Navigate to Resources > JDBC Provider.

3. Select the <NodeName>.   

4. Then select the <ServerName> and click <Apply>.

5. Click the <New> button for a new creation or select the Universal JDBC Provider 
name for an update.

6. For new Data Collector installation: 

a. Click <New>.

b. On the configuration tab, select Universal JDBC Providers and set it to  'DB2 
Universal JDBC Driver Provider' .

c. Select ’Apply’

d. Change the Name field to a uniquely identified name. For example:

<server> DB2 zOS Local JDBC Provider (RRS)

e. Select <Apply>.

f. In Additional Properties table, select ’DataSources (Version 4)’ or 
’DataSources’ option.

Note:  "DataSource (Version 4)" is for WebSphere V4. "DataSource" is for 
WebSphere V5. You may select either or both; this should be determined by 
the applications you run on this server and the datasource level they use. If 
you are not sure about the data source configuration, contact your 
Application Support person. 

g. Click <New>.

h. Fill in the appropriate fields that define your DataSource, which is 
installation-specific.  The following are examples:
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For the "DataSources (Version 4)":

Name: DataSourceSample

JNDI Name: jdbc/DataSourceSample

Database Name:YOUR_DB_LOCATION_NAME (for example, S390LOC)

Default User ID: ccc (Your database User ID.)

Default User Password: *** (Your database user password.) 

For the "DataSource":

Name: DataSourceSampleV5

JNDI Name: jdbc/DataSourceSampleV5

i. If your datasource will be used for CMP EJB (container managed persistence), 
mark the checkbox for the Container managed persistence field.

j. Select the appropriate database in the Component-managed Authentication 
Alias for database authentication in runtime for resource authentication 
setting to Application.

k. Select the appropriate database in the Container-managed Authentication 
Alias for database authentication in runtime for resource authentication 
setting to Container. 

l. Select 'DefaultPrincipalMapping' option in Mapping-Configuration Alias 
field.

m. Select <Apply>.

n. Navigate to Additional Property: Custom Properties and add the name value 
pair.  

Name: databaseName

Value: YOUR_DB_LOCATION_NAME (for example, S390LOC)

o. Click <Apply>.

7. For Data Collector upgrade, we recommend that you

a. Backup the datasource information from your existing Application Monitor 
Universal JDBC provider

b. Delete the old/existing Application Monitor Universal JDBC Provider

c. Follow the instructions from the new Data Collector installation to create a 
new Universal JDBC provider.

Adding JNDI Support

To enable JNDI event capture: (If you are not sure of this option, contact your 
Application Support person.)

1.  The default initial context factory property is provided in the file located at 
/<installation directory>/wsam/<server>/etc/jndi.properties. We recommend 
not to delete this initial property. However, users may update jndi.properties with 
additional context class factory as an option.

2. Login to the WebSphere Admin Console. 

3. Navigate to Servers > Application Servers option, select the <ServerName>.

4. In the Process Definition > Servant > Additional Properties:Java Virtual Machine 
link. 

5. Insert the following value to the beginning of the Classpath field if it doesn’t 
already exist.
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/<installation directory>/wsam/<server>/etc

6. Select <Apply>.

7. In the messages Dialog box, select ’Save’.

8. In the Save to Master Configuration dialog box, 

•   If you are under ND environment, be sure the checkbox ‘Synchronize 
changes with Nodes’ is selected and then select <Save>.

• If you are NOT under ND environment, simply select <Save>.

9. You may re-verify your configuration data in /<WebSphere 
directory>/<server>/was.env by searching the keyword 
server_region_classpath.

Adding JMS Support

To enable JMS event capture: (If you are not sure of this option, contact your 
Application Support person.)

1. Enable the JMS support configuration:

a.  Login to mainframe USS system.

b. Edit the following properties in the  /<installation  
directory>/wsam/<server>/etc/bcm.properties file.  

For JMS Interface Queue, update the property 'jmsqueue.enable' 

to 'yes' value. For example: 

jmsqueue.enable=yes

For JMS Interface Topic, update the property 'jmstopic.enable' 

to 'yes' value. For example: 

jmstopic.enable=yes

c. Save the updated bcm.properties file. 

2. Login to the WebSphere Admin Console and navigate to Servers > Application 
Servers option, and select the <ServerName>.

3. Navigate to the Additional Properties: Custom Services.

a. Select '-' of the probe service for an update.

b. Insert the following value exactly as written to the beginning of the Classpath 
field:          

${WAS_LIBS_DIR}/messagingImpl.jar:

Note:  The ':' is required to separate between 2 classpath values.

c. Click <Apply>.

4. In the messages Dialog box, select ’Save’.

5. In the Save to Master Configuration dialog box, 

•   If you are under ND environment, be sure the checkbox ‘Synchronize 
changes with Nodes’ is selected and then select <Save>.

• If you are NOT under ND environment, simply select <Save>.

6. You may re-verify your configuration data in /<WebSphere 
directory>/<server>/server.xml by searching the keyword ’messagingImpl’.

7. Need to ensure the existence of messagingImpl.jar file under ${WAS_LIBS_DIR} 
directory path.  To do so, navigate as follows:

a. At your z/OS WebSphere Admin console, select the Environment > Manage 
WebSphere Variables.
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b. Select the <NodeName> and leave the server option blank and click <Apply> 
button.

c. Look for ${WAS_LIBS_DIR} and its real value (e.g., 
${WAS_INSTALL_ROOT}/lib). Use <next> or <previous> link to scroll to the 
next or previous page, respectively, until you find it.

d. Need to look furthur for ${WAS_INSTALL_ROOT} and its real value from the 
previous search. (e.g., /WebSphere/V5R0M1/AppServer). 

e. Then, go to the mainframe USS system and look for the existing of 
messagingImpl.jar file under the directory of ${WAS_LIBS_DIR}.  For 
example, 

cd /WebSphere/V5R0M1/AppServer/lib

ls -l messagingImpl.jar

If you don't see it, you need to locate this messagingImpl.jar file (via your 
WebSphere administrator) and update the classpath in Custom Services 
option.

Adding MQI Capturing Support

Assumption/Pre-requisites: 

• MQ version 5.3.1 must be installed already.  

• WebSphere MQ Queue Connection and Queue Destinations must be configured 
under WebSphere MQ JMS Provider option via WebSphere Admin Console.

To enable MQI event capture: (If you are not sure about this option, contact your 
Application Support person. )

1. Enable the MQI support configuration:

a. Login to the mainframe USS system.

b. Update the property 'mqi.enable' to 'yes' in  /<installation 
directory>/wsam/<server>/etc/bcm.properties file.  For example:

mqi.enable=yes

c. Save the updated bcm.properties file. 

2. Login to the WebSphere Admin Console and navigate to Servers > Application 
Servers option, and select the <ServerName>.

3. Select the Additional Properties: Message Listener Service > Additional 
Properties: Listener Ports.

4. Click <New> for creating a new listener port or select the port name for updating.

5. Fill in the appropriate fields: 

Name: <Listener Port Name> (e.g., TestwareMQListener) 

Initial State: Started

Connection factory JNDI name:  <JNDI Name for the JMS 

connection factory> (e.g., jms/TestwareQCF)

Destination JNDI name: <JNDI Name for the destination to be 

used by listener port> (e.g., queue/mdbQueue)

6. Click <Apply> and then <OK>.

7. Navigate back to your <ServerName> page.

8. Navigate to the Additional Properties: Custom Services. .

a. Select '-' of the probe service for an update.
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b. Insert the following value exactly as written to the beginning of the Classpath 
field:          

${MQJMS_LIB_ROOT}/com.ibm.mq.jar:

Note:  The ':' is required to separate between 2 classpath values. 

c. Click <Apply>.

9. In the messages Dialog box, select ’Save’.

10. In the Save to Master Configuration dialog box, 

•   If you are under ND environment, be sure the checkbox ‘Synchronize 
changes with Nodes’ is selected and then select <Save>.

• If you are NOT under ND environment, simply select <Save>.

11. You may re-verify your configuration data in /<WebSphere 
directory>/<server>/server.xml by searching the keyword ’com.ibm.mq’.

12. Need to ensure the existence of com.ibm.mq.jar file under ${MQJMS_LIB_ROOT} 
directory path.  To do so, navigate as follows:

a. At your z/OS WebSphere Admin console, select the Environment > Manage 
WebSphere Variables.

b. Select the <NodeName> and leave the server option blank and click <Apply> 
button.

c. Look for ${MQJMS_LIB_ROOT} and its real value (e.g., 
${MQ_INSTALL_ROOT}/java/lib). Use <next> or <previous> link to scroll to 
the next or previous page, respectively, until you find it.

d. Need to look furthur for ${MQ_INSTALL_ROOT} and its real value from the 
previous search. (e.g., /usr/lpp/mqm/V5R3M1). 

e. Then, go to the mainframe USS system and look for the existing of 
com.ibm.mq.jar  under the directory ${MQJMS_LIB_ROOT}.  For example, 

cd /usr/lpp/mqm/V5R3M1/java/lib

ls -l com.ibm.mq.jar

If you don't see it, you need to locate this messagingImpl.jar file (via your 
WebSphere administrator) and update the classpath in Custom Services.

Adding Multiple Host Support

java.rmi.server.hostname property is optional and it is to be used if there are multiple 
IP stacks on the same system/LPAR. HOST_NAME is the name of your IP 
Address/host of your LPAR that you want the Data Collector to use for 
communication with the Managing Server.

1. Login to the WebSphere Administration Console.

2. Navigate as follows:

a. Select the Server > Application Servers option and select the <ServerName>.

b. Navigate to the Additional Properties: Process Definition > Servant > 
Additional Properties: Java Virtual Machine > Additional Properties: Custom 
Properties.

c. For new Data Collector installation, select <New>. 

d. In the configuration panel, enter the following name/value pair. Select <OK> 
after each add operation:
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1java.rmi.server.hostname property is optional and it is to be used if there are 
multiple IP stacks on the LPAR. HOST_NAME is the name of your IP 
Address/host of your LPAR that you want the Data Collector to use for 
communication with the Managing Server.

e. For Data Collector upgrade, verify whether the existing host name value is 
still valid. 

3. In the Messages dialog box, select ’Save’. 

4. In the Save to Master Configuration dialog box, 

•   If you are under ND environment, be sure the checkbox ‘Synchronize 
changes with Nodes’ is selected and then select <Save>.

• If you are NOT under ND environment, simply select <Save>.

5. You may re-verify your configuration data in /<WebSphere 
directory>/<server>/servant.jvm options by searching the variable name (e.g., 
java.rmi.server.hostname).

Adding Support for Composite Requests using CTG

See CICS document for reference. 

Adding Support for Composite Requests using IMS Connect

See IMS document for reference. 

Name Suggested Value

java.rmi.server.hostname1 HOST_NAME
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Chapter 10. Troubleshooting

The following information will help you in troubleshooting problems with your 
installation. 

Log Files

The following log files may provide some useful data for troubleshooting, with or 
without the assistance of the IBM® Support team. Most logs are not owned by 
Application Monitor but are used as a destination to receive diagnostic messages from 
its code.

WAS Error Logs

Application Monitor does not use this log. This is the standard WebSphere Error Log.  
See Appendix A, “Tivoli TEC Integration,” on page 115 for more information on 
viewing this log. 

Data Collector Log

Application Monitor uses this log. 

The managed system uses this log file to record major events. Some of these events 
pertain to the connections between the managing appliance and the managed system 
as well as other anomalies that might be encountered. The Data Collector log is 
located in the directory /<installation directory>/wsam/<server>/logs/filename 
where the filename is constructed as: 

sysplex.machine_name.lpar_name.server_instance_name.yyyymmddhhmmss.address-space-id-
number.datacollector.log

where yyyy=year, mm=month, dd=day, hh=hour, mm=minutes, ss=seconds, address-
space-id-number is a decimal.

CYN1 Log

Application Monitor uses this log.

The managed system, Common Services Subsystem, uses this log (pointed to by the 
CYN1 proc for the CYN1 subsystem) to print information regarding the SMF records 
received and processed by the subsystem. It will display both informational and 
diagnostic messages as well. For more details on the messages, check the following 
manual: WebSphere® Studio Application Monitor Messages and Codes (SC31-6315-
02).

Viewing the WebSphere error log:

While we have supplied a Rexx Exec in CYN.SCYNPROC, this is not a supported 
function and is provided on a “use as-is” basis. To view the error log, issue the TSO 
command:

EX ‘CYN.SCYNPROC(CYN1ELOG)’  ‘WAS.ERROR.LOG’

If your systems use a log name other than “was.error.log”, simply substitute the log 
name used in your installation.  If you are unsure of the log name or are running 
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multiple servant regions, check the JESMSGLG file for the servant region.  The log file 
name will be identified on the BBOU0025I informational message.

Protocol Timeout

If you have a transaction that is hung or too slow, you need to do this to avoid an 
abend. 

1. Login to the WebSphere Administration Console.

2. Navigate as follows:

a. Select the Server > Application Servers option and select the server you want 
to configure for use with the Application Monitor.

b. Navigate to the Additional Properties: Process Definition > Control > 
Additional Properties section.

c. Select ’Environment Entries’. 

d. Add the following properties, as name/value pairs.  Select <OK> after each 
add operation:

   

 

3. In the Messages dialog box, select ’Save’.

4. In the Save to Master Configuration dialog box, 

•  If you are under ND environment, be sure the checkbox ‘Synchronize 
changes with Nodes’ is selected and then select <Save>.

• If you are NOT under ND environment, simply select <Save>.

 

5. You may re-verify your configuration data in /<WebSphere 
directory>/<server>/was.env.

Name Suggested 
Minimum Value

protocol_http_timeout_input 3600

protocol_http_timeout_output 3600

protocol_http_timeout_output_recovery 3600

protocol_http_timeout_persistentSession 3600
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Chapter 11. Uninstalling the z/OS Data  Collector

The following information will help you to disable, re-enable, or uninstall the z/OS 
Data Collector. 

Disable the Application Monitor

z/OS Websphere 5

1. Login to the WebSphere Admin Console.

2. Select the Servers > Application Servers option > select the <NodeName> and 
select the <ServerName>. 

3. Navigate to the Additional Properties: Custom Services section. 

4. Click the "-" of the Probe Service property, and uncheck the "startup" checkbox.

5. Click <Apply>.

6. To disable the Data Collector Home Runtime, go back to your <ServerName>  
link page and navigate to Additional Properties:Process Definition > Servant> 
Additional Properties :JVM.

7. Remove the  "-Xruncyanea" argument from the Generic JVM arguments.

8. Click <Apply>.

9. To disable the JNDI, remove the following value in the classpath if it exists.  

/<installation directory>/wsam/<server>/etc

10. Click <Apply>.

11. In the messages Dialog box, select ’Save’.

12. In the Save to Master Configuration dialog box, 

•   If you are under ND environment, be sure the checkbox ‘Synchronize 
changes with Nodes’ is selected and then select <Save>.

• If you are NOT under ND environment, simply select <Save>.

13. To disable the Application Monitor JDBC driver: 

• Login to USS mainframe system.

• Open the /<installation directory>/wsam/<server>/etc/bcm.properties file, 
and update the property  'jdbc.enable' to 'no' value. For example,

jdbc.enable = no

14. To disable JMS feature: 

• Login to USS mainframe system. 

• Open the /<installation directory>/wsam/<server>/etc/bcm.properties file, 

— For JMS Interface Queue, update the property 'jmsqueue.enable' to 'no' 
value. For example, 

jmsqueue.enable = no

— For JMS Interface Topic, update the property 'jmstopic.enable' to 'no' 
value. For example,

jmstopic.enable=no

15. To disable MQI feature: 
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• Login to USS mainframe system. 

• Open the /<installation directory>/wsam/<server>/etc/bcm.properties file, 
and update the property ’mqi.enable' to 'no' value. For example, 

mqi.enable = no

16. To disable SAM/IMS feature: Please refers to the IMS document for detail 
references.

17. To disable SAM/CICS feature: Please refers to the CICS document for detail 
references.

18. Restart your server. 

Re-enable the Application Monitor

The following instructions describe the process for re-enabling the z/OS Data 
Collector.

z/OS WebSphere 5

1. Login to the WebSphere Admin Console.

2. Select the Servers > Application Servers option >and the <ServerName>.

3. Navigate to the Additional Properties: Custom Services. 

4. Click the "-" of the Probe Service property, and check the "startup" checkbox.

5. Click <Apply>.

6. To re-enable the Data Collector Home Runtime, go back to your <ServerName> 
link page and navigate to Additional Properties:Process Definition> Servant> 
Additional Properties: JVM.

7. Add "-Xruncyanea" in the Generic JVM arguments section.

8. Click <Apply>.

9. To re-enable JNDI, add the following value in the Classpath field if necessary. See 
JNDI under “Optional z/OS WebSphere 5 Support” on page 75. 

/<installation directory>/wsam/<server>/etc

10. Click <Apply>.

11. In the messages Dialog box, select ’Save’.

12. In the Save to Master Configuration dialog box, 

•   If you are under ND environment, be sure the checkbox ‘Synchronize 
changes with Nodes’ is selected and then select <Save>.

• If you are NOT under ND environment, simply select <Save>.

13. To re-enable the Application Monitor JDBC provider: 

• Login to USS mainframe system.

• Open the /<installation directory>/wsam/<server>/etc/bcm.properties file, 
and update the property 'jdbc.enable' to 'yes' value. For example,

jdbc.enable = yes

14. To re-enable JMS feature: 

• Login to USS mainframe system. 

• Open the /<installation directory>/wsam/<server>/etc/bcm.properties file, 

— For JMS Interface Queue, update the property 'jmsqueue.enable' to 'yes' 
value. For example, 
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jmsqueue.enable = yes

— For JMS Interface Topic, update the property 'jmstopic.enable' to 'yes' 
value. For example,

jmstopic.enable=yes

15. To re-enable MQI feature: 

• Login to USS mainframe system. 

• Open the /<installation directory>/wsam/<server>/etc/bcm.properties file, 
and update the property 'mqi.enable' to 'yes' value. For example, 

mqi.enable = yes

16. To re-enable SAM/IMS feature: Please refers to the IMS document for detail 
references.

17. To re-enable SAM/CICS feature: Please refers to the CICS document for detail 
references.

18. Restart your server. 

Uninstalling the z/OS Data Collector

The following directions describe the uninstall process for z/OS WebSphere 5.

z/OS WebSphere 5

1. Login to the WebSphere Admin Console.

2. Select Servers > Application Servers option > and the <ServerName> and select 
the server  you want to unconfigure. 

3. Uninstall Probe Services:

Navigate to Additional Properties:Custom Services. Click on the checkbox of 
com.cyanea.websphere.ProbeService classname and select <Delete>.

4. In the Messages dialog box, select ’Save’. 

5. In the Save to Master Configuration dialog box, 

•  If you are under ND environment, be sure the checkbox ‘Synchronize 
changes with Nodes’ is selected and then select <Save>.

• If you are NOT under ND environment, simply select <Save>.

6. Uninstall the Data Collector Home runtime properties as follows:

a. Go to your <ServerName> link page and navigate to Additional 
Properties:Process Definition > Servant > Additional Properties: Java Virtual 
Machine

b. Remove the following value from the Classpath field if it exists. 

/<installation directory>/wsam/<server>/etc

c. Remove Generic JVM arguments that reference –Xruncyanea

d. Click <Apply>.

e. Go to Additional Properties:Custom Properties. 

f. Click on the checkbox of cyanea.home and click <Delete>. 

g. Click on the checkbox of java.rmi.server.codebase and click <Delete>.

h. Click on the checkbox of appserver.platform if it exists and click <Delete>.

i. Click on the checkbox of java.rmi.server.hostname if it exists and click 
<Delete>.
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j. Click on the checkbox of sam.codepage if it exists, and click <Delete>. 

7. In the Messages dialog box, select ’Save’. 

8. In the Save to Master Configuration dialog box, 

•   If you are under ND environment, be sure the checkbox ‘Synchronize 
changes with Nodes’ is selected and then select <Save>. 

• If you are NOT under ND environment, simply select <Save>.

9. Uninstall SMF support and protocol HTTP Timeout option as follows: 

a. Go to your <ServerName link> page and navigate to Additional 
Properties:Process Definition > Control > Additional Properties:Environment 
Entries. 

b. Remove the following properties if they exist, for example:

server_SMF_container_interval_enabled = 1

server_SMF_interval_length = 120

server_SMF_server_interval_enabled = 1

server_SMF_web_container_interval_enabled=1

c. Remove the following properties if they exist, for example:

protocol_http_timeout_input=3600

protocol_http_timeout_output=3600

protocol_http_timeout_output_recovery=3600

protocol_http_timeout_persistentSession=3600

10. In the Messages dialog box, select ’Save’. 

11. In the Save to Master Configuration dialog box, 

•   If you are under ND environment, be sure the checkbox ‘Synchronize 
changes with Nodes’ is selected and then select <Save>.

• If you are NOT under ND environment, simply select <Save>.

12. Uninstall PMI support: Go to your <ServerName> link page and navigate to 
Additional Properties: Performance Monitoring Service. Deselect “Startup” 
checkbox and select “none” in the “initial specification level” option.

13. In the Messages dialog box, select ’Save’. 

14. In the Save to Master Configuration dialog box, 

•  If you are under ND environment, be sure the checkbox ‘Synchronize 
changes with Nodes’ is selected and then select <Save>.

• If you are NOT under ND environment, simply select <Save>.

15. Uninstall the server region libpath as follows: 

a. Login to Admin console and navigate as follows:

1) Select the Servers > Application Servers option > select the <NodeName> 
and select the <ServerName>.

2) Navigate to Additional Properties: Process Definition > Servant > 
Additional Properties: Environment Entries.

3) Select the LIBPATH property entry.

4) Remove the following values if they exist: 

<installation 
directory>/wsam/<server>/lib:/usr/lpp/cicists/gateway/ctg/deployable

Note:  If LIBPATH property only contains above Data Collector property, 
you can simply do the following:
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a) Select the checkbox of LIBPATH property.

b) Select the <Delete> button.

5) In the Message dialog box, select ‘Save’.

6) In the Save to Master Configuration dialog box, 

•  If you are under ND environment, be sure the checkbox ‘Synchronize 
changes with Nodes’ is selected and then select ‘Save’. 

• If you are NOT under ND environment, simply select ‘Save’.

16. Uninstall JDBC Providers

a. Login to WebSphere Admin Console. 

b. Go to Resources > JDBC Providers.

c. Select the <NodeName> and the <ServerName> and click <Apply>.

d. Select the checkbox of the Application Monitor JDBC provider and/or 
Application Monitor Universal JDBC provider and click <Delete>. For 
example, the provider names can be:

"<server>DB2 390 Local JDBC Driver"

"<server>DB2 Universal JDBC Driver"

e. In the Messages dialog box, select ’Save’. 

f. In the Save to Master Configuration dialog box, 

•   If you are under ND environment, be sure the checkbox ‘Synchronize 
changes with Nodes’ is selected and then select <Save>.

• If you are NOT under ND environment, simply select <Save>.

g. To unconfigure the Application Monitor JDBC option: 

• Login to USS mainframe system.

• Open the /<installation directory>/wsam/<server>/etc/bcm.properties 
file, and update the property 'jdbc.enable' to 'no' value. For example,

jdbc.enable = no

17. Unconfigure JNDI support

If previous "Uninstall Probe Services" step is not executed, do the following: 

a. Login to the WebSphere Admin Console and navigate to Servers > 
Application Servers option and select your <ServerName>.

b. In the Process Definition > Server > Additional Properties:Java Virtual 
Machine link, remove the following value from the Classpath field and select 
<Apply>.

/<installation directory>/wsam/<server>/etc

c. In the messages Dialog box, select ’Save’.

d. In the Save to Master Configuration dialog box, 

•   If you are under ND environment, be sure the checkbox ‘Synchronize 
changes with Nodes’ is selected and then select <Save>.

• If you are NOT under ND environment, simply select <Save>.

e. You may re-verify your configuration data in /<WebSphere 
directory>/<server>/was.env by searching the keyword 
server_region_classpath.

18. To unconfigure JMS feature: 

• Login to USS mainframe system. 

• Open the /<installation directory>/wsam/<server>/etc/bcm.properties file, 
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— For JMS Interface Queue, update the property 'jmsqueue.enable' to 'no' 
value. For example, 

jmsqueue.enable = no

— For JMS Interface Topic, update the property 'jmstopic.enable' to 'no' 
value. For example,

jmstopic.enable=no

19. To unconfigure MQI feature: 

• Login to USS mainframe system. 

• In the /<installation directory>/wsam/<server>/etc/bcm.properties file, set 
the property 'mqi.enable' to 'no' value. For example, 

mqi.enable = no

• Navigate to Servers > Application Server Options > Select the <ServerName>.

• Select the Additional Properties: Message Listener Service link.

•  Select the Additional Properties: Listener Ports link.

• Select the checkbox of the Application Monitor Listener Port and click 
<Delete>.  For example, listener port name can be 'TestwareMQListener'. 
Click <Apply> or <OK>.

• In the messages Dialog box, select 'Save'. 

• In the Save to Master Configuration dialog box:

— If you are under ND environment, be sure the checkbox 'Synchronize 
changes  with Nodes' is selected and then select 'Save'.

— If you are NOT under ND environment, simply select 'Save'.

20. To unconfigure SAM/IMS feature: Please refers to the IMS document for detail 
references.

21. To unconfigure SAM/CICS feature: Please refers to the CICS document for detail 
references.
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Part 4. The Data Collector for Multiplatforms
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Chapter 12. Preparing to Install

The following are the pre-installation requirements for installing and using the Data 
Collector. 

Requirements for Installing the Data Collector

The following are the requirements for being able to install and use the Data Collector. 

Note:  For manual installation instructions, see Appendix D. 

   
Table 7. Data Collector Requirements

Platform Application Server Additional Requirements

AIX 5.1 WebSphere 5.0.2.6, 
5.1.1 WebSphere 
Portal 5.0.2

 Check that the following packages are installed. 
(The numbers may be these or later file set 
numbers.)

• bos.perf.diag_tool 5.1.0.25 Performance 
Diagnostic Tool 

• bos.perf.libperfstat 5.1.0.35 Performance 
Statistics Library

• bos.perf.perfstat 5.1.0.36 Performance Statistics 
Interface 

• bos.perf.tools 5.1.0.35 Base Performance Tools 

AIX 5.2 WebSphere 5.0.2.6, 
5.1.1

 Check that the following packages are installed. 
(The numbers may be these or later file set 
numbers.)

• bos.perf.diag_tool 5.2.012 Performance 
Diagnostic Tool 

• bos.perf.libperfstat 5.2.0.10 Performance 
Statistics Library

• bos.perf.perfstat 5.2.0.14 Performance Statistics 
Interface 

• bos.perf.tools 5.2.0.17 Base Performance Tools 

Solaris 8 WebSphere 5.0.2.6, 
5.1.1 

               

Solaris 9 WebSphere 5.0.2.6, 
5.1.1

HP-UX 11.iv1 WebSphere 5.0.2.6, 
5.1.1 

In order to generate a Java heap dump, you must 
rebuild the kernel.  See “Rebuild the HP-UX Kernel” 
on page 103.

Windows 
2000 sp4

WebSphere 5.0.2.6, 
5.1.1 

Windows 
2003

WebSphere 5.0.2.6, 
5.1.1

RHEL 
2.1(Intel) 

WebSphere 5.0.2.6, 
5.1.1 
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Increase the Heap Size

We recommend you increase the heap size configuration by 64 MB above the current 
configuration. 

Cluster Considerations

To install on a cluster, run the installer on each node that you wish to install upon. It is 
recommended that you create a response file and use the silent installer mode if you 
have to install across multiple nodes in a cluster. 

z/Linux SuSe 
8.1

WebSphere 5.0.2.6, 
5.1.1

Table 7. Data Collector Requirements

Platform Application Server Additional Requirements
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Chapter 13. Installation and Configuration

This chapter describes how to install the Data Collector for distributed platforms. 

The installation procedure uses a graphical installer.  Alternately, it is possible to 
install the Data Collector manually.

If you want to verify the changes that the graphical installer makes to your 
application server’s configuration, you can find them in the section “Manually 
Installing the J2EE Data Collector” on page 157.

Installing the Data Collector

The following instructions describe how to install the Data Collector onto your 
system. Follow the instructions appropriate for the platform and application server. 

General Information

1. Data Collector installation can be performed on single or multiple application 
servers in Network Deployment (ND) or Non-network Deployment 
environments. 

2. Data collector installation cannot span over multiple nodes. 

3. The installer has an interactive (GUI) mode and a non-interactive (silent) mode. 

Installing Data Collectors that Monitor WebSphere

Gather Configuration Information

• WebSphere instance host name and SOAP port (Default value is 8880, may be 
different for your environment.)

— If using ND, provide the hostname and SOAP port of the Deployment 
Manager. 

If Global Security is turned on, provide the WebSphere Username and Password of a 
WebSphere user with administrative rights.: 

• WebSphere Username

• WebSphere Password

Installation

This section contains instructions to install a Data Collector that monitors WebSphere 
on either a UNIX or Windows system.  Follow the instructions appropriate to the 
platform on which you are installing the Data Collector.

To install the Data Collector on UNIX with WebSphere:

1. Start your J2EE server. 

Note:  If you are in an ND environment then you must start the following.

• Deployment Manager

• Node Agent
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• WebSphere instances to be monitored

2. Log in as a user who has permissions to create the installation directory, for 
example: /opt/cyaneone/.

3. Set up WAS_HOME (should point to your local WebSphere application server 
home directory), JAVA_HOME, and include the Java bin directory in the PATH:

Solaris, HP-UX, AIX, Intel/Linux and z/Linux

WAS_HOME=<WebSphere installation directory>; export WAS_HOME

JAVA_HOME=${WAS_HOME}/java; export JAVA_HOME

PATH=${JAVA_HOME}/bin:${PATH}; export PATH

Note:  To verify this has completed correctly issue the following commands:

echo $WAS_HOME

echo $JAVA_HOME

echo $PATH

and verify the output from the echo command to your inputs.

4. Locate the file MPDCInstall.tar in the installation media. Extract the contents to a 
temporary directory:

mkdir /tmp/cyainst

cp MPDCInstall.tar /tmp/cyainst

cd /tmp/cyainst

tar xf MPDCInstall.tar

5. If you want to perform an Interactive (GUI) install go to Step 5a. If you want to 
perform a non-Interactive (silent) install go to step 5b. 

Note:  Do not re-run installer without restoring your original configuration. The 
location of the backup of the configuration performed by the installer can be 
found in the log file. 

a. If running the installation on a remote server, export the display to your local 
workstation using the following command: 

DISPLAY=<workstation>:0; export DISPLAY

Run installer (You must be in the bin directory of the installer to work 
properly.):

cd /tmp/cyainst/Installer-DC/bin/

sh install-DC.sh

b. Create a copy of the sample response file.

cd /tmp/cyainst/Installer-DC/etc

cp dcInputs_Sample.txt dcInputs.txt

Edit the response file dcInputs.txt. The parameters required are documented 
within the text file.

Run the installer in silent mode. 

cd /tmp/cyainst/installer-DC/bin/

sh install-DC.sh -silent ../etc/dcInputs.txt

6. Restart the application server on which you installed the Data Collector.

7. Go to the Application Monitor of the Managing Server and configure the Data 
Collector you installed.

Note:  Make sure the Application Server type and version, and the operating system 
type and version you are using are supported. (If the installation environment does 
not meet the pre-requisites, the installer pre-requisite check will fail and you will be 
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unable to continue the installation. If you wish to proceed with the installation, you 
can bypass the pre-requisite check by passing the parameter "-force" to install-DC.sh.

Note:  The installer will create log files in /tmp/cyanea_installer_dc/. After 
installation, you can find a copy of the logs in the <cyanea_home>/logs directory. 

Note:  The installer will save your previous WebSphere configuration before 
installation. Refer to the log file for the location of the backup.

To install the Data Collector on Windows with WebSphere:

1. Start your J2EE server. 

Note:  If you are in an ND environment then you must start the following.

• Deployment Manager

• Node Agent

• WebSphere instances to be monitored

2. Log in as a user who has permissions to create the installation directory, for 
example: c:\opt\cyaneone\.

3. Set up WAS_HOME (should point to your local WebSphere application server 
home directory), JAVA_HOME, and include the Java bin directory in the PATH, 
for example:

set WAS_HOME=c:\Program Files\WebSphere\Appserver

set JAVA_HOME=%WAS_HOME%\java

set PATH=%JAVA_HOME%\bin; %PATH%

4. Locate the file MPDCInstall.tar in the installation media. Extract the contents to a 
temporary directory: 

mkdir c:\temp\cyainst

Uncompress MPDCInstall.tar into c:\temp\cyainst.

5. If you want to perform an Interactive (GUI) install go to Step 5a. If you want to 
perform a non-Interactive (silent) install go to step 5b.

Note:  Do not re-run installer without restoring your original configuration. The 
location of the backup of the configuration performed by the installer can be 
found in the log file. 

a. Run installer:

cd c:\temp\cyaninst\Installer-DC\bin

Installer-DC\bin\install-DC.bat

b. Create a copy of the sample response file.

cd c:\temp\cyaninst\Installer-DC\etc

copy dcInputs_Sample.txt dcInputs.txt

Edit the response file dcInputs.txt copy in the installer bin directory. The 
parameters required are documented within the text file.

Run the installer in silent mode. 

cd c:\temp\cyaninst\Installer-DC\bin

install-DC.bat -silent ..\etc\dcInputs.txt

Note:  Make sure the Application Server type and version, and the operating 
system type and version you are using are supported. (If the installation 
environment does not meet the pre-requisites, the installer pre-requisite check 
will fail and you will be unable to continue the installation. If you wish to proceed 
with the installation, you can bypass the pre-requisite check by passing the 
parameter "-force" to install-DC.bat.
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Note:  The installer will create log file in the <TEMP>\cyanea_installer_dc 
directory, where TEMP is a Windows environment variable. You can locate the 
value of TEMP by typing: 

echo %TEMP%

After installation, you can find a copy of the logs in the <cyanea_home>\logs 
directory. 

Note:  The installer will save your previous WebSphere configuration before 
installation. Refer to the log file for the location of the backup.  

6. Restart the application server on which you installed the Data Collector. 

7. Go to the Application Monitor of the Managing Server and configure the Data 
Collector you installed. 

Node Authentication

In Node Authentication related configuration, the Kernel, Data Collectors or Port 
Consolidator operate in secure mode either individually or in combination. But the 
configuration changes are common for all the modes except that a particular 
component can be made to operate in a different mode by changing the property 
security.enabled on that particular component.

Kernel Related Changes

In Kernel properties file (kl1.properties and kl2.properties) do the following:

Note:  All the properties are already documented in the appropriate property file. Just 
uncommenting the data and giving the right value is recommended.

To enable Kernel to operate in secure mode: security.enabled=true

Only when this property is true along with the above property, then the CodeBase 
server will operate in secure mode: codebase.security.enabled=true

Define CYANEA_HOME accordingly.

Path of the certificate to use when talking to Data Collector. This is needed only when 
Data Collector is operating in secure mode.

certificate.path=<CYANEAHOME>/etc/mgmttodc.cer:<CYANEAHOME>/etc/mg
mttoproxy.cer:<CYANEAHOME>/etc/mgmttomgmt.cer

Keystore location of the management server: 
keystore.location=<CYANEAHOME>/etc/CyaneaMgmtStore

Other properties that you need NOT change and are set by default or should be 
changed when a specific situation arises.

For backward compatibility of old Data Collectors to work with new security enabled 
Kernel IPaddresses need to be seperated by ':'.   
cyanea.trustedips=192.168.3.84:127.0.0.1

Keystore location of the management server: 
keystore.location=/<CYANEA_HOME>/etc/CyaneaMgmtStore

Keystore password of management server: keystore.storepass=cyanea94612

Keystore key password of management server: keystore.keypass=cyanea94612

User ID passed to other end for authentication: nodeauth.userid=cyaneamgmt    
When there are multiple I/O cards, if you want to use specific IP for code base server 

authentication: nodeauth.ip=
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Data Collector Related Changes

To enable Data Collector to operate in secure mode: security.enabled=true

Define CYANEA_HOME accordingly.

Path of the certificate to use when talking to Data Collector. This is needed only when 
Data Collector is operating in secure mode.

certificate.path=<CYANEA_HOME>/etc/dctomgmt.cer

Keystore location of the Data Collector: 
keystore.location=<CYANEA_HOME>/etc/CyaneaDCStore

Other properties that you need NOT change and are set by default or should be 
changed when a specific situation arises.

Keystore password of Data Collector server: keystore.storepass=oakland94612

Keystore key password of Data Collector server: keystore.keypass=oakland94612

User ID passed to other end for authentication: nodeauth.userid=cyaneadc

Node Authentication Related Properties in Port Consolidator

To enable portconsolidator to operate in secure mode: security.enabled=true

Path of the certificate to use when talking to port consolidator. This is needed only 
when Data Collector is operating in secure mode.

certificate.path=<cyanea home>/etc/proxytomgmt.cer:<cyanea 
home>/etc/proxytodc.cer

Keystore location of the portconsolidator: keystore.location=<cyanea 
home>/etc/CyaneaProxyStore

Keystore password of portconsolidator server: keystore.storepass=oakland94612

Keystore key password of portconsolidator server: keystore.keypass=oakland94612

User ID passed to other end for authentication: nodeauth.userid=cyaneaproxy

Keystore Managment and Populating Certificates

 You do not have to do the following unless you want to integrate the keystore into 
your own keystore.

For populating management server keystore do the following:

Note:  Replace cyanea94612 with appropriate passwords and CyaneaMgmtStore with 
appropriate storefile.

keytool -genkey -alias mgmtmgmt -keyalg RSA -keysize 1024 -sigalg MD5withRSA -
validity 

2000 -keypass cyanea94612 -keystore ./CyaneaMgmtStore  -storepass cyanea94612 -
dname 

"cn=mgmtmgmt, OU=CyaneaComp, O=Cyanea, L=Oakland, ST=CA, C=US"

keytool -genkey -alias fordc -keyalg RSA -keysize 1024 -sigalg MD5withRSA -validity 
2000 

-keypass cyanea94612 -keystore ./CyaneaMgmtStore  -storepass cyanea94612 -dname 

"cn=cyaneadc, OU=CyaneaComp, O=Cyanea, L=Oakland, ST=CA, C=US"

For  populating Data Collector keystore do the following:
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Note:   Replace oakland94612 by appropriate passwords and CyaneaDCStore with 
appropriate storefile.

keytool -genkey -alias formgmt -keyalg RSA -keysize 1024 -sigalg MD5withRSA -
validity 2000 

-keypass oakland94612 -keystore ./CyaneaDCStore  -storepass oakland94612 -dname 

"cn=cyaneamgmt, OU=CyaneaComp, O=Cyanea, L=Oakland, ST=CA, C=US"

To populate certificates do the following for each of the aliases in the KeyStore.

To list all aliases in each store: 

keytool -list -keystore ./CyaneaMgmtStore -storepass oakland94612 -keypass 
oakland94612

For each alias, generate the certificate by issuing the following command (select the 
appropriate password): 

$CYANEA_HOME/bin/keygen.sh ./CyaneaMgmtStore cyanea94612 <alias> 
cyanea94612

Node Authentication Related Properties for the Visualization 
Engine

Here <Cyanea Home> is /opt/cyaneaone replace accordingly. All the following 
properties need to be set as System Properties using AppServer AdminConsole.

Path of the certificate to use when talking to the Data Collector. This is needed only 
when the Data Collector is operating in secure mode. 
certificate.path=/<CYANEA_HOME>/etc/mgmttomgmt.cer

Keystore location of the management server: 
keystore.location=/<CYANEA_HOME>/etc/CyaneaMgmtStore

Keystore password of management server keystore.storepass=cyanea94612

Keystore key password of management server keystore.keypass=cyanea94612

User ID passed to other end for authentication nodeauth.userid=cyaneamgmt

Adding MQ Support

To enable MQ monitoring on WebSphere, set the following system property: 

cyanea.ext.dirs=<MQ_INSTALL_ROOT>/java/lib/
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Chapter 14. Customization

The following provide instructions for customizing your Data Collector. 

Rebuild the HP-UX Kernel

The kernel parameters maxdsiz and maxdsiz_64bit limit the data segment size of a 
process in HP-UX. In order to generate a Java heap dump, the parameters must be set 
to at least 1.6 times the size of the Java heap size in the application server. 

To configure HP-UX to provide a Java heap dump:

1. Use kmtune to set the parameters maxdsiz and maxdsiz_64bit  to at least 1.6 times 
the size of the Java heap size in the application server.

2. Rebuild the kernel.

3. Reboot the node. 

Note:  Refer to the HP-UX documentation for details on how to configure the 
kernel memory parameters. 

Configuring Web Servers 

In order to monitor Web Servers using the Web Server Overview feature, you must 
configure your Web Servers appropriately.  This feature is available for Apache and 
IBM HTTP servers.

To configure Web Servers to be monitorable by the Web Servers Overview:

1. Obtain mod_status_xml library file from http://httpd.apache.org/docs-
2.0/en/mod/mod_status.html. 

2. Copy mod_status_xml library file to the libexec subdirectory of the Web Server 
installation directory.  For example, to /opt/IBMHTTPServer/libexec.

3. Edit the httpd.conf file, located in the conf subdirectory of the Web Server 
installation directory.  For example, in /opt/IBMHTTPServer/conf.

a. Remove comments (#) from the following lines in httpd.conf:

ExtendedStatus On

LoadModule status_module      libexec/mod_status.so

AddModule mod_status.c

b. Add the following lines to httpd.conf.  Replace  <Polling Agent IP Address> 
with the domain of the Managing Server:

# configuration for mod_status

<Location /server-status>

SetHandler server-status

Order deny,allow

Deny from all

Allow from all <Polling Agent IP Address>

</Location>

c. Save your changes.
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Parameters Specified with Multiple Network Cards 

To install multiple network cards: Make sure that the IP specified for the data collector 
server are IPs that can be used to talk to each other (i.e if there is a network config 
where one of the IPs does not have a path to the other box, don’t use that IP). 

1. On the data collector machines, define an additional Java system property and set 
it to the IP address of the Data Collector:

java.rmi.server.hostname

2. On the data collector machine, in the 
$CYANEA_HOME/etc/datacollector.properties file change the kernel.codebase 
and kernel.rfs.address to point to the managing server IP. If there are any 
generated datacollector property files (these have names like 
datacollector.properties.<appservername>… or 
<hostname>.<appservername>.datacollector.properties….,) you will need to 
remove those. They will be regenerated when the data collector starts.

Nested Requests

For WebSphere, we support the following nested requests:

   

 

To disable a nested requests, rename or remove the corresponding xml files from 
<CYANEA_HOME>/etc directory. For example, to disable JMS nested requests for 
websphere 511, remove was51_jmst.xml and was51_jmsq.xml

For WebSphere portal, we support the following nested requests:

   

 

Functions

Servlet was<VERSION>_servlet.xml

EJB was<VERSION>_ejb.xml

JDBC was<VERSION>_jdbc.xml

JCA was<VERSION>_jca.xml

JNDI was<VERSION>_jndi.xml

JMS was<VERSION>_jmst.xml, 
was<VERSION>_jmsq.xml

MQI was<VERSION>_jbsmqi.xml

Functions

Portal page wps<VERSION>_page.xml

Portlet wps<VERSION>_portlet.xml

Authentication wps<VERSION>_login.xml

Authorization wps<VERSION>_authorization.xml

Credential Vault wps<VERSION>_credentialvault.xml

Content Access wps<VERSION>_contentaccess.xml
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To disable a nested requests, rename or remove the corresponding xml files from 
<CYANEA_HOME>/etc directory.

For JDBC Adapter, we support the following nested requests:

   

 

To disable a nested requests, rename or remove the corresponding xml files from 
<CYANEA_HOME>/etc directory.

Functions

JDBC pool resource wbi_jdbc_pool.xml

JDBC wbi_jdbc_sql.xml

Requests wbi_jdbc_requests.xml

MQI wbi_mqi.xml

Serialization wbi_serialize.xml
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Chapter 15. Troubleshooting

Out of Memory Error

If out of memory errors occur while you are using L3 and hotspot JVM, follow the 
instructions below.                                                                                                                                                                                          

 The default NewSize and MaxNewSize might be small for some Applications if the 
Application is allocating large numbers of short living objects. 

Some tuning we recommend for an applicationthat allocates many short living 
objects: 

-XX:+DisableExplicitGC -XX:NewSize=128m -XX:MaxNewSize=256m -Xconcurrentio

Note:  NewSize and MaxNewSize should be changed based on the Maximum and 
Minimum heap settings of the JVM.
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Chapter 16. Uninstalling the Distributed Data Collector

These instructions describe how to disable and uninstall the Data Collector.  The 
instructions vary based on the application server and plaform.

Disable

The following instructions describe how to disable the Data Collector.

Disabling Data Collectors for WebSphere

Follow the instructions appropriate for the platform on which you would like to 
disable the Data Collectors for WebSphere.

To disable the Data Collector for WebSphere on AIX, Solaris, Linux, HP-UX or 
Windows:

1. Prior to starting the disable process, stop the data collector. 

2. Open the WebSphere Administrative Console from the 

[installation directory]/bin/adminclient.sh [hostname] [port number]

3. Click the + sign until you ungroup the Application Servers directory.

4. Select the server where the Administrator installed the data collector.

5. Select the Custom tab.

6. Highlight WSAM Custom Service.

7. Click Edit.

8. Uncheck the Enabled box.

9. Click OK and click Apply. 

10. Select the JVM Settings tab. 

11. Click Advanced JVM Settings.

12. In the Command Line Arguments field remove:                                                                     

-Xruncyanea

13. Click OK and click Apply. 

To remove associated files:

1. Go to the WebSphere installation directory:

2. Go JVM Advance properties. 

3. Remove -xbootclasspath.

4. Start WebSphere.

Uninstalling the Data Collectors

Perform these instructions to uninstall the Data Collector.

To uninstall the Data Collector:

1. Disable the Data Collector, as described in “Disabling Data Collectors for 
WebSphere”.
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2. Remove the installed files.

3. Undo the WebSphere configuration changes as described in Appendix D. 
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Chapter 17. WBI JDBC Adapter Data Collector 

Installing the Data Collector on WBI JDBC Adapter

Installing Data Collector Files

Prerequisites: Follow JDBC Adapter Configuration guide to set up JDBC Adapter.

To copy the Data Collector files for JDBC:

1. Locate the file MPDCInstall.tar in the installation media. Extract the contents to a 
temporary directory:

mkdir /tmp/cyainst

tar xvf MPDCInstall.tar /tmp/cyainst

2. Copy the following files to the /<CYANEA_HOME>/lib directory files, as 
described in the following table:

   

 

3. Copy the following files to the <CYANEA_HOME>/etc directory files, as 
described in the following table. Customize datacollector.policy and 
datacollector.properties based on Managing Server deployment. Customize 
request.properties based on the Data Collector deployment. 

   

Destination directory Files to copy to <CYANEA_HOME>/lib

<cyanea_home>/lib dc/dc_home/lib/ppe.probe.jar

<cyanea_home>/lib dc/dc_home/lib/ppe.probe-intf.jar

<cyanea_home>/lib dc/dc_home/lib/cdn.jar

<cyanea_home>/lib dc/dc_home/lib/kernel.common.jar

<cyanea_home>/lib dc/dc_home/lib/model.jar

<cyanea_home>/lib dc/dc_home/lib/ppe.stdalone.jar

<cyanea_home>/lib dc/dc_home/lib/common.jar

Destination 
directory

Files to copy to <cyanea_home>/etc 

<cyanea_home>/etc dc/dc_home/etc/datacollector.policy

dc/dc_home/etc/datacollector.properties

dc/dc_home/etc/version.properties

dc/dc_home/etc/LogMessages

dc/dc_home/etc/bcm.properties
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4. Copy the appropriate library file from the dc/dc_home/lib directory to the 
<CYANEA_HOME>/lib directory, and name it appropriately, as described in the 
following table: 

   

 

Configure JDBC Adapter startup script

Follow these instructions to configure the JDBC adapter.

1. Stop the adapter. 

<ADAPTER_HOME>/bin/connector_manager_<CONNECTER_NAME>  -kill

2. Edit the file by taking the steps below.

<ADAPTER_HOME>/connectors/<CONNECTOR_NAME>/start_<CONNECTOR_NAME>.sh

a. Define the CYANEA_HOME variable:

CYANEA_HOME=/opt/cyaneaone

b. Append <CYANEA_HOME>/lib to LIBPATH.

LIBPATH=${LIBPATH}:${CYANEA_HOME}/lib

c. Define CYANEA_CLASSPATH and prepend it to CLASSPATH.

CYANEA_CLASSPATH=${CYANEA_HOME}/lib/monitered/${CONNAME}:${CYANEA_HOME}/lib/
kernel.common.jar:${CYANEA_HOME}/lib/ppe.probe.jar:${CYANEA_HOME}/lib/common
.jar:${CYANEA_HOME}/lib/cdn.jar:${CYANEA_HOME}/lib/model.jar:${CYANEA_HOME}/
lib/ppe.probe-intf.jar:${CYANEA_HOME}/lib/ppe.stdalone.jar

CLASSPATH=${CYANEA_CLASSPATH}:${CLASSPATH}

d. Modify the Java command line arguments.

Original Java command line :

exec ${CWJAVA} ${LOCAL_JVM_FLAGS} -Xms64m                                                         
-Djava.library.path=${LIBPATH} -Djava.ext.dirs=${JRE_EXT_DIRS} -classpath 
${CLASSPATH}  AppEndWrapper ${CONNECTOR_TYPE}${CONNECTOR_AGENT}                       
-n${CONNAME}Connector -s${SERVER} ${CON_START_OPTIONS}  $3 $4 $5 $6 $7 $8 $9

Modify the Java command line with cyanea installed. (Changes in bold.) 
Replace <MS_HOME> and <VERSION> with the appropriate values. 

<cyanea_home>/etc dc/dc_home/etc/wbi_jdbc_requests.xml

dc/dc_home/etc/wbi_jdbc_sql.xml

dc/dc_home/etc/wbi_jdbc_pool.xml

dc/dc_home/etc/wbi_mqi.xml

dc/dc_home/etc/wbi_serialize.xml

Platform Source file, within 
dc/dc_home/lib

Destination file, within the JDBC installation 
directory

AIX libcyanea_wbi_ibm_13_aix.so <CYANEA_HOME>/lib/libcyanea.so
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exec ${CWJAVA} ${LOCAL_JVM_FLAGS} –Xruncyanea -Xms64m1                                 
-Dcyanea.home=${CYANEA_HOME}                                                                  
-Djava.rmi.server.codebase=”file://<MS_HOME>/lib/ppe.probe-intf.jar 
file://<MS_HOME/lib<VERSION>/ppe.probe.jar 
file://<MS_HOME>/lib<VERSION>/ppe.stdalone.jar”                                                                                                                         
-Djava.security.policy=${CYANEA_HOME}/etc/datacollector.policy                                 
-Dconnector.name= ${CONNAME}                                                                                                        
-Dbroker.name=${SERVER}                                                                                                                     
-Djava.library.path=${LIBPATH} -Djava.ext.dirs=${JRE_EXT_DIRS} -classpath 
${CLASSPATH}  com.cyanea.stdalone.ProbeService AppEndWrapper 
${CONNECTOR_TYPE}${CONNECTOR_AGENT} -n${CONNAME}Connector -s${SERVER} 
${CON_START_OPTIONS}  $3 $4 $5 $6 $7 $8 $9
1If you specified heap size limits in your WBI environment, you need to 
increase your heap size by 64 MB.

3. Start the adapter: 

<ADAPTER_HOME>/bin/connector_manager_<CONNECTER_NAME>  -start
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Part 5. Appendixes
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Appendix A. Tivoli TEC Integration

Overview

The Application Monitor for Tivoli Enterprise Console® (T/EC) is the integration of 
the Application Monitor services with Tivoli Enterprise Console 3.8.

Requirements for Integrating with T/EC

The Application Monitor supports the following Tivoli® server platforms:

• Microsoft® Windows Server

• Sun Solaris

• IBM AIX

• HP-UX

The following Tivoli software is required:

• Tivoli Framework 3.7.1 or greater

• Tivoli Enterprise Console Server 3.8

• Tivoli Enterprise Console UI Server 3.8

• Tivoli Enterprise Console Console 3.8

One of the following Tivoli software components are required:

• Tivoli Enterprise Console 3.8 non-TME® SNMP Adapter

• Tivoli Enterprise Console 3.8 Adapter Configuration Facility

You should identify one system as the SNMP Adapter host, which accepts SNMP 
traps from the  Application Monitor, adapts them to T/EC Events and forwards them 
to a T/EC Server.  The supported platforms for the SNMP Adapter host are the same 
as for the Tivoli server.  To avoid interference, it is recommended that the system 
running the SNMP Adapter not run any other SNMP agent on the same UDP port.

Configuring T/EC

Summary

The Application Monitor for Tivoli Enterprise Console provides configurations for 
T/EC Server, T/EC Console, and T/EC SNMP Adapter that allow alerts from the 
Application Monitor to appear in the T/EC console.

The Application Monitor for Tivoli Enterprise Console is available as a CD-ROM 
under the directory TivoliIntegration/tec.  Copy the files to location(s) accessible by 
the T/EC server, one T/EC console and SNMP Adapter host.

Configuring the T/EC Server

The Application Monitor events are described for T/EC in cyanea.baroc.  To install 
this file, open a command prompt or shell with Tivoli paths and environment set, 
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change directories to the Application Monitor for Tivoli Enterprise Console media, 
and type the following:

sh cyanea_setup_tec.sh SourceRuleBaseName NewRuleBaseName NewRuleBasePath

SourceRuleBaseName is the name of your current rule base.  For new installations of 
Tivoli Enterprise Console, this is named “Default.”

NewRuleBaseName is the name of a new rule base to create.  “+-” is recommended.

NewRuleBasePath is the name of a new directory where the rule base will be stored.  
An example is “/usr/tec/cyanea.”  Windows users: be sure to use forward slashes in 
pathnames.

Upon successful completion, the Cyanea rulebase will accept the Application Monitor 
events.

Configuring the T/EC Console

The Application Monitor for T/EC includes a configuration file that can be imported 
into the T/EC console to define the Application Monitor event group and filter.

1. Open the T/EC Console, login as required.

Figure 3. Login

2. Select Windows > Configuration.

Figure 4. Configuration

3. Select File > Import.
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Figure 5. Import

4. Click Browse to select the file cyanea_event_group.cfg.

Figure 6. Select

5. Click Select.
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Figure 7. Import

6. Select Cyanea in the center pane and click OK.

Figure 8. Notice

7. Click OK and restart the T/EC Console.

8. Click on Event Groups to see the new Cyanea Event Group.

Figure 9. IBM Tivoli Enterprise Console Configuration

9. To use the Cyanea event group, assign it to a console.  See T/EC User’s Guide for 
instructions. The operators for that console will now see Cyanea in their summary 
chart view and event viewer.
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Figure 10. IBM Tivoli Enterprise Console

Figure 11. Event Viewer

10. T/EC console is now configured.

Installing and Configuring the T/EC SNMP Adapter

As noted in the Requirements section, there are two choices for T/EC SNMP Adapter: 
non-TME and Adapter Configuration Facility (ACF) versions.  The non-TME version 
is a standalone installation, and the ACF version can be deployed remotely using the 
Tivoli Desktop.  The following sections describe the steps required for each.  Do not 
install both on the same system, as conflicts can occur.

Installing and Configuring T/EC SNMP Adapter for non-TME

Instructions for installing the non-TME version are found in the Tivoli Enterprise 
Console Adapters Guide.  Follow Tivoli’s instructions to install the non-TME SNMP 
Adapter on any of the supported platforms.
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To configure, open a command prompt or shell, change the current directory to the 
location of the Application Monitor for Tivoli Enterprise Console files, and type the 
following:

sh cyanea_config_tecad_snmp.sh pathname

Pathname is optional.  It specifies the directory name containing the SNMP Adapter.  
The script will look in a few default locations, and exit with a warning message if the 
Adapter files and directory cannot be found.

Note this script will only work on UNIX systems and Windows systems with a 
Bourne shell prompt (such as Tivoli managed node).  If you are configuring a 
Windows system without access to a Bourne shell, do the following steps from a 
command prompt:

net stop TECSNMPAdapter

copy cyanea.cds c:\tecsnmp\etc

copy cyanea.oid c:\tecsnmp\etc

c:

cd \tecsnmp\etc

copy tecad_snmp.cds+cyanea.cds

copy tecad_snmp.oid+cyanea.oid

net start TECSNMPAdapter

Installing and Configuring the T/EC SNMP Adapter for ACF

Screen by screen instructions for deploying and configuring a new ACF adapter are 
shown.  These instructions assume that the adapter will only support the Application 
Monitor traps and events.  Support for other traps requires manually appending the 
tecad_snmp.cds and tecad_snmp.oid files (not shown).

How to deploy the Application Monitor SNMP Adapter configuration and Tivoli 
Enterprise Console SNMP Adapter using T/EC Adapter Configuration Facility.

Dependencies: Framework 3.7.1 or greater, endpoint, T/EC 3.8, T/EC ACF 3.8 
installed.

1. Click Create > Region.

Figure 12. Create Region

2. Enter a name for the Policy Region, and click Create & Close.
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Figure 13. TME Desktop for Administrator Root

3. Double-click on the Policy Region to open it.

Figure 14. Policy Region Cyanea

4. Select Properties > Managed Resources.

Figure 15. Set Managed Resources

5. Move ACP and ProfileManager to the left-hand side and click Set & Close.
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6. Select Create > ProfileManager.

Figure 16. Create Profile Manager

7. Enter a name, and click the Dataless Endpoint Mode checkbox.  Click Create & 
Close.

Figure 17. Policy Region Cyanea

8. Double-click to open the Profile.
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Figure 18. Profile Manager

9. Select Profiles > Subscribers.
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Figure 19. Subscribers

10. Move the desired endpoint (to receive the SNMP adapter) to the left-hand side 
and click  Set Subscriptions & Close.
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Figure 20. Profile Manager

11. Select Create > Profile.
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Figure 21. Create Profile

12. Enter a name, select ACP, and click Create & Close.
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Figure 22. Profile Manager

13. Double-click to open the profile.

Figure 23. Adapter Configuration Profile

14. Click Add Entry.
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Figure 24. Add Adapter Configuration

15. Scroll down, select tecad_snmp, and click Select & Close.

Figure 25. Edit Adapter

16. Select Environment.
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Figure 26. Edit Adapter

17. Double-click on ServerPort in the left-hand pane.  Enter the desired T/EC port 
number (usually 5529 for NT T/EC Server, or 0 for a UNIX T/EC Server), and 
click the checkmark button to accept the change.  The entry will display in the 
right-hand pane.

Figure 27. Edit Adapter

18. Select Distribution.
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Figure 28. Edit Adapter

19. The .cds file and .oid file should be changed to include the cyanea traps.  There 
are two choices:

• Support both the Application Monitor traps and standard traps.  You must 
manually append the Tivoli supplied files with the Application Monitor files.  
They are ASCII, so use your favorite editor and/or command line tools.  Then 
follow the directions below.

• Replace with the Application Monitor files, to only support the Application 
Monitor traps.  Follow the directions as listed below.

20. Double-click on the tecad_snmp.cds entry.  

Figure 29. Edit Adapter

21. Click on the Browse button associated with the right-hand pathname.
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Figure 30. Select File

22. Browse to the location of cyanea.cds.  Select the file, and click Set & Close.

23. Click the checkmark button to accept the change, as shown in the lower pane.

Figure 31. Edit Adapter

24. Repeat the steps to change the right-hand value of tecad_snmp.oid to point to 
cyanea.oid.
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Figure 32. Edit Adapter

25. Click Save & Close.

Figure 33. Adapter Configuration Profile

26. Close the profile.

27. Distribute the profile (ex. drag the profile on top of the endpoint.) The main 
window of the desktop shows a log of actions.
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Figure 34. TME Desktop for Administrator Root_Tivoli-region 

28. The adapter is configured, distributed, and running.

Using the Application Monitor for T/EC

Configure the Application Monitor agent to send SNMP traps to the configured the 
Application Monitor SNMP Adapter host, and the Application Monitor events will 
show up in the T/EC console.

Figure 35. Event Viewer

Click on an event and choose Details for more information.
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Appendix B. BMC Patrol Integration

Overview

Cyanea for Patrol Enterprise Manager is the integration of the Application Monitor 
services with BMC’s Patrol Enterprise Manager (Patrol EM). Cyanea for Patrol EM 
consists of two components: a customized Patrol EM filter (CYANEA.afltr) and an 
application that receives Cyanea SNMP traps (CyaneaSNMPAdapter).

Requirements

The following BMC server platforms are supported by the Application Monitor:

• Sun Solaris

• IBM AIX

• HP-UX

The following BMC Patrol EM software is required:

• Patrol Enterprise Manager 4.2 or later

The following Patrol EM software is required:

• Multi-Listener - PEM TCP/IP multi-listener daemon

One system should be identified as the Cyanea SNMP Adapter host, to accept the 
Application Monitor SNMP traps, adapt them to Patrol EM Events and forward them 
to a Patrol EM Server. The supported platforms for this system are:

• Windows 2000

• Sun Solaris

• IBM AIX

• HP-UX

For the recommended configuration, this system should no be running any other 
SNMP agent on UDP port 162 that would interfere with running the Cyanea 
SNMP Adapter. This system should also have the Java™ runtime version 1.3 (JRE 
1.3) or later installed.

Configuring BMC Patrol

Cyanea for Patrol Enterprise Manager provides a customized filter for Patrol EM and 
the Cyanea SNMP Adapter to have alerts from Cyanea appear in the Patrol EM Active 
Alert Display. 

Cyanea for Patrol Enterprise Manager is available from Cyanea on CD-ROM, or as 
cyanea.tar, or cyanea.zip. Cyanea for Patrol EM consists of the following files:

• cyaneafilter.tar

• CyaneaTrapReceiver.jar

• cyanea.conf

• cyaneaSnmpAdapter.sh (for Unix systems)

• cyaneaSnmpAdapter.bat (for Windows systems)
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Once these files have been extracted from the CD, tar file, or zip file, copy the files to 
location(s) accessible by the Patrol EM server and the Cyanea SNMP Adapter host.

Configuring Patrol EM Server

The Cyanea events are described for Patrol EM in the filter file CYANEA.afltr. 
Installing and configuring this filter consists of the following steps:

• Generating the CYANEA filter engine

• Defining the CYANEA filter path

The Multi-Listener - PEM TCP/IP multi-listener daemon must be installed and 
configured before executing the following steps. Follow the instructions provided in 
the Multi-Listener documentation to specify a socket number that the filter path will 
be monitoring. 

Generating the CYANEA Filter Engine

1. Login to the Patrol EM server as user NetCmmnd.

2. Extract the contents of the file cyaneafilter.tar:

tar xvf cyaneafilter.tar

3. Using the Patrol M Console, generate the CYANEA filter engine. 

4. Select Customization > ALFE.

Figure 36. Path Definition

5. Select NetCmmnd.fltr. 

Figure 37. Select Filter

6. The ALFE dialog window displays with the NetCmmnd filter loaded.
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Figure 38. ALFE Netcmmnd

7. Select File > Load Text Filter, then select CYANEA.afltr.
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Figure 39. Select Load Text Filter

8. The ALFE dialog window displays with the CYANEA filter loaded. 
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Figure 40. Cyanea Filter

9. Select Generate > Generate Production Filter.
 Appendix B.   BMC Patrol Integration  141



 

Figure 41. Generate Production Filter

10. When the system generates the filter, the message "Filter engine generated" 
displays in the Prompter box.

Figure 42. Prompter box

11. Select File > Save.
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Figure 43. Save Filter

12. After the system saves the filter the message 
"/home/u/NetCmmnd/CYANEA.fltr saved" displays in the Prompter box. 
Close the ALFE window.

Defining the CYANEA Filter Path

1. Using the Patrol M Console, define the CYANEA filter path.

2. Select Customization > Path Definition.
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Figure 44. Path Definition

3. The Path Definition dialog window opens. 

Figure 45. Path Definition Dialog box

4. To create the CYANEA path, select Path > New. 
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Figure 46. Create Cyanea Path

5. Enter "CYANEA" for the path name. 

Figure 47. Enter Cyanea Path Name

6. Left-click on the Filter icon and select multi_lstn for the Path Prototype. 

Figure 48. Path Prototype

7. The multi-lstn path prototype defines the path attributes.
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Figure 49. Path Attributes

8. Set the required path attributes to the following values: Autostart = true; Filter = 
CYANEA; Host ID = name of your Patrol EM server; The attributes "URM files 
size" and "URM filename" are optional. 

9. Attribute values are set by selecting the attribute in the Available Attributes box, 
typing in or selecting the desired value in the Attribute Details box, then 
selecting the Add/Replace button. The completed path definition displays in the 
Path Definition dialog window. 
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Figure 50. Path Definition

10. Select Path > Save to DB.

Figure 51. Save to database

11. Select Yes to update the configuration.

Figure 52. Update Configuration

12. Exit from the Path Definition dialog window. 

13. Using the Patrol EM Console, obtain the configuration: Select Admin > Obtain 
Configuration. 
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Figure 53. Obtain Configuration

14. Verify that the CYANEA filter path is running by selecting FIlter Path Mgmt from 
the Patrol EM Console’s Admin menu. The Filter Path Management dialog 
window displays. The CYANEA path should be listed in the Active Filter Paths 
box. 

Figure 54. Filter Path Management

Installing and Configuring the Cyanea SNMP Adapter

As noted in the Requirements section, the Cyanea SNMP Adapter can be run on any 
system that has connectivity to the Application Monitor agent and the Patrol EM 
server. The Java runtime version 1.3 or later must be installed on the system and be 
included in the PATH environment variable. 
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Cyanea SNMP Adapter Installation and Configuration on a Windows platform:

1. Copy the following files to a directory on the Windows platform:

Note:  These files need to be in the same directory.

• CyaneaTrapReceiver.jar

• cyanea.conf

• cyaneaSnmpAdapter.bat (for Windows systems)

2. Edit the cyanea.conf file to specify the following items:

• Patrol EM server name

• Socket number that you configured for the CYANEA filter path

• SNMP port number

########################################################################
# cyanea.conf

#

# DESCRIPTION: Cyanea BMC Patrol EM Adapter Configuration

#

# The configuration entries are as follows:

# 

# PEM_HOST       >Name of Patrol EM server

# PEM_SOCKET   >Socket on Patrol EM server to receive Cyanea trap data 

# SNMP_PORT     >Port number to listen for incoming SNMP trap on

#

# Copyright (c) 2003 by Cyanea Systems Corp.  ALL RIGHTS RESERVED.

########################################################################

3. Navigate to the directory containing the Cyanea SNMP Adapter files.

4. Start the Cyanea SNMP Adapter by entering the following command at a DOS 
prompt:

> cyaneaSnmpAdapter.bat

The Cyanea SNMP Adapter will begin listening for SNMP traps on the port specified 
in the cyanea.conf file. Error messages will be generated and output to standard out if 
any problems occur in receiving and decoding the Cyanea SNMP traps. The error 
output can be redirected to a log file if desired by starting the Cyanea SNMP Adapter 
with the following command:

> cyaneaSnmpAdapter.bat > cyanea.log

Cyanea SNMP Adapter Installation and Configuration on a Unix platform:

1. On the Unix platform, extract the Cyanea SNMP Adapter files from cyanea.tar: 

tar xvf cyanea.tar

Extract the files to the /home/u/NetCmmnd directory. If desired, you may move 
the files to another directory, but all of the Cyanea SNMP Adapter files must be in 
the same directory. 

2. Edit the cyanea.conf file as described above.

3. Login as "root", and execute the following command: 

./cyaneaSnmpAdapter.sh > cyanea.log &
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This will start the Cyanea SNMP Adapter running in the background. The system 
will output any error messages to the file cyanea.log. 

Using Patrol EM with the Application Monitor 

Configure the Cyanea agent to send SNMP traps to the configured Cyanea SNMP 
Adapter hose, and Cyanea events will show up in the Patrol EM Active Alert Display. 

Figure 55. Active Alert Display

Click on an event and select Actions > About to view more information about the 
selected event.

Figure 56. Select About window

The details for the event display in the Stored Token box of the About window. 
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Figure 57. About window
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Appendix C. Port Consolidator

The port consolidator is used to reduce network resources. Typically, it’s used in the 
firewall environment. The following shows one deployment scenario:

Note:  All Data Collectors and port consolidators are installed on the same physical 
machine. 

P

Figure 58. Port Consolidator deployment scenario

Manual Installation

In the normal case, the port consolidator is installed at  the same physical machine as 
the Data Collector. 

Here <CYANEA_HOME> is the same as the Data Collector’s <CYANEA_HOME>. 
There are four subdirectories under <CYANEA_HOME>. They are lib, bin, etc, logs.

<CYANEA_HOME/lib contains the required jar files.

WebSphere: 
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<CYANEA_HOME>/lib 

common.jar, cyaneaaux.jar,ppe.proxy.jar

<CYANEA_HOME>/lib/ext

ppe.proxy-intf.jar, ppe.probe.jar, ppe.probe-intf.jar, kernel.common.jar, model.jar

Configuration

Edit <CYANEA_HOME>/bin/proxyserverctrl_ws.sh (or proxyserverctrl_wl.sh) and 
set the following variables:

JAVA_HOME                                                                                     
CYANEA_HOME                                                                             
CYANEA_MS_HOME                                                                             
PROXY_PORT=                                                                          
KERNEL_HOST01                                                                         
KERNEL_HOST02                                                                  
PORT_KERNEL_CODEBASE01                                                    
PORT_KERNEL_CODEBASE02                                                            
PORT_KERNEL_RFS01                                                        
PORT_KERNEL_RFS02

Start/Stop Port Consolidator

Usage: ./proxyserverctrl_ws.sh ( start | stop | forcestop | killall | ping | list | delete 
)

 start - start port consolidator

 stop - stop port consolidator

 forcestop - kill -9 all port consolidator proccesses

 ping - ping port consolidator

 list - list all registered datacollectors

 delete - delete all registered datacollectors

Configuring Data Collector

To enable port consolidator on the Data Collector, add the following properties in 
datacollector.properties:

proxy.host                                                                                
proxy.port

To set java system property java.rmi.server.codebase:

<CYANEA_MS_HOME>=/opt/cyaneaone

<CYANEA_HOME>=/opt/dc

WebSphere:

java.rmi.server.codebase=file://<CYANEA_MS_HOME>/lib/ppe.probe-intf.jar \                                                                                                                                                                                               
file://<CYANEA_MS_HOME>/lib2.1.3/ppe.probe.jar \                                         
file://<CYANEA_MS_HOME>/lib2.1.3/ppe.ws5.jar \      
file://<CYANEA_MS_HOME>/lib/ppe.proxy-intf.jar \                                          
file://<CYANEA_MS_HOME>/lib2.1.3/ppe.proxy.jar \                                          
file://<CYANEA_HOME>/lib/ext/ppe.probe.jar  file://<CYANEA_HOME>/lib/ext/ppe.ws5.jar

To set CLASSPATH:
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Websphere: 

copy ppe.proxy-intf.jar to <CYANEA_HOME/lib/ext
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Appendix D. Manual Installation of the Data Collector

This section describes how to configure the Data Collector for distributed platforms.  

Manually Installing the J2EE Data Collector

This section describes how to manually install the Data Collector for distributed 
platforms.  For instructions on using the graphical installer, see Chapter 
14. “Customization” on page 103.

The process includes installing the Data Collector itself, as well as customizing 
application servers and web servers.

Installing Data Collector Files

Regardless of the application server you are monitoring, there are similar steps for 
manually installing the Data Collector:

• Unpacking the distribution and creating installation directories

• Copying files to the installation directories

• Configuring the Data Collector

Note:  If you are installing Data Collectors to monitor a horizontal application server 
cluster, you must install a distinct Data Collector for each application server in the 
cluster.

Installing Data Collector Files for WebSphere

Follow these procedures for manually installing the Data Collector to monitor 
WebSphere.  

To unpack the distribution and create installation directories:

1. Copy the file MPDCInstall.tar into a temporary directory. 

2. Untar the file MPDCInstall.tar as follows: 

tar xf MPDCInstall.tar

3. Create an installation directory, for example, /opt/cyaneaone. Throughout this 
section, the directory you create will be referred to as <CYANEA_HOME>.

4. Create the following subdirectories under <CYANEA_HOME>:

mkdir etc

mkdir lib

mkdir bin

mkdir logs

mkdir lib/ext

To copy the Data Collector files for WebSphere:

1. Change your working directory to the dc/dc_home subdirectory of the 
temporary directory in which you untarred the MPDCInstall.tar distribution. 

2. Copy the following files to the /<CYANEA_HOME>/lib directory files, as 
described in the following table.
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Note:  Where there are choices among files, choose the file whose name matches 
the version of WebSphere you are monitoring.

   

 

3. Copy the following files to the /<CYANEA_HOME>/lib/ext directory, as 
described in the following table:

Note:  Where there are choices among files, choose the file whose name matches 
the version of WebSphere you are monitoring.

   

 

4. Copy the following files to the /<CYANEA_HOME>/etc directory files, as 
described in the following table:

   

Source File within dc/dc_home/ Destination 
directory

lib/cyanea.bootstrap_was.jar <CYANEA_HOME>
/lib

Source Files within dc/dc_home/ Destination 
directory

lib/ppe.probe.jar

lib/cdn.jar

lib/common.jar

lib/ppe.was_5.jar

<CYANEA_HOME>
/lib/ext

lib/ppe.probe-intf.jar <CYANEA_HOME>
/lib/ext

lib/kernel.common.jar <CYANEA_HOME>
/lib/ext

lib/model.jar <CYANEA_HOME>
/lib/ext

lib/cyaneaaux.jar <CYANEA_HOME>
/lib/ext

For Portal Only - Source Files Destination 
directory

lib/ppe.wps_5.jar <CYANEA_HOME>
/lib

Source file, within dc/dc_home/etc Destination 
directory
 158 Application Monitor:Installation and Customization Guide  



 

5. Copy the appropriate library file from the dc/dc_home/lib directory to the 
/<CYANEA_HOME>/lib directory, and name it appropriately, as described in 
the following table. In addition, copy the library for your JDK.

datacollector.policy

datacollector.properties

version.properties

LogMessages

bcm.properties

For WebSphere 5.1:

was51_servlet.xml

was51_ejb.xml

was51_jndi.xml

was51_jdbc.xml

was51_jmsq.xml

was51_jmst.xml

was51_jmsmqi.xml

was51_jca.xml

For WebSphere 5.0.2 and WebSphere 5.0.2 Portal 

was502_servlet.xml

was502_ejb.xml

was502_jndi.xml

was502_jdbc.xml

was502_jmsq.xml

was502_jmst.xml

was502_jmsmqi.xml

was502_jca.xml

For WebSphere 5.0.2 Portal Only

wps502_authorization.xml

wps502_credentialvault.xml  

wps502_page.xml

wps502_contentaccess.xml

wps502_login.xml

wps502_portlet.xml            

<CYANEA_HOME
>/etc
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Note:  Replace  <JDKversion> with the version number you are using, for 
example, 1.4.x is 14 and 1.3.x is 13.

   

 

Note:  For HP-UX, libcyanea.sl needs execution permission: 

chmod +x libcyanea.sl

To configure the Data Collector:

1. Set the $<KERNEL_HOST01> variable in the datacollector.policy to be the IP 
address or node name of the primary kernel server.

2. Modify the values of the properties defined in datacollector.properties file to 
match those of your Managing Server installation in Chapter 3. The variables 
${KERNEL_HOST01} and ${KERNEL_HOST02} must be set to be the IP address 
or host name of the Managing Server computer, and the ports to whatever values 
you used at the time of the Managing Server installation.  The default values for 
the ports are:    

${PORT_KERNEL_CODEBASE01}  9122

${PORT_KERNEL_CODEBASE02}  9123

${PORT_KERNEL_RFS01}       9120

${PORT_KERNEL_RFS02}       9121

Configuring Application Servers

The following tables provide the configuration settings for a manual installation. 

Configuring WebSphere 5.0.2 Portal on Intel/Linux

These are the recommended application server options for WebSphere 5.0.2 on Linux.

   

Platform Source file, within dc/dc_home/lib Destination file

AIX  libcyanea_was_5_ibm_<JDKversion>_aix.so <CYANEA_HOME>/lib/libcyanea.so

Solaris libcyanea_was_5_hot_<JDKversion>_sunos.so <CYANEA_HOME>/lib/libcyanea.so

HP-UX libcyanea_was_5_hot_<JDKversion>_hp-ux.sl <CYANEA_HOME>/lib/libcyanea.sl

Windows cyanea_was_5_ibm_<JDKversion>_windows.dll <CYANEA_HOME>/lib/cyanea.dll

Linux libcyanea_was_5_ibm_<JDKversion>_linux.so <CYANEA_HOME>/lib/libcyanea.so

Table 8. Application Server Options for WebSphere 5.0.2 Portal on Linux

Entity Settings

Generic JVM 
Arguments

Add the following as arguments to the JVM command line:

Note:  The order the instructions are performed in is important. Please 
follow this order. 

-Xoss2M -Xss1M -
Xbootclasspath/p:<CYANEA_HOME>/lib/cyanea.bootstrap_was.jar -
Xruncyanea

Environment 
Entries

Set the following environment variables:  

LD_LIBRARY_PATH =<CYANEA_HOME>/lib
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Custom 
Properties 
(JVM)

Add the following system properties:

•
java.rmi.server.codebase = 
file://<MS_CYANEA_HOME>/lib3.1/ppe.probe.jar 
file://<MS_CYANEA_HOME>/lib/ppe.probe-intf.jar 
file://<MS_CYANEA_HOME>/lib3.1/ppe.was_5.jar

Where <MS_CYANEA_HOME> is the cyanea home where the 
Managing Server was installed.  For example, /opt/cyaneaone.

•
cyanea.home=<CYANEA_HOME>

•
java.security.policy=<CYANEA_HOME>/etc/datacollector.policy

•
cyanea.nodename=<node name>

•
cyanea.appserver=<application server name>

•
appserver.platform=wps502

•
com.ibm.websphere.classloader.plugin=com.cyanea.bcm.websphere.
BcmPlugin

Custom 
Services

Add a custom service as follows: 

Name: Cyanea Custom Service

Classname: com.cyanea.ws5.ProbeService

Classpath: null

Note:  There is a bug in the Administrative Console that will not allow you 
to type an empty classpath.

Shared Library 
Settings

Modify "WPSlib " Shared Libraries at the node level to include 
ppe.wps_5.jar in the classpath. This can be done through administrative 
console or by modifying libraries.xml at the node level. 

To set it through administrative console go to:

Environment-->Shared libraries-->WPSlib

Add <CYANEA_HOME>/lib/ppe.wps_5.jar to the classpath.

Performance 
Monitoring 
Service

beanModule=X                                                                                               
cacheModule=N                                                                         
connectionPoolModule=H                                                                             
j2cModule=H                                                                                        
jvmRuntimeModule=H                                                                              
orbPerfModule=H                                                                         
servletSessionsModule=H                                                                      
systemModule=M                                                                            
threadPoolModule=H                                                                     
transactionModule=M                                                                          
webAppModule=H                                                                       
webServicesModule=N                                                                                  
wlmModule=M                                                                                                
wsgwModule=N       

Table 8. Application Server Options for WebSphere 5.0.2 Portal on Linux (continued)

Entity Settings
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Configuring WebSphere 5.0.2 Portal on AIX

These are the recommended application server options for WebSphere 5.0.2 on AIX.

   
Table 9. Application Server Options for WebSphere 5.0.2 Portal on AIX

Entity Settings

Generic JVM 
Arguments

Add the following as arguments to the JVM command line:

Note:  The order the instructions are performed in is important. Please 
follow this order. 

-Xbootclasspath/p:<CYANEA_HOME>/lib/cyanea.bootstrap_was.jar -
Xruncyanea -Xgcthreads1 

Environment 
Entries

Set the following environment variables:  

•
_JVM_THREAD_DUMP_BUFFER_SIZE=25000000

•
AIXTHREAD_SCOPE=S

•
AIXTHREAD_MUTEX_DEBUG=OFF

•
AIXTHREAD_COND_DEBUG=OFF

•
AIXTHREAD_RWLOCK_DEBUG=OFF

•
LIBPATH=<CYANEA_HOME>/lib

In order to view thread CPU times, set the following environment variable: 

•
AIXTHREAD_ENRUSG=ON

Custom 
Properties 
(JVM)

Add the following system properties:

•
java.rmi.server.codebase = 
file://<MS_CYANEA_HOME>/lib3.1/ppe.probe.jar 
file://<MS_CYANEA_HOME>/lib/ppe.probe-intf.jar 
file://<MS_CYANEA_HOME>/lib3.1/ppe.was_5.jar

Where <MS_CYANEA_HOME> is the cyanea home where the 
Managing Server was installed.  For example, /opt/cyaneaone.

•
cyanea.home=<CYANEA_HOME>

•
java.security.policy=<CYANEA_HOME>/etc/datacollector.policy

•
cyanea.nodename=<node name>

•
cyanea.appserver=<application server name>

•
appserver.platform=wps502

•
com.ibm.websphere.classloader.plugin=com.cyanea.bcm.websphere.
BcmPlugin
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Custom 
Services

Add a custom service as follows: 

Name: Cyanea Custom Service

Classname: com.cyanea.ws5.ProbeService

Classpath: null

Note:  There is a bug in the Administrative Console that will not allow you 
to type an empty classpath.

Shared Library 
Settings

Modify "WPSlib " Shared Libraries at the node level to include 
ppe.wps_5.jar in the classpath. This can be done through administrative 
console or by modifying libraries.xml at the node level. 

To set it through administrative console go to:

Environment-->Shared libraries-->WPSlib

Add <CYANEA_HOME>/lib/ppe.wps_5.jar to the classpath.

Performance 
Monitoring 
Service

beanModule=X                                                                                               
cacheModule=N                                                                         
connectionPoolModule=H                                                                             
j2cModule=H                                                                                        
jvmRuntimeModule=H                                                                              
orbPerfModule=H                                                                         
servletSessionsModule=H                                                                      
systemModule=M                                                                            
threadPoolModule=H                                                                     
transactionModule=M                                                                          
webAppModule=H                                                                       
webServicesModule=N                                                                                  
wlmModule=M                                                                                                
wsgwModule=N       

Table 9. Application Server Options for WebSphere 5.0.2 Portal on AIX (continued)

Entity Settings
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Configuring WebSphere 5.0.2 Portal on Solaris

These are the recommended application server options for WebSphere 5.0.2 on Solaris.

   
Table 10. Application Server Options for WebSphere 5.0.2 Portal on Solaris

Entity Settings

Generic JVM 
Arguments

Run the JVM in server mode. 

Add the following as arguments to the JVM command line:

Note:  The order the instructions are performed in is important. Please 
follow this order. 

-server -
Xbootclasspath/p:<CYANEA_HOME>/lib/cyanea.bootstrap_was.jar -
Xruncyanea 

Note:  The default NewSize and MaxNewSize might be small for some 
Applications if the Application is allocating large numbers of short living 
objects.

Here are the settings we recommend for an application that allocates many 
short living objects: 

-XX:+DisableExplicitGC -XX:NewSize=128m -XX:MaxNewSize=256m -
Xconcurrentio 

Note:  The arguments NewSize and MaxNewSize should be set based on 
the Maximum and Minimum heap settings of the JVM. 

Custom 
Properties 
(JVM)

Add the following system properties:

•
java.rmi.server.codebase = 
file://<MS_CYANEA_HOME>/lib3.1/ppe.probe.jar 
file://<MS_CYANEA_HOME>/lib/ppe.probe-intf.jar 
file://<MS_CYANEA_HOME>/lib3.1/ppe.was_5.jar

Where <MS_CYANEA_HOME> is the cyanea home where the 
Managing Server was installed.  For example, /opt/cyaneaone.

•
cyanea.home=<CYANEA_HOME>

•
java.security.policy=<CYANEA_HOME>/etc/datacollector.policy

•
cyanea.probe.stdout=<path of application server stdout>

•
cyanea.nodename=<node name>

•
cyanea.appserver=<application server name>

•
appserver.platform=wps502

com.ibm.websphere.classloader.plugin=com.cyanea.bcm.websphere.
BcmPlugin
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Configuring WebSphere 5.0.2 Portal on Windows

These are the recommended application server options for WebSphere 5.0.2 on 
Windows.

   

Custom 
Services

Add a custom service as follows: 

Name: Cyanea Custom Service

Classname: com.cyanea.ws5.ProbeService

Classpath: null

Note:  There is a bug in the Administrative Console that will not allow you 
to type an empty classpath.

Shared Library 
Settings

Modify "WPSlib " Shared Libraries at the node level to include 
ppe.wps_5.jar in the classpath. This can be done through administrative 
console or by modifying libraries.xml at the node level. 

To set it through administrative console go to:

Environment-->Shared libraries-->WPSlib

Add <CYANEA_HOME>/lib/ppe.wps_5.jar to the classpath.

Performance 
Monitoring 
Service 

beanModule=X                                                                                               
cacheModule=N                                                                         
connectionPoolModule=H                                                                             
j2cModule=H                                                                                        
jvmRuntimeModule=H                                                                              
orbPerfModule=H                                                                         
servletSessionsModule=H                                                                      
systemModule=M                                                                            
threadPoolModule=H                                                                     
transactionModule=M                                                                          
webAppModule=H                                                                       
webServicesModule=N                                                                                  
wlmModule=M                                                                                                
wsgwModule=N       

Environment 
Entries 

Set the following environment variables: 

LD_LIBRARY_PATH=<CYANEA_HOME>/lib

Table 11. Application Server Options for WebSphere 5.0.2 Portal on Windows

Entity Settings

Generic JVM 
Arguments

Add the following as arguments to the JVM command line:

Note:  The order the instructions are performed in is important. Please 
follow this order. 

-Xbootclasspath/p:<CYANEA_HOME>/lib/cyanea.bootstrap_was.jar -
Xruncyanea 

Table 10. Application Server Options for WebSphere 5.0.2 Portal on Solaris 

Entity Settings
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Environment 
Entries 

Set the following environment variables:  

_JVM_THREAD_DUMP_BUFFER_SIZE=25000000

PATH=<CYANEA_HOME>\lib

Custom 
Properties 
(JVM)

Add the following system properties:

•
java.rmi.server.codebase = 
file://<MS_CYANEA_HOME>/lib3.1/ppe.probe.jar 
file://<MS_CYANEA_HOME>/lib/ppe.probe-intf.jar 
file://<MS_CYANEA_HOME>/lib3.1/ppe.was_5.jar

Where <MS_CYANEA_HOME> is the directory where the Managing 
Server is installed. For example, /opt/cyaneaone

•
cyanea.home=<CYANEA_HOME>

•
java.security.policy=<CYANEA_HOME>/etc/datacollector.policy

•
cyanea.nodename=<node name>

•
cyanea.appserver=<application server name>

•
appserver.platform=wps502

•
com.ibm.websphere.classloader.plugin=com.cyanea.bcm.websphere.
BcmPlugin

Custom 
Services

Add a custom service as follows: 

Name: Cyanea Custom Service

Classname: com.cyanea.ws5.ProbeService

Classpath: null

Note:  There is a bug in the Administrative Console that will not allow you 
to type an empty classpath.

Shared Library 
Settings

Modify "WPSlib " Shared Libraries at the node level to include 
ppe.wps_5.jar in the classpath. This can be done through administrative 
console or by modifying libraries.xml at the node level. 

To set it through administrative console go to:

Environment-->Shared libraries-->WPSlib

Add <CYANEA_HOME>/lib/ppe.wps_5.jar to the classpath.

Table 11. Application Server Options for WebSphere 5.0.2 Portal on Windows 

Entity Settings
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Configuring WebSphere 5.0.2.6 on Intel/Linux and z/Linux

These are the recommended application server options for WebSphere 5.0.2.6 on 
Intel/Linux and z/Linux.

   

Performance 
Monitoring 
Service 

beanModule=X                                                                                               
cacheModule=N                                                                         
connectionPoolModule=H                                                                             
j2cModule=H                                                                                        
jvmRuntimeModule=H                                                                              
orbPerfModule=H                                                                         
servletSessionsModule=H                                                                      
systemModule=M                                                                            
threadPoolModule=H                                                                     
transactionModule=M                                                                          
webAppModule=H                                                                       
webServicesModule=N                                                                                  
wlmModule=M                                                                                                
wsgwModule=N       

Table 12. Application Server Options for WebSphere 5.0.2.6 on Intel/Linux and 
z/Linux

Entity Settings

Generic JVM 
Arguments

Add the following as arguments to the JVM command line:

Note:  The order the instructions are performed in is important. Please 
follow this order. 

-Xoss2M -Xss1M -
Xbootclasspath/p:<CYANEA_HOME>/lib/cyanea.bootstrap_was.jar -
Xruncyanea

Environment 
Entries

Set the following environment variables:  

LD_LIBRARY_PATH =<CYANEA_HOME>/lib

Table 11. Application Server Options for WebSphere 5.0.2 Portal on Windows 

Entity Settings
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Custom 
Properties 
(JVM)

Add the following system properties:

•
java.rmi.server.codebase = 
file://<MS_CYANEA_HOME>/lib3.1/ppe.probe.jar 
file://<MS_CYANEA_HOME>/lib/ppe.probe-intf.jar 
file://<MS_CYANEA_HOME>/lib3.1/ppe.was_5.jar

Where <MS_CYANEA_HOME> is the cyanea home where the 
Managing Server was installed.  For example, /opt/cyaneaone.

•
cyanea.home=<CYANEA_HOME>

•
java.security.policy=<CYANEA_HOME>/etc/datacollector.policy

•
cyanea.nodename=<node name>

•
cyanea.appserver=<application server name>

•
appserver.platform=was502

• Optional if you are using MQ:

cyanea.ext.dirs=<MQ HOME>/lib

Custom 
Services

Add a custom service as follows: 

Name: Cyanea Custom Service

Classname: com.cyanea.ws5.ProbeService

Classpath: null

Note:  There is a bug in the Administrative Console that will not allow you 
to type an empty classpath.

Performance 
Monitoring 
Service

beanModule=X                                                                                               
cacheModule=N                                                                         
connectionPoolModule=H                                                                             
j2cModule=H                                                                                        
jvmRuntimeModule=H                                                                              
orbPerfModule=H                                                                         
servletSessionsModule=H                                                                      
systemModule=M                                                                            
threadPoolModule=H                                                                     
transactionModule=M                                                                          
webAppModule=H                                                                       
webServicesModule=N                                                                                  
wlmModule=M                                                                                                
wsgwModule=N       

Table 12. Application Server Options for WebSphere 5.0.2.6 on Intel/Linux and 
z/Linux (continued)

Entity Settings
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Configuring WebSphere 5.0.2.6 on AIX

These are the recommended application server options for WebSphere 5.0.2.6 on AIX.

   
Table 13. Application Server Options for WebSphere 5.0.2.6 on AIX

Entity Settings

Generic JVM 
Arguments

Add the following as arguments to the JVM command line:

Note:  The order the instructions are performed in is important. Please 
follow this order. 

-Xbootclasspath/p:<CYANEA_HOME>/lib/cyanea.bootstrap_was.jar -
Xruncyanea -Xgcthreads1 

Environment 
Entries

Set the following environment variables:  

•
_JVM_THREAD_DUMP_BUFFER_SIZE=25000000

•
AIXTHREAD_SCOPE=S

•
AIXTHREAD_MUTEX_DEBUG=OFF

•
AIXTHREAD_COND_DEBUG=OFF

•
AIXTHREAD_RWLOCK_DEBUG=OFF

•
LIBPATH=<CYANEA_HOME>/lib

In order to view thread CPU times, set the following environment variable: 

•
AIXTHREAD_ENRUSG=ON

Custom 
Properties 
(JVM)

Add the following system properties:

•
java.rmi.server.codebase = 
file://<MS_CYANEA_HOME>/lib3.1/ppe.probe.jar 
file://<MS_CYANEA_HOME>/lib/ppe.probe-intf.jar 
file://<MS_CYANEA_HOME>/lib3.1/ppe.was_5.jar

Where <MS_CYANEA_HOME> is the cyanea home where the 
Managing Server was installed.  For example, /opt/cyaneaone.

•
cyanea.home=<CYANEA_HOME>

•
java.security.policy=<CYANEA_HOME>/etc/datacollector.policy

•
cyanea.nodename=<node name>

•
cyanea.appserver=<application server name>

•
appserver.platform=was502

• Optional if you are using MQ:

cyanea.ext.dirs=<MQ HOME>/lib
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Configuring WebSphere 5.0.2.6 on Solaris

These are the recommended application server options for WebSphere 5.0.2.6 on 
Solaris.

   

Custom 
Services

Add a custom service as follows: 

Name: Cyanea Custom Service

Classname: com.cyanea.ws5.ProbeService

Classpath: null

Note:  There is a bug in the Administrative Console that will not allow you 
to type an empty classpath.

Performance 
Monitoring 
Service

beanModule=X                                                                                               
cacheModule=N                                                                         
connectionPoolModule=H                                                                             
j2cModule=H                                                                                        
jvmRuntimeModule=H                                                                              
orbPerfModule=H                                                                         
servletSessionsModule=H                                                                      
systemModule=M                                                                            
threadPoolModule=H                                                                     
transactionModule=M                                                                          
webAppModule=H                                                                       
webServicesModule=N                                                                                  
wlmModule=M                                                                                                
wsgwModule=N       

Table 14. Application Server Options for WebSphere 5.0.2.6 on Solaris

Entity Settings

Generic JVM 
Arguments

Run the JVM in server mode. 

Add the following as arguments to the JVM command line:

Note:  The order the instructions are performed in is important. Please 
follow this order. 

-server -
Xbootclasspath/p:<CYANEA_HOME>/lib/cyanea.bootstrap_was.jar -
Xruncyanea 

Note:  The default NewSize and MaxNewSize might be small for some 
Applications if the Application is allocating large numbers of short living 
objects.

Here are the settings we recommend for an application that allocates many 
short living objects: 

-XX:+DisableExplicitGC -XX:NewSize=128m -XX:MaxNewSize=256m -
Xconcurrentio 

Note:  The arguments NewSize and MaxNewSize should be set based on 
the Maximum and Minimum heap settings of the JVM. 

Table 13. Application Server Options for WebSphere 5.0.2.6 on AIX (continued)

Entity Settings
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Custom 
Properties 
(JVM)

Add the following system properties:

•
java.rmi.server.codebase = 
file://<MS_CYANEA_HOME>/lib3.1/ppe.probe.jar 
file://<MS_CYANEA_HOME>/lib/ppe.probe-intf.jar 
file://<MS_CYANEA_HOME>/lib3.1/ppe.was_5.jar

Where <MS_CYANEA_HOME> is the cyanea home where the 
Managing Server was installed.  For example, /opt/cyaneaone.

•
cyanea.home=<CYANEA_HOME>

•
java.security.policy=<CYANEA_HOME>/etc/datacollector.policy

•
cyanea.probe.stdout=<path of application server stdout>

•
cyanea.nodename=<node name>

•
cyanea.appserver=<application server name>

•
appserver.platform=was502

• Optional if you are using MQ:

cyanea.ext.dirs=<MQ HOME>/lib

Custom 
Services

Add a custom service as follows: 

Name: Cyanea Custom Service

Classname: com.cyanea.ws5.ProbeService

Classpath: null

Note:  There is a bug in the Administrative Console that will not allow you 
to type an empty classpath.

Performance 
Monitoring 
Service 

beanModule=X                                                                                               
cacheModule=N                                                                         
connectionPoolModule=H                                                                             
j2cModule=H                                                                                        
jvmRuntimeModule=H                                                                              
orbPerfModule=H                                                                         
servletSessionsModule=H                                                                      
systemModule=M                                                                            
threadPoolModule=H                                                                     
transactionModule=M                                                                          
webAppModule=H                                                                       
webServicesModule=N                                                                                  
wlmModule=M                                                                                                
wsgwModule=N       

Environment 
Entries 

Set the following environment variables: 

LD_LIBRARY_PATH=<CYANEA_HOME>/lib

Table 14. Application Server Options for WebSphere 5.0.2.6 on Solaris (continued)
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Configuring WebSphere 5.0.2.6 on HP-UX

These are the recommended application server options for WebSphere 5.0.2.6  on HP-
UX.

   
Table 15. Application Server Options for WebSphere 5.0.2.6 on HP-UX

Entity Settings

Generic JVM 
Arguments

Add the following as arguments to the JVM command line:

Note:  The order the instructions are performed in is important. Please 
follow this order. 

-Xbootclasspath/p:<CYANEA_HOME>/lib/cyanea.bootstrap_was.jar -
Xruncyanea 

Note:  The default NewSize and MaxNewSize might be small for some 
Applications if the Application is allocating large numbers of short living 
objects. 

Some tuning we recommend for an application that allocates many short 
living objects: 

-XX:+DisableExplicitGC -XX:NewSize=128m -XX:MaxNewSize=256m -
Xconcurrentio

Note:  NewSize and MaxNewSize should be changed based on the 
Maximum and Minimum heap settings of the JVM.

Custom 
Properties 
(JVM)

Add the following system properties:

•
java.rmi.server.codebase = 
file://<MS_CYANEA_HOME>/lib3.1/ppe.probe.jar 
file://<MS_CYANEA_HOME>/lib/ppe.probe-intf.jar 
file://<MS_CYANEA_HOME>/lib3.1/ppe.was_5.jar

Where <MS_CYANEA_HOME> is the cyanea home where the 
Managing Server was installed.  For example, /opt/cyaneaone.

•
java.security.policy=<CYANEA_HOME>/etc/datacollector.policy

•
cyanea.probe.stdout=<path of application server stdout>

•
cyanea.home=<CYANEA_HOME>

•
cyanea.nodename=<node name>

•
cyanea.appserver=<application server name>

•
appserver.platform=was502

• Optional if you are using MQ:

cyanea.ext.dirs=<MQ HOME>/lib
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Configuring WebSphere 5.0.2.6 on Windows

These are the recommended application server options for WebSphere 5.0.2.6 on 
Windows.

   

Custom 
Services

Add a custom service as follows: 

Name: Cyanea Custom Service

Classname: com.cyanea.ws5.ProbeService

Classpath: null

Note:  There is a bug in the Administrative Console that will not allow you 
to type an empty classpath.

Performance 
Monitoring 
Service 

beanModule=X                                                                                               
cacheModule=N                                                                         
connectionPoolModule=H                                                                             
j2cModule=H                                                                                        
jvmRuntimeModule=H                                                                              
orbPerfModule=H                                                                         
servletSessionsModule=H                                                                      
systemModule=M                                                                            
threadPoolModule=H                                                                     
transactionModule=M                                                                          
webAppModule=H                                                                       
webServicesModule=N                                                                                  
wlmModule=M                                                                                                
wsgwModule=N       

Environment 
Entries

Set the following environment variables: 

SHLIB_PATH=<CYANEA_HOME>/lib

cyanea.home=<CYANEA_HOME>

cyanea.nodename=<node name>

cyanea.appserver=<application server name>

appserver.platform=was502

Optional if you are using MQ:

cyanea.ext.dirs=<MQ HOME>/lib

Table 16. Application Server Options for WebSphere 5.0.2.6 on Windows

Entity Settings

Generic JVM 
Arguments

Add the following as arguments to the JVM command line:

Note:  The order the instructions are performed in is important. Please 
follow this order. 

-Xbootclasspath/p:<CYANEA_HOME>/lib/cyanea.bootstrap_was.jar -
Xruncyanea 

Table 15. Application Server Options for WebSphere 5.0.2.6 on HP-UX (continued)
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Environment 
Entries 

Set the following environment variables:  

_JVM_THREAD_DUMP_BUFFER_SIZE=25000000

PATH=<CYANEA_HOME>\lib

Custom 
Properties 
(JVM)

Add the following system properties:

•
java.rmi.server.codebase = 
file://<MS_CYANEA_HOME>/lib3.1/ppe.probe.jar 
file://<MS_CYANEA_HOME>/lib/ppe.probe-intf.jar 
file://<MS_CYANEA_HOME>/lib3.1/ppe.was_5.jar

Where <MS_CYANEA_HOME> is the directory where the Managing 
Server is installed. For example, /opt/cyaneaone

•
cyanea.home=<CYANEA_HOME>

•
java.security.policy=<CYANEA_HOME>/etc/datacollector.policy

•
cyanea.nodename=<node name>

•
cyanea.appserver=<application server name>

•
appserver.platform=was502

• Optional if you are using MQ:

cyanea.ext.dirs=<MQ HOME>/lib

Custom 
Services

Add a custom service as follows: 

Name: Cyanea Custom Service

Classname: com.cyanea.ws5.ProbeService

Classpath: null

Note:  There is a bug in the Administrative Console that will not allow you 
to type an empty classpath.

Performance 
Monitoring 
Service 

beanModule=X                                                                                               
cacheModule=N                                                                         
connectionPoolModule=H                                                                             
j2cModule=H                                                                                        
jvmRuntimeModule=H                                                                              
orbPerfModule=H                                                                         
servletSessionsModule=H                                                                      
systemModule=M                                                                            
threadPoolModule=H                                                                     
transactionModule=M                                                                          
webAppModule=H                                                                       
webServicesModule=N                                                                                  
wlmModule=M                                                                                                
wsgwModule=N       

Table 16. Application Server Options for WebSphere 5.0.2.6 on Windows (continued)
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Configuring WebSphere 5.1.1 on AIX

These are the recommended application server options for WebSphere 5.1.1 on AIX.

Note:  Clean $WAS_ROOT/logs/preload prior to a new installation.

   
Table 17. Application Server Options for WebSphere 5.1.1 on AIX

Entity Settings

Generic JVM 
Arguments

Add the following as arguments to the JVM command line:

-Xbootclasspath/p:<CYANEA_HOME>/lib/cyanea.bootstrap_was.jar-
Xruncyanea

Environment 
Entries

Set the following environment variables:  

•
_JVM_THREAD_DUMP_BUFFER_SIZE=25000000

•
AIXTHREAD_SCOPE=S

•
AIXTHREAD_MUTEX_DEBUG=OFF

•
AIXTHREAD_COND_DEBUG=OFF

•
AIXTHREAD_RWLOCK_DEBUG=OFF

•
LIBPATH=<CYANEA_HOME>/lib

In order to view thread CPU times, set the following environment variable: 

•
AIXTHREAD_ENRUSG=ON

Custom 
Properties 
(JVM)

Add the following system properties:

•
java.rmi.server.codebase = 
file://<MS_CYANEA_HOME>/lib3.1/ppe.probe.jar 
file://<MS_CYANEA_HOME>/lib/ppe.probe-intf.jar 
file://<MS_CYANEA_HOME>/lib3.1/ppe.was_5.jar

Where <MS_CYANEA_HOME> is the cyanea home where the 
Managing Server was installed.  For example, /opt/cyaneaone.

•
cyanea.home=<CYANEA_HOME>

•
java.security.policy=<CYANEA_HOME>/etc/datacollector.policy

•
cyanea.nodename=<node name>

•
cyanea.appserver=<application server name>

•
appserver.platform=was511

• Optional if you are using MQ:

cyanea.ext.dirs=<MQ HOME>/lib
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Configuring WebSphere 5.1.1 on Intel/Linux and z/Linux

These are the recommended application server options for WebSphere 5.1.1 on 
Intel/Linux and z/Linux.

   

Custom 
Services

Add a custom service as follows: 

Name: Cyanea Custom Service

Classname: com.cyanea.ws5.ProbeService

Classpath: null

Note:  There is a bug in the Administrative Console that will not allow you 
to type an empty classpath. 

Performance 
Monitoring 
Service 

beanModule=X                                                                                               
cacheModule=N                                                                         
connectionPoolModule=H                                                                             
j2cModule=H                                                                                        
jvmRuntimeModule=H                                                                              
orbPerfModule=H                                                                         
servletSessionsModule=H                                                                      
systemModule=M                                                                            
threadPoolModule=H                                                                     
transactionModule=M                                                                          
webAppModule=H                                                                       
webServicesModule=N                                                                                  
wlmModule=M                                                                                                
wsgwModule=N       

Table 18. Application Server Options for WebSphere 5.1.1 on Intel/Linux and 
z/Linux

Entity Settings

Generic JVM 
Arguments

Add the following as arguments to the JVM command line:

-Xoss2M -Xss1M -
Xbootclasspath/p:<CYANEA_HOME>/lib/cyanea.bootstrap_was.jar -
Xruncyanea

<CYANEA_HOME> = Cyanea installation directory

Environment 
Entries

Set the following environment variables:  

•
LD_LIBRARY_PATH =<CYANEA_HOME>/lib

Table 17. Application Server Options for WebSphere 5.1.1 on AIX (continued)
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Custom 
Properties 
(JVM)

Add the following system properties:

•
java.rmi.server.codebase = 
file://<MS_CYANEA_HOME>/lib3.1/ppe.probe.jar 
file://<MS_CYANEA_HOME>/lib/ppe.probe-intf.jar 
file://<MS_CYANEA_HOME>/lib3.1/ppe.was_5.jar

Where <MS_CYANEA_HOME> is the cyanea home where the 
Managing Server was installed.  For example, /opt/cyaneaone.

•
cyanea.home=<CYANEA_HOME>

•
java.security.policy=<CYANEA_HOME>/etc/datacollector.policy

•
cyanea.nodename=<node name>

•
cyanea.appserver=<application server name>

•
appserver.platform=was511

Note:  Clean $WAS_ROOT/logs/preload prior to a new installation.

• Optional if you are using MQ:

cyanea.ext.dirs=<MQ HOME>/lib

Custom 
Services

Add a custom service as follows: 

Name: Cyanea Custom Service

Classname: com.cyanea.ws5.ProbeService

Classpath:null

Note:  There is a bug in the Administrative Console that will not allow you 
to type an empty classpath. 

Performance 
Monitoring 
Service 

beanModule=X                                                                                               
cacheModule=N                                                                         
connectionPoolModule=H                                                                             
j2cModule=H                                                                                        
jvmRuntimeModule=H                                                                              
orbPerfModule=H                                                                         
servletSessionsModule=H                                                                      
systemModule=M                                                                            
threadPoolModule=H                                                                     
transactionModule=M                                                                          
webAppModule=H                                                                       
webServicesModule=N                                                                                  
wlmModule=M                                                                                                
wsgwModule=N       

Table 18. Application Server Options for WebSphere 5.1.1 on Intel/Linux and 
z/Linux (continued)
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Configuring WebSphere 5.1.1 on Solaris

These are the recommended application server options for WebSphere 5.1.1 on Solaris.

   
Table 19. Application Server Options for WebSphere 5.1.1 on Solaris

Entity Settings

Generic JVM 
Arguments

Run the JVM in server mode. 

Add the following as arguments to the JVM command line:

Note:  The order in which the options are specified is important. Please 
follow this order. 

-server -
Xbootclasspath/p:<CYANEA_HOME>/lib/cyanea.bootstrap_was.jar -
Xruncyanea

 

Note:  The default NewSize and MaxNewSize might be small for some 
Applications if the Application is allocating large numbers of short living 
objects.

Here are the settings we recommend for an application that allocates many 
short living objects: 

-XX:+DisableExplicitGC -XX:NewSize=128m -XX:MaxNewSize=256m -
Xconcurrentio 

Note:  The arguments NewSize and MaxNewSize should be set based on 
the Maximum and Minimum heap settings of the JVM. 

Custom 
Properties 
(JVM)

Add the following system properties:

•
java.rmi.server.codebase = 
file://<MS_CYANEA_HOME>/lib3.1/ppe.probe.jar 
file://<MS_CYANEA_HOME>/lib/ppe.probe-intf.jar 
file://<MS_CYANEA_HOME>/lib3.1/ppe.was_5.jar

Where <MS_CYANEA_HOME> is the cyanea home where the 
Managing Server was installed.  For example, /opt/cyaneaone.

•
cyanea.home=<CYANEA_HOME>

•
java.security.policy=<CYANEA_HOME>/etc/datacollector.policy

•
cyanea.probe.stdout=<path of application server stdout>

•
cyanea.nodename=<node name>

•
cyanea.appserver=<application server name>

•
appserver.platform=was511 

Note:  Clean $WAS_ROOT/logs/preload prior to a new installation.

• Optional if you are using MQ:

cyanea.ext.dirs=<MQ HOME>/lib
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Configuring WebSphere 5.1.1 on HP-UX

These are the recommended application server options for WebSphere 5.1.1 on HP-
UX.

   

Custom 
Services

Add a custom service as follows: 

Name: Cyanea Custom Service

Classname: com.cyanea.ws5.ProbeService

Classpath: null

Note:  There is a bug in the Administrative Console that will not allow you 
to type an empty classpath. 

Performance 
Monitoring 
Service 

beanModule=X                                                                                               
cacheModule=N                                                                         
connectionPoolModule=H                                                                             
j2cModule=H                                                                                        
jvmRuntimeModule=H                                                                              
orbPerfModule=H                                                                         
servletSessionsModule=H                                                                      
systemModule=M                                                                            
threadPoolModule=H                                                                     
transactionModule=M                                                                          
webAppModule=H                                                                       
webServicesModule=N                                                                                  
wlmModule=M                                                                                                
wsgwModule=N       

Environment 
Entries

Set the following environment variables: 

LD_LIBRARY_PATH=<CYANEA_HOME>/lib

Table 20. Application Server Options for WebSphere 5.1.1 on HP-UX

Entity Settings

Generic JVM 
Arguments

Add the following as arguments to the JVM command line:

-Xbootclasspath/p:<CYANEA_HOME>/lib/cyanea.bootstrap_was.jar -
Xruncyanea

Note:  The default NewSize and MaxNewSize might be small for some 
Applications if the Application is allocating large numbers of short living 
objects. 

Some tuning we recommend for an application that allocates many short 
living objects: 

-XX:+DisableExplicitGC -XX:NewSize=128m -XX:MaxNewSize=256m -
Xconcurrentio

Note:  NewSize and MaxNewSize should be changed based on the 
Maximum and Minimum heap settings of the JVM.

Table 19. Application Server Options for WebSphere 5.1.1 on Solaris (continued)
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Custom 
Properties 
(JVM)

Add the following system properties:

•
java.rmi.server.codebase = 
file://<MS_CYANEA_HOME>/lib3.1/ppe.probe.jar 
file://<MS_CYANEA_HOME>/lib/ppe.probe-intf.jar 
file://<MS_CYANEA_HOME>/lib3.1/ppe.was_5.jar

Where <MS_CYANEA_HOME> is the cyanea home where the 
Managing Server was installed.  For example, /opt/cyaneaone.

•
java.security.policy=<CYANEA_HOME>/etc/datacollector.policy

•
cyanea.probe.stdout=<path of application server stdout>

•
cyanea.home=<CYANEA_HOME>

•
cyanea.nodename=<node name>

•
cyanea.appserver=<application server name>

•
appserver.platform=was511

• Optional if you are using MQ:

cyanea.ext.dirs=<MQ HOME>/lib

Custom 
Services

Add a custom service as follows: 

Name: Cyanea Custom Service

Classname: com.cyanea.ws5.ProbeService

Classpath: null

Note:  There is a bug in the Administrative Console that will not allow you 
to type an empty classpath. 

Performance 
Monitoring 
Service 

beanModule=X                                                                                               
cacheModule=N                                                                         
connectionPoolModule=H                                                                             
j2cModule=H                                                                                        
jvmRuntimeModule=H                                                                              
orbPerfModule=H                                                                         
servletSessionsModule=H                                                                      
systemModule=M                                                                            
threadPoolModule=H                                                                     
transactionModule=M                                                                          
webAppModule=H                                                                       
webServicesModule=N                                                                                  
wlmModule=M                                                                                                
wsgwModule=N       

Table 20. Application Server Options for WebSphere 5.1.1 on HP-UX (continued)
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Configuring WebSphere 5.1.1 on Windows

These are the recommended application server options for WebSphere 5.1.1 on 
Windows.

   

Environment 
Entries

Set the following environment variables: 

SHLIB_PATH=<CYANEA_HOME>/lib

cyanea.home=<CYANEA_HOME>

cyanea.nodename=<node name>

cyanea.appserver=<application server name>

appserver.platform=was511

Optional if you are using MQ:

cyanea.ext.dirs=<MQ HOME>/lib

Table 21. Application Server Options for WebSphere 5.1.1 on Windows

Entity Settings

Generic JVM 
Arguments

Add the following as arguments to the JVM command line:

-Xbootclasspath/p:<CYANEA_HOME>/lib/cyanea.bootstrap_was.jar -
Xruncyanea

Environment 
Entries 

Set the following environment variables:  

_JVM_THREAD_DUMP_BUFFER_SIZE=25000000

PATH=<CYANEA_HOME>\lib

Table 20. Application Server Options for WebSphere 5.1.1 on HP-UX (continued)
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Custom 
Properties 
(JVM)

Add the following system properties:

•
java.rmi.server.codebase = 
file://<MS_CYANEA_HOME>/lib3.1/ppe.probe.jar 
file://<MS_CYANEA_HOME>/lib/ppe.probe-intf.jar 
file://<MS_CYANEA_HOME>/lib3.1/ppe.was_5.jar

Where <MS_CYANEA_HOME> is the directory where the Managing 
Server is installed. For example, \opt\cyaneaone

•
cyanea.home=<CYANEA_HOME>

•
java.security.policy=<CYANEA_HOME>\etc\datacollector.policy

•
cyanea.nodename=<node name>

•
cyanea.appserver=<application server name>

•
appserver.platform=was511 

Note:  Clean $WAS_ROOT/logs/preload prior to a new installation.

• Optional if you are using MQ:

cyanea.ext.dirs=<MQ HOME>/lib

Custom 
Services

Add a custom service as follows: 

Name: Cyanea Custom Service

Classname: com.cyanea.ws5.ProbeService

Classpath: null

Note:  There is a bug in the Administrative Console that will not allow you 
to type an empty classpath. 

Performance 
Monitoring 
Service 

beanModule=X                                                                                               
cacheModule=N                                                                         
connectionPoolModule=H                                                                             
j2cModule=H                                                                                        
jvmRuntimeModule=H                                                                              
orbPerfModule=H                                                                         
servletSessionsModule=H                                                                      
systemModule=M                                                                            
threadPoolModule=H                                                                     
transactionModule=M                                                                          
webAppModule=H                                                                       
webServicesModule=N                                                                                  
wlmModule=M                                                                                                
wsgwModule=N       

Table 21. Application Server Options for WebSphere 5.1.1 on Windows (continued)
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 182 Application Monitor:Installation and Customization Guide  



Appendix E. Setting up an HTTP Server with your Managing 
Server

It is recommended that you use a HTTP Web server to access the Managing Server 
front end running on WebSphere Application Server. If you choose to use IBM HTTP 
Server (IHS) version 1.3, verify the following: 

1. Please make sure, that the IHS installation program has appended the following 
two lines to the Web server configuration file httpd.conf  

LoadModule ibm_app_server_http_module \ 
<WAS_HOME>/bin/mod_ibm_app_server_http.so                      
WebSpherePluginConfig <WAS_HOME>/config/cells/plugin-cfg.xml

where <WAS_HOME> is your WebSphere 5.1 installation directory.  The 
configuration file httpd.conf usually gets installed in directory 
/usr/HTTPServer/conf or /opt/IBMHTTPServer/conf, but that varies 
depending on the conventions used at your site.

2. If the Web server is not configured to listen to the default port (80), you will need 
to specify the appropriate port number in the Managing Server front end access 
URL (e.g. http://<hostname>:90/cyanea_one/home for port 90).  If you wish to 
access the front end at the default port (80), you need to verify that the Web server 
is listening at the default port.  The ports are defined by two IHS runtime 
directives 

Port 80

Listen 80

in the httpd.conf file.  Once the plug-in and port configurations for IHS are 
correct, you may access the front end without any port specification in the URL 
(e.g. http://<hostname/cyanea_one/home).

3. For further information on configuring IHS, please refer to IBM documentation at 
http://publib.boulder.ibm.com/infocenter/wasinfo/index.jsp?topic=/com.ibm.
websphere.base.doc/info/aes/ae/tins_webserver.html. 
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Appendix F. Notices

This information was developed for products and services offered in the U.S.A.  IBM 
may not offer the products, services, or features discussed in this document in other 
countries. Consult your local IBM representative for information on the products and 
services currently available in your area. Any reference to an IBM product, program, 
or service is not intended to state or imply that only that IBM product, program, or 
service may be used. Any functionally equivalent product, program, or service that 
does not infringe any IBM intellectual property right may be used instead. However, 
it is the user's responsibility to evaluate and verify the operation of any non-IBM 
product, program, or service.

IBM may have patents or pending patent applications covering subject matter 
described in this document. The furnishing of this document does not give you any 
license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM 
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation

Licensing

2-31 Roppongi 3-chome, Minato-ku

Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other country 
where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS 
MACHINES CORPORATION PROVIDES THIS PUBLICATION •AS IS• WITHOUT 
WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT 
NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do 
not allow disclaimer of express or implied warranties in certain transactions, 
therefore, this statement may not apply to you. This information could include 
technical inaccuracies or typographical errors. Changes are periodically made to the 
information herein; these changes will be incorporated in new editions of the 
publication. IBM may make improvements and/or changes in the product(s) and/or 
the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for 
convenience only and do not in any manner serve as an endorsement of those Web 
sites. The materials at those Web sites are not part of the materials for this IBM 
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes 
appropriate without incurring any obligation to you.  Licensees of this program who 
wish to have information about it for the purpose of enabling: (i) the exchange of 
information between independently created programs and other programs (including 
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this one) and (ii) the mutual use of the information which has been exchanged, should 
contact:

IBM Corporation

P.O. Box 12195, Dept. TL3B/B503/B313

3039 Cornwallis Rd.

Research Triangle Park, NC 27709-2195

U.S.A.

Such information may be available, subject to appropriate terms and conditions, 
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available 
for it are provided by IBM under terms of the IBM Customer Agreement, IBM 
International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. 
Therefore, the results obtained in other operating environments may vary 
significantly. Some measurements may have been made on development-level 
systems and there is no guarantee that these measurements will be the same on 
generally available systems. Furthermore, some measurement may have been 
estimated through extrapolation. Actual results may vary. Users of this document 
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those 
products, their published announcements or other publicly available sources. IBM has 
not tested those products and cannot confirm the accuracy of performance, 
compatibility or any other claims related to non-IBM products. Questions on the 
capabilities of non-IBM products should be addressed to the suppliers of those 
products.

All statements regarding IBM's future direction or intent are subject to change or 
withdrawal without notice, and represent goals and objectives only. This information 
contains examples of data and reports used in daily business operations. To illustrate 
them as completely as possible, the examples include the names of individuals, 
companies, brands, and products. All of these names are fictitious and any similarity 
to the names and addresses used by an actual business enterprise is entirely 
coincidental.

COPYRIGHT LICENSE: This information contains sample application programs in 
source language, which illustrates programming techniques on various operating 
platforms. You may copy, modify, and distribute these sample programs in any form 
without payment to Cyanea Systems Corp., for the purposes of developing, using, 
marketing or distributing application programs conforming to the application 
programming interface for the operating platform for which the sample programs are 
written.  These examples have not been thoroughly tested under all conditions. IBM 
or Cyanea, therefore, cannot guarantee or imply reliability, serviceability, or function 
of these programs. You may copy, modify, and distribute these sample programs in 
any form without payment to IBM or Cyanea Systems Corp. for the purposes of 
developing, using, marketing, or distributing application programs conforming to 
IBM's and Cyanea's application programming interfaces.
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Trademarks

The following terms are trademarks of the IBM Corporation or its subsidiaries in the 
United States or other countries or both:

   

 

The following terms are trademarks of other companies:

UNIX is a registered trademark of The Open Group in the United States and other 
countries.

Java and JavaScript are registered trademarks and Sun Solaris and Solaris are 
trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

Pentium® is a registered trademark of Intel Corporation in the United States, other 
countries, or both.

Microsoft and Windows are trademarks of Microsoft Corporation in the United 
States, other countries, or both.

HP-UX  is a trademark of Hewlett-Packard Corporation in the United States, other 
countries, or both.

RedHat is a trademark of RedHat Corporation in the United States, other countries, or 
both.

Linux  is a trademark of Linux Torvalds in the United States, other countries, or both.

Other company, product and service names may be trademarks or service marks of 
others.

Table 22. Trademarks

IBM MVS

WebSphere WebSphere Studio

z/OS DB2

 S/390  OS/390

AIX AIX-5L

Tivoli Enterprise Console Tivoli

USS TSO

RACF TME
 Appendix F.   Notices  187



 

 188 Application Monitor:Installation and Customization Guide  



Index

A
Archive Agent Log 32
Audit Messages 32

B
BMC Patrol Integration 137

C
Copy Distribution Files 45
CYN1 Log 85

D
Data Collector

Customization 52
Manual Setup 157

Data Collector Log 85
Definition of Subsystem CYN1 47

PARMLIM UPDATE 48
PROCLIB UPDATE 48

I
Installation

IEFU83 Exit 48
MVS files 47
SNMP Adapter 148
T/EC SNMP Adapter 121

K
Kernel Log 32

L
License Server Log 32
Linux Managing Server 28
Log Files 85

Archive Agent 32
Audit Messages 32
CYN1 Log 85
Data Collector Log 85
Kernel 32
License Server 32
Message Dispatcher 32
Publish Server 32
Visualization Engine 32
WAS Error Log 85

M
Message Dispatcher Log 32

P
Parmlib Update 48
Patrol EM Server Configuration 138

Platforms
AIX 9, 95
HP-UX 95
HPUX 98
Linux 9, 10, 28
Solaris 9, 95, 98
Windows 95
z/Linux 9

Proclib Update 48
Publish Server Log 32

R
RACF Update 48

S
Setup

Email Host 27
Graphical Environment 19

Space Management 41
Start

Application Monitor 24
System Initialization 49
System Requirements 10

T
T/EC Console Configuration 118
T/EC Server Configuration 117
Test Connection 31
Tuning

Database 28

U
Update

Authorization and Linklist 48
Control Files 67
PROCLIB 48
RACF 48
USS Environment 55

Upgrade
Previous Version 23

V
Verification

MVS Components 52
Visualization Engine Log 32

W
WAS Error Log 85
WebSphere Error Log 85

Z
z/OS Data Collector Customization 95
© Copyright IBM Corp.  2004  189



 

 190 Application Monitor:Installation and Customization Guide  



Bibliography

• WebSphere Studio Application Monitor

User’s Guide (SC31-6865-00)

• WebSphere Studio Application Monitor

Operator’s Guide (SC31-6866-00)

• WebSphere Studio Application Monitor

Installation and Configuration Guide (SC31-6867-00)

• WebSphere Studio Application Monitor

CICS Data Collector Product Guide (SC31-6868-00)

• WebSphere Studio Application Monitor

IMS Data Collector Product Guide (SC31-6869-00)

• WebSphere Studio Application Monitor

Messages and Codes (SC31-6864-00)

• WebSphere Studio Application Monitor

Program Directory for 

IBM WebSphere Studio Application Monitor (GI10-3349-00)

• WebSphere Studio Application Monitor

Program Directory for the

CICS Data Collector (GI10-3350-00)

• WebSphere Studio Application Monitor

Program Directory for the

IMS Data Collector (GI10-3351-00)
© Copyright IBM Corp.  2004  191



 

 192 Application Monitor:Installation and Customization Guide  



Readers’ Comments—We’d Like to Hear from You

WebSphere Studio Application Monitor
WebSphere Studio Application Monitor Installation and Customization Guide
3.1 

Publication No. SC31-6867-00
Overall, how satisfied are you with the information in this book?

How satisfied are you that the information in this book is:

Please tell us how we can improve this book:

Overall satisfaction

Very Satisfied           Satisfied                Neutral              Dissatisfied                Very
                                                                                                                                                         Dissatisfied

                                                                                                                             Dissatisfied
Very Satisfied           Satisfied                Neutral              Dissatisfied                Very

Accurate
Complete
Easy to find
Easy to understand
Well organized
Applicable to your tasks

Thank you for your response. May we contact you?    ❏  Yes    ❏   No

❏
❏
❏
❏
❏
❏

❏
❏
❏
❏
❏
❏

❏
❏
❏
❏
❏
❏

❏
❏
❏
❏
❏
❏

❏
❏
❏
❏
❏
❏

❏❏❏❏❏

When you send comments to IBM, you grant IBM a nonexclusive right to use or distribute your comments in any
way it believes appropriate without incurring any obligation to you.

AddressName

Company or Organization

Phone No.



    
Cut or Fold
Along Line

- - - - - - 

______________________________

 

- - - - - - 

IBM@

SC31-6867-00

IBM Corporation
P.O. Box 12195, Dept. TL3B/B503/B313
3039 Cornwallis Rd.
Research Triangle Park, NC 
U.S.A.27709-2195

S2770921958s
Fold and Tape Please do not staple Fold and Tape

Fold and Tape Fold and Tape

NO POSTAGE
NECESSARY
IF MAILED IN THE
UNITED STATES

BUSINESS REPLY MAIL
FIRST-CLASS MAIL PERMIT NO. 40 ARMONK, NEW YORK

POSTAGE WILL BE PAID BY ADDRESSEE

- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -

______________________________________________

- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -
 - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 
Please do not staple

SC31-6867-00
Cut or Fold
Along Line

_____________________
__



Overall, how satisfied are you with the information in this book?

How satisfied are you that the information in this book is:

Please tell us how we can improve this book:

Overall satisfaction

Very Satisfied           Satisfied                Neutral              Dissatisfied                Very
                                                                                                                                                         Dissatisfied

                                                                                                                             Dissatisfied
Very Satisfied           Satisfied                Neutral              Dissatisfied                Very

Accurate
Complete
Easy to find
Easy to understand
Well organized
Applicable to your tasks

Thank you for your response. May we contact you?    ❏  Yes    ❏   No

❏
❏
❏
❏
❏
❏

❏
❏
❏
❏
❏
❏

❏
❏
❏
❏
❏
❏

❏
❏
❏
❏
❏
❏

❏
❏
❏
❏
❏
❏

❏❏❏❏❏

When you send comments to IBM, you grant IBM a nonexclusive right to use or distribute your comments in any
way it believes appropriate without incurring any obligation to you.

AddressName

Company or Organization

Phone No.



Overall, how satisfied are you with the information in this book?

How satisfied are you that the information in this book is:

Please tell us how we can improve this book:

Overall satisfaction

Very Satisfied           Satisfied                Neutral              Dissatisfied                Very
                                                                                                                                                         Dissatisfied

                                                                                                                             Dissatisfied
Very Satisfied           Satisfied                Neutral              Dissatisfied                Very

Accurate
Complete
Easy to find
Easy to understand
Well organized
Applicable to your tasks

Thank you for your response. May we contact you?    ❏  Yes    ❏   No

❏
❏
❏
❏
❏
❏

❏
❏
❏
❏
❏
❏

❏
❏
❏
❏
❏
❏

❏
❏
❏
❏
❏
❏

❏
❏
❏
❏
❏
❏

❏❏❏❏❏

When you send comments to IBM, you grant IBM a nonexclusive right to use or distribute your comments in any
way it believes appropriate without incurring any obligation to you.

AddressName

Company or Organization

Phone No.





IBM@
Part Number: 5697-J18
SC31-6867-00

*07SC31686700*
(1
P

) 
P

/N
: 5

69
7-

J1
8

*5
69

7-
J1

8*



IBM@


	About this book
	About this book
	Who should read this book
	Where to find more information
	Documentation Conventions

	Part 1. Introduction
	Chapter 1. Product Overview
	Architecture
	The Managing Server
	Requirements
	Supported Installations

	Data Collectors
	Requirements
	Supported Installations


	Part 2. The Managing Server Installation
	Chapter 2. Preparing to Install
	Planning Your Installation
	Software Requirements
	Hardware Requirements
	Database Considerations
	Networking Considerations
	Installation Overview 

	Upgrading Considerations
	Preparing your Environment for Installation
	Install J2EE Application Server
	Optional: Install Web Server 

	Install Virtual Frame Buffer

	Chapter 3. Installation and Configuration
	Create Users and Setup User Environment
	Create Users

	Database Installation
	Install Database
	Setting up the Database
	Using a Remote Database 

	Setting the Environment
	WebSphere 
	DB2
	Oracle
	Example Configurations
	Gather Configuration Information

	Setting up the Graphical Environments
	Gather Configuration Information
	Managing Server
	WebSphere
	DB2
	Oracle

	Run Installer
	Upgrading Considerations
	Migrating Data

	Starting the Application Monitor

	Chapter 4. Customization
	Setup Email Host
	Setup init.d
	Setup SNMP
	Setup Regular Database Tuning
	Increase Linux Kernel Setting
	Configuring Your Firewall
	Parameters Specified with Multiple Network Cards 

	Chapter 5. Troubleshooting
	Test Database Connection
	WebSphere (DB2 or Oracle)
	Authentication 
	Database Problems

	Viewing the Error Logs
	To Change Username/Password for WSAM Application Monitor

	Chapter 6. Uninstalling the Managing Server 
	Remove the Application Monitor Database
	DB2
	Oracle

	Uninstall the J2EE Application Server
	WebSphere

	Shutting Down the Managing Server 
	WebSphere

	Uninstall the Application Monitor Files

	Part 3. The Data Collector for z/OS
	Chapter 7. Preparing to Install
	Planning Your Installation
	Platform Pre-requisites
	MVS Component Considerations
	Space Management
	Network Considerations
	Installation Overview
	System Access and Levels of Authority


	Chapter 8. Installation and Configuration
	Unpackaging Data Collector Software
	SMP/E Install
	Non-SMP/E Install

	Installing the Data Collector
	Installing MVS Components
	Authorizing Data Sets and Updating the Linklist
	Installing USS Component

	Verifying Installation of the Data Collector
	Verifying WebSphere 5

	Configuring the Data Collector
	General

	Configuring the Application Servers
	Configuring WebSphere 5 on z/OS

	Starting the Data Collector (Quick Start Guide)
	Configuring Distinct WebSphere Application Server Instances
	General
	z/OS WebSphere 5

	Data Collector Property References
	z/OS WebSphere 5


	Chapter 9. Customization
	Optional z/OS WebSphere 5 Support
	Adding SMF Support
	Adding PMI Support
	Adding JDBC Support
	Adding JNDI Support
	Adding JMS Support
	Adding MQI Capturing Support
	Adding Multiple Host Support
	Adding Support for Composite Requests using CTG
	Adding Support for Composite Requests using IMS Connect


	Chapter 10. Troubleshooting
	Log Files
	Viewing the WebSphere error log:

	Protocol Timeout

	Chapter 11. Uninstalling the z/OS Data Collector
	Disable the Application Monitor
	z/OS Websphere 5

	Re-enable the Application Monitor
	z/OS WebSphere 5

	Uninstalling the z/OS Data Collector
	z/OS WebSphere 5


	Part 4. The Data Collector for Multiplatforms
	Chapter 12. Preparing to Install
	Requirements for Installing the Data Collector
	Increase the Heap Size
	Cluster Considerations 

	Chapter 13. Installation and Configuration
	Installing the Data Collector
	General Information
	Installing Data Collectors that Monitor WebSphere

	Node Authentication
	Kernel Related Changes
	Data Collector Related Changes
	Node Authentication Related Properties in Port Consolidator
	Keystore Managment and Populating Certificates
	Node Authentication Related Properties for the Visualization Engine

	Adding MQ Support

	Chapter 14. Customization
	Rebuild the HP-UX Kernel
	Configuring Web Servers 
	Parameters Specified with Multiple Network Cards 
	Nested Requests 

	Chapter 15. Troubleshooting
	Out of Memory Error

	Chapter 16. Uninstalling the Distributed Data Collector
	Disable
	Disabling Data Collectors for WebSphere

	Uninstalling the Data Collectors

	Chapter 17. WBI JDBC Adapter Data Collector 
	Installing the Data Collector on WBI JDBC Adapter
	Installing Data Collector Files
	Configure JDBC Adapter startup script


	Appendix A. Tivoli TEC Integration
	Overview
	Requirements for Integrating with T/EC
	Configuring T/EC
	Summary
	Configuring the T/EC Server
	Configuring the T/EC Console
	Installing and Configuring the T/EC SNMP Adapter
	Installing and Configuring T/EC SNMP Adapter for non-TME
	Installing and Configuring the T/EC SNMP Adapter for ACF

	Using the Application Monitor for T/EC

	Appendix B. BMC Patrol Integration
	Overview
	Requirements
	Configuring BMC Patrol
	Configuring Patrol EM Server
	Generating the CYANEA Filter Engine
	Defining the CYANEA Filter Path
	Installing and Configuring the Cyanea SNMP Adapter

	Using Patrol EM with the Application Monitor 

	Appendix C. Port Consolidator
	Manual Installation
	Configuration
	Start/Stop Port Consolidator
	Configuring Data Collector

	Appendix D. Manual Installation of the Data Collector
	Manually Installing the J2EE Data Collector
	Installing Data Collector Files

	Configuring Application Servers
	Configuring WebSphere 5.0.2 Portal on Intel/Linux
	Configuring WebSphere 5.0.2 Portal on AIX
	Configuring WebSphere 5.0.2 Portal on Solaris
	Configuring WebSphere 5.0.2 Portal on Windows
	Configuring WebSphere 5.0.2.6 on Intel/Linux and z/Linux
	Configuring WebSphere 5.0.2.6 on AIX
	Configuring WebSphere 5.0.2.6 on Solaris
	Configuring WebSphere 5.0.2.6 on HP-UX
	Configuring WebSphere 5.0.2.6 on Windows
	Configuring WebSphere 5.1.1 on AIX
	Configuring WebSphere 5.1.1 on Intel/Linux and z/Linux
	Configuring WebSphere 5.1.1 on Solaris
	Configuring WebSphere 5.1.1 on HP-UX
	Configuring WebSphere 5.1.1 on Windows


	Appendix E. Setting up an HTTP Server with your Managing Server
	Appendix F. Notices
	Trademarks

	. WebSphere Studio Application Monitor



